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Comecei a desenvolver com ASPNET ainda quando o Delphi for .NET era
apenas um compilador. E desde |a fiquei encantado pela riqueza de recursos
que o framework Web oferece. Temos controles servidores, temos muitos
recursos para performance (como cache), um mecanismo robusto para
acesso a dados (ADO.NET), a facilidade do desenvolvimento drag & drop
e baseado em eventos. Nao tenho duvidas que o ASPNET é hoje a melhor
solucao para o desenvolvimento Web com Delphi. E digo mais, a nova versao
do Delphi, a RAD Studio 2007, vem com suporte ao ASPNET 2.0, e com ele
uma vasta variedade de novos recursos antes sé disponiveis para quem
trabalhava com Visual Studio 2005. Temos Master Pages, DataSources,
Web Parts, Temas e Skins, servicos de Membership e Login (tudo pronto),
Profiles, Navegacao, novos controles (mais de 50) e muito mais. Acredite,
vocé vai desenvolver para Web com o mesmo poder RAD que tem hoje no
Delphi Win32. Amigo leitor, se ainda nao comecou a desenvolver com essa
poderosa e robusta tecnologia, essa edicao é para voce.

Ainda nesta edicao, o Manoel traz a segunda parte do artigo que mostra
como desenvolver aplicativos méveis para Pocket PC com o Delphi, criando
agora a aplicacao Pocket propriamente dita, que acessa o Web Service
criado na edi¢ao anterior. O Adriano aproveita o seu mini-curso para mostrar
um interessantissimo recurso, como trabalhar com arquivos de remessa
e retorno para realizar a cobranca junto a instituicbes bancarias, segundo
as normas da FEBRABAN. Em sua outra colaboracao, Adriano traz mais um
artigo sobre automacao comercial mostrando agora como fazer com que sua
aplicacao interaja com leitores de cédigos de barra.

0O uso do RAD e POO em uma aplicagao € algo inversamente proporcional.
Quanto mais RAD vocé desenvolve, menos faz uso da POO. Quanto mais
POO vocé utiliza, mais perde os recursos do RAD. O Paulo Quicoli apresenta
um poderoso padrao de projeto largamente utilizado em médios e grandes
projetos, chamado Model-View-Controller (MVC), que permite que vocé
separe em camadas as diferentes partes da sua aplicacdo. E o melhor
de tudo, sem perder o poder RAD do Delphi. DataModules é o tema do
artigo do Pablo e Fernando Prass, na coluna Easy Delphi. Aprenda a utilizar
corretamente DataModules em suas aplicacoes client/Server.

E temos muito Delphi for PHP: o Fabricio continua o seu mini-curso que
estd mostrando como construir uma aplicacao completa com Delphi for PHR
e temos a continuacao do artigo introdutério sobre a linguagem (22 parte)
agora mostrando os tipos de dados utilizados no PHP

Sucesso a todos, bons cédigos, muito Delphi na cabeca e boa leitura!

Guinther Pauli

guinther@devmedia.com.br
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exemplar na banca de jornal: vocé pode acessar GRATUITAMENTE,
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Confira o que vocé encontra no Portal do Assinante:
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Ask The Expert

Perguntas e Respostas

Duvidas respondidas por Luciano Pimenta
(envie as suas para lucianopimenta@devmedia.com.br)

Como detectar internet na

Listagem 1. Chamada a fungao InternetGetConnectedState

;e
maquina
. . ~ uses
Preciso saber qual via programacao se Wininet
te.rn Internet dlspomvel no m.lcro do meu f)f(l)cedure TForml.ButtonlClick(Sender: TObject);
cliente. Como posso fazer isso? Existe var
. Flags : dword;
alguma API do Windows? begin
. if InternetGetConnectedState(@Flags, 0) then
AndersonMuiques Labell.Caption := ‘[Internet Disponivel]’
else
Labell.Caption := ‘[Internet indisponivell’;
Old Anderson, respondendo a sua end;

questdo: sim, existe uma API do Win-

dows que retorna se existe internet dis- e
ponivel no micro e é muito simples de
implementar. Basta fazer uma chamada : Detecrs
a funcdo InternetGetConnectedState. Veja 5 22
. [Internet Disponivel]

ana Listagem 1. '

Veja na Figura 1 como ficou o exemplo

A

ao detectar a internet. Figura1. Detectando internet

“ O Maior Portal para Desenvolvedores
da América Latina.”

Acesse:

. Dev
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Assinatura +460 video aulas | 6 cursos online
R
ClubeDelphi L4885

Mais contedido .NET por menos! www.clubedelphi.net/portal

Caro Leitor, .:: DESTAQUE ::.

0 portal ClubeDelphi PLUS é a continuacao, na Web, da Confira no portal ClubeDelphi PLUS 2 video aulas sobre DataSnap e SOAP
revista ClubeDelphi. O portal recebe um contetido novo
todo dia e hoje conta com: i) mais de 460 video aulas; ii)
6 cursos online; iii) 1 livro eletrénico gratuito, de Guinther
Pauli, sobre ADO.NET e BDP; iv) mais de 150 artigos
exclusivos (que nao foram publicados na revista)};

DataSnap e SOAP
http://www.devmedia.com.br/articles/viewcomp.asp?comp=6771
http://www.devmedia.com.br/articles/viewcomp.asp?comp=6733

Acesse o portal ClubeDelphi PLUS e receba muito mais Curso Online - PLUS
conteddo sobre Delphi! E o que é melhor: de graca!
Todo leitor da revista ClubeDelphi, seja ele assinante ou
comprador da revista em bancas, tem acesso ao portal (para
quem compra em bancas, 0 acesso é vélido por 30 dias).

0 portal ClubeDelphi PLUS conta com 6 cursos online, confira!

Sistema completo com Delphi 7, dbExpress e Firebird 2.0 [Luciano Pimental
Se vocé é assinante, utilize o seu login e senha pessoais para
acessar o portal.Se vocé comprou em bancas, utilize o login e
senha publicados na pagina do editorial desta edicao.

Aplicagdes WEB com IW e Delphi 7 (Delphi Win32)! [Guinther Pauli]

Aplicacoes client/server no Delphi 2006 [Luciano Pimenta]

Confira a seguir as ultimas novidades do portal! Criando uma Aplicacdo multi-camadas Completa com Delphi [Guinther Pauli]

Boa leitura e sucesso!
Equipe DevMedia

A8 v

Criando uma aplicacdo completa: sistema SysCash [Everson Volaco]

Aplicacoes Client/Server com dbExpress e Firebird [Luciano Pimental

Ultimas Video-Aulas (Somente para assinantes)

Aprenda a desenvolver sistemas para o sistema operacional PalmOS
Acompanhe as aulas de Ricardo Boaro que falam unicamente do desenvolvimento de aplicagbes para PalmOS utilizando a IDE PocketStudio que é
bastante semelhate ao Delphi inclusive utilizando-se de linguagem Pascal.

Migrando de 2 para 3 camadas - Partel ell
Veja nesta série de duas aulas como construir aplicacdes 2-camadas que podem ser facilmente migradas para multicamadas com DataSnap, por Guinther Pauli.

Imprimindo etiquetas no QuickReport - Partel a lll
Veja nessa video aula de Paulo Quicoli como criar etiquetas personalizadas usando o editor de relatérios nativo do Delphi, QuickReport.

Crie um loja virtual com Delphi for PHP - Parte VI
Veja nessa video aula de Fabricio Desbessel,a continuacdo de mais um curso on-line do Portal ClubeDelphi. Aprenda a criar uma loja virtual com Delphi for PHP.

Rave Reports - Partelell
Veja nessa video aula de Jefferson Junglaus, como trabalhar com Rave Reports no Delphi.
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Secao DELPHI

Nesta secao vocé encontra artigos intermediarios
sobre Delphi Win32 e Delphi .NET

B

PocketPC com Delphi

Desenvolvendo aplicativos moveis — Parte 2

Manoel Campos da Silva Filho
(manoelcampos@gmail.com)

é Analista de Sistemas, Tecndlogo em Pro-
cessamento de Dados pela Universidade do
Tocantins, especializando em Gestdo e Consul-
toria em Telecomunicagdes, Professor da Escola
Técnica Federal de Palmas-TO. Trabalha com
desenvolvimento em Delphi, PHP e ASPNET,
programacdo para Linux em C. Desenvolve em
Delphi desde a versdo 3.0

ontinuando o artigo da edigdo
anterior, veremos agora como
criar a aplicagdo cliente no Pocket

PC para consumir o Web Service criado
na ultima edicao.

Criando a aplicacao

O CF Builder inclui algumas opgdes
no Repository do BDS para criagdo de
aplicacdes para dispositivos moveis.
Acesse o menu File>New>Other, na op-
¢do Smart Device escolha Smart Device
Application para criar um novo projeto
(Figura 1). Salve a unit principal com o
nome “MainForm.pas” e o projeto como
“PesquisaOpiniao.dpr”.

Para testarmos a aplicagdo no emulador
acesse o menu Compact Framework>Run
Smart Device Project no BDS, ou utilize
o Play existente na barra de ferramentas
adicionado pelo CF Builder (Figura 2).

Na barra vocé pode selecionar o emula-
dor que deseja rodar a aplicagdo. O execu-
tdvel é copiado automaticamente para a

pasta compartilhada que vocé informou
no campo Shared Folder nas configuragoes
do emulador.

Assim, apds rodar o emulador clicando
no Play dabarra do CF Builder, vocé deve
acessar o Storage Card, como mostrado an-
teriormente, para executar a aplicagdo.

Lembre-se que se vocé ndo fizer um
Soft Reset no emulador o Storage Card ndo
aparecerd. Apés o emulador abrir pela
primeira vez, vocé ndo precisa fechd-lo,
assim, o Storage Card ndo desaparece.

Para atualizar a aplicagdo no emulador,
basta clicar no Play para que o executdvel
seja copiado novamente para o Storage
Card.

Acessando o Web Service na
aplicacao desktop

Para acessar o Web Service a partir da
aplicagdo desktop, precisamos adicionar
uma referéncia a URL do arquivo WSDL
que descreve as fungdes disponiveis no
Web Service.

6 ClubeDelphi - PocketPC com Delphi



MOBILE

Como vamos trabalhar com dois proje-
tos a0 mesmo tempo, e vocé jd estd com o
projeto do Web Service aberto, para abrir
o projeto da aplicagdo desktop clique com
o botao direito em Project Group 1, no Pro-
ject Manager, selecione Add Existing Project
e localize o projeto PesquisaOpiniao.

Clique em Save All na barra de ferra-
mentas para salvar o grupo de projetos.
Salve com o nome de “Projetos Compact
Framework”. Agora temos os dois proje-
tos no Project Manager.

Dé um duplo clique no PesquisaOpi-
niao, a aplicagdo desktop para Compact
Framework. Clique com o botao direito
e escolha a opgdo Add Web Reference para
adicionar uma referéncia ao Web Service
criado.

Na janela que é aberta vocé deve infor-
mar a URL do Web Service, que se vocé
utilizou os nomes que sugeri, deve ser
“http://localhost/PesquisaOpiniaoWS/
PesquisaOpiniao.asmx”. Porém, como
a aplicacdo cliente ndo estard rodando

& Mew Items

Ikem Caktegories:

no seu PC e sim no dispositivo mével,
por meio do emulador, vocé ndo deve
informar localhost e sim o endereco IP do
seu PC (onde estd o servidor web com
o WebService hospedado) ou o nome
DNS dele.

No meu caso, utilizei o endereco
“http://developer/PesquisaOpiniaoWS/
PesquisaOpiniao.asmx”. Rode o projeto
do Web Service que o navegador é aberto
indicando a URL, porém, substitua loca-
Thost pelo IP ou nome DNS do seu PC.

Ap6s informar a URL, pressione EN-
TER para abrir a pagina no navegador
interno. Clique em Service Description
para abrir o WSDL (o descritor do Web
Service). O valor do campo Web reference
folder name serd usado como prefixo do
namespace que serd criado para acesso
ao Web Service.

Altere o valor do campo para “Pes-
quisaOpiniaoServer”. Depois clique em
Add Reference para adicionar a referéncia
ao projeto. O BDS cria um arquivo PAS

X

= Delphi For \MET Projects
Intraweb
Mew Files
] Smark Device
PocketPC
SmartPhone
Design Projects
Qther Files
Unit Test
web Documents

Figura 1.0pgos Adicionadas pelo CF Builder no Repository

Smark Device
Application ...

]

Zancel Help |

#& PesquisaOpiniao - Borland Developer 5tudio 2006 - MainForm

Fil=  Edit

Search  Miew Refactaor

Project  Fun  Component

GExperts

?,ﬁz @ |Se|ected Ernulator

Figura 2. Barra de Ferramentas do CF Builder no BDS

mapeando as fungdes existentes no Web
Service para serem usadas em nossa
aplicacao.

Agora inclua um MainMenu no formu-
lario principal da aplicacdo desktop. Nele
inclua um item “Arquivo” e dentro desse
um item “Selecionar dados no Servidor”.
Para usarmos as fung¢des do Web Service
precisamos incluir a unit que foi criada
apos a referéncia ao Web Service ser adi-
cionada ao projeto.

Assim, pressione ATL+F11 e selecione
a unit PesquisaOpiniaoServer. PesquisaOpi-
niao. Inclua outros componentes no for-
muldrio para que esse fique semelhante
a Figura 3.

Nota: Caso tente testar a aplicacdo e
receba uma mensagem do tipo: File not
found:  'MainForm.frmMain.resources’,
vocé deve fazer uma cépia do arquivo
RESX colocando o mesmo nome da
mensagem, sendo esse erro problema

no BDS ou plugin.

Nota: Nao crie um formuldrio mui-
to grande, pois dependendo do
equipamento, o mesmo pode ficar

desconfigurado.

Para armazenar os dados na aplicacao,
utilizaremos o DataSet. Como as fungdes
do Web Service, que retornam dados
para a aplicacdo, devolvem DataSets,

= Pesquisa de Opiniao |:|@I§|

Arquivo

Pezguiza
|EumeBUH1 j::

Figura 3. Design do Formuldrio
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utilizaremos um DataSet para cada ta-
bela que precisarmos armazenar dados
localmente.

Assim, inclua cinco DataSets e altere
seus nomes, respectivamente, para “ds-
Pesquisa”, “dsPergunta”, “dsAlternativa”,
“dsEntrevistado” e “dsResposta”. Na Ta-
bela 1 temos as propriedades que devem
ser alteradas para alguns componentes.

Como precisaremos trabalhar com
arquivos XML, criaremos uma unit que
terd uma classe com funcgOes estdticas
(class function) que serdo acessadas sem
a necessidade de instanciar um objeto
da classe.

Classes assim servem apenas para agru-
par fungdes e constantes, organizando
melhor o c6digo. Crie a unit com o nome

( )
Listagem 1. Funcdes para manipular os arquivos XML da aplicagao
unit ClubeDelphi.PesquisaOpiniao.XML;
interface
uses System.Data, System.Reflection, System.IO, System.Windows.Forms;
type
{ Classe para agrupar as fungbes para manipula¢do dos DataSets |}
XMLCache = class
private
{ Varidvel de classe: possui um unico valor para todas as instdncias da classe. Ela
é acessada sem a necessidade de instanciar um objeto da classe. Armazenard o caminho
da aplicacdo }
class var FAppDir: string;
public
{ Constantes que definem o nome dos XML usados }
const argPesquisa = ‘pesquisa.xml’;
const argPergunta = ‘pergunta.xml’;
const argAlternativa = ‘alternativa.xml’;
const argEntrevistado = ‘entrevistado.xml’;
const argResposta = ‘resposta.xml’;
{ Descobre a pasta do executdvel |}
class function ApplicationDir: string;
{ Inclui um registro de entrevistado no DataSet
passado por pardmetro }
class function IncluirEntrevistado(
var ds: DataSet; Nome: string;
CodPesquisa: Integer): Integer;
{ Registra, no DataSet passado por pardmetro, uma resposta de um entrevistado }
class function RegistrarRespostal
var ds: DataSet; CodEntrevistado, CodPergunta, CodAlternativa: Integer): Boolean;
{ Carrega um XML, verificando se o mesmo existe, no DataSet passado por pardmetro }
class function CarregarXML(var ds: DataSet; NomeArqg: string): Boolean;
{ Grava os dados de um DataSet passado por pardmetro, em um arquivo XML }
class procedure GravarXML(ds: DataSet; NomeArqg: string);
{ Envia os dados dos entrevistados e seus respostas ao servidor }
class procedure EnviarCacheXML(var dskEntrevistado, dsResposta: DataSet);
end;
. J
Componente Propriedade Valor Descricao
Name cbxPesquisa
Contém os dados a serem usados como valores para cada um
ValueMember cod_pesquisa dos itens do componente. A propriedade DataSource sera
ComboBox atribuida via programagao.
DisplayMember titulo Contém os dados que serdo exibidos no componente.
. Néao permite que o usudrio digite qualquer coisa no componente,
DropDownStyle DropDownList : X :
s6 podendo escolher um dos itens existentes nele.
TextBox Name txtEntrevistado
Label Name IbCodEntrevistado
Name cbxPergunta
ValueMember cod_pergunta
ComboBox X -
DisplayMember titulo
DropDownStyle DropDownList
Name cbxResposta
ValueMember cod_alternativa
ComboBox X -
DisplayMember descricao
DropDownStyle DropDownList

Tabela 1. Configuragao dos componentes do formuldrio

de “ClubeDelphi.PesquisaOpiniao.XML.
pas” e adicione o cédigo da Listagem 1.

Nota: O codigo possui comentérios so-
bre as caracteristicas de cada funcéo.

A fungdo XMLCache.ApplicationDir
retorna o caminho onde a aplicagdo esta.
Foi usada uma variavel de classe FAppDir
para armazenar, quando a fungdo for
executada pela primeira vez, o caminho
do executdvel, para ndo ter que ficar exe-
cutando este cédigo repetidamente. Veja
o cédigo na Listagem 2.

A fungdo XMLCache.CarregarX ML (Lis-
tagem 3) verifica se o arquivo informado
no pardmetro NomeArq existe para poder
carregd-lo no DataSet passado por refe-
réncia. Como o arquivo XML estard na
pasta da aplicagdo, e estaremos usando o
.NET Compact Framework, necessita que
informe o caminho completo do arquivo
que se deseja manipular.

Na fung¢do XMLCache.IncluirEntrevista-
do (Listagem 4), assim como nas outras
fungdes de inclusdo, como o registro dos
entrevistados é feito localmente, o valor
da chave primdria é gerado localmente
também, de acordo com o valor do ul-
timo registro. Se o DataSet estd vazio, o
cédigo para o registro a ser adicionado
no DataSet serd 1.

A fun¢do XMLCache.EnviarCacheXML
(Listagem 5) envia os dados dos entre-
vistados, armazenados localmente no
dispositivo em arquivo XML, e suas
respostas ao Servidor, repassando os
dados desses arquivos para as fungdes
do Web Service.

Abra o formuldrio principal e pressione
ALT+F11 para usar a unit recém criada.
No evento Click do dltimo item de menu
criado, vamos solicitar ao usudrio que
digite o titulo da pesquisa (ou parte dele)
para que seja feito o acesso ao Web Servi-
ce e retornados os dados da pesquisa.

Como a aplicacdo estard rodando em
um dispositivo mével, nem sempre
teremos conectividade para acessar o
Web Service, pois, como é um sistema
de pesquisa, o usudrio podera estar em
qualquer parte da cidade, sem acesso a
internet para fazer a comunicagdo com
o servidor.

Assim, precisaremos carregar os dados
necessdrios para o dispositivo e guardar

8 ClubeDelphi - PocketPC com Delphi



localmente em arquivos XML, antes do
usudrio ir a rua para fazer seu trabalho
de pesquisa. Quando o usudrio estiver
narua, os dados das entrevistas que fizer
devem ser armazenados localmente em
arquivos XML, para quando ele chegar
a um local que tenha acesso a internet
ou a rede local da empresa, transferir os
dados ao servidor. Para isso que servirdo
os DataSets adicionados.

Para solicitar ao usudrio o titulo da
pesquisa, quando clicar no menu, poderi-
amos utilizar uma fun¢do como InputBox
do Delphi Win32 (que abre uma janela
solicitando um dado do usudrio), porém,
ndo temos uma fung¢do semelhante em
Delphi for .NET.

Dessa forma, criaremos uma classe que
implementard um InputBox. Crie uma
nova unit e salve com o nome de “Clu-
beDelphi.InputBox.pas”. O c6digo dessa
unit é mostrado na Listagem 6. Para
usar o InputBox chame a funcdo de classe
InputBox.Show passando os devidos para-
metros (a fungdo é chamada a partir da
classe e ndo de uma instancia).

A fungdo do InputBox.Show é chamar o
InputBox sem a necessidade de criar um
objeto da classe. Para chamé-lo basta
fazer InputBox.Show passando os para-
metros, sem criar objeto algum, com o
cédigo da Listagem 7.

Precisamos agora incluir o cédigo para
buscar os dados das perguntas e alterna-
tivas no servidor. No formuldrio principal,
pressione ALT+F11 para usar a unit recém
criada. No evento Click do item de menu
adicione o c6digo da Listagem 8.

Esse cédigo chama as fungdes exis-
tentes no Web Service para retornar os
dados que desejamos e em seguida estes
dados sdo armazenados localmente em
arquivos XML para a aplicagdo poder
trabalhar off-line.

Cadastre algumas pesquisas, compile
e execute a aplicagdo (usando os botdes
da barra de ferramentas do CF Builder)
e clique no menu para ver o resultado. O
emulador padrao é aberto.

Acesse o Storage Card para executar o
programa. Lembre-se de usar o Soft Reset
caso o emulador ndo estivesse aberto
anteriormente.

Utilizando o Device Emulator
A aplicagdo, acessando o Web Service

MOBILE

Listagem 2. Retorna o caminho onde a aplicacao se encontra

class function XMLCache.ApplicationDir: string;

var
caminho: string;
begin
if FAppDir = *’ then
begin
{ Pega o caminho completo do Assembly em execucdo (a aplicacdo) }
caminho := Assembly.GetExecutingAssembly.GetName().CodeBase;
{ Extrai somente a pasta onde da aplicacdo, incluindo uma barra no final }
Result := System.String.Format(‘{0}{1}’, Path.GetDirectoryName(caminho), ‘\’);
{ Se a funcdo for chamada a partir de uma aplicacdo desktop que ndo seja para Compact
Framework, o texto file:\ aparecerd no inicio da string. 0 if a seguir remove este texto }
if Result.StartsWith(*file:\") then
Result := Result.Substring(6, result.lLength-6);
FAppDir := Result;
end
else Result := FAppDir;
end;

Listagem 3. Carrega um arquivo XML passado como parametro

class function XMLCache.CarregarXML(var ds: DataSet; NomeArq: string): Boolean;
begin
Result := &File.Exists(ApplicationDir + NomeArq);
{ Se o arquivo existe, carrega-o no DataSet passado por pardmetro }
if result then
ds.ReadXml (ApplicationDir + NomeArq);
end;
class procedure XMLCache.GravarXML(ds: DataSet; NomeArq: string);
begin
{ Grava os dados do DataSet no XML, na pasta da aplicacdo, com o nome passado por pardmetro }
ds.WriteXml (ApplicationDir + NomeArq);
end;

Listagem 4. Incluir um entrevistado

class function XMLCache.IncluirEntrevistado(
var ds: DataSet; Nome: string; CodPesquisa: Integer): Integer;
var
row: DataRow;
total, cod: Integer;
begin
total:= ds.Tables[0].Rows.Count;
if total = 0 then
cod :=1
else
begin
row:= ds.Tables[0].Rows[total-1];
{ Gera um cdédigo local que serd substituido no servidor quando os dados forem enviados |/
cod:= Convert.ToInt32(row[ ‘cod_entrevistado’1)+1;
end;
{ Cria uma nova linha (um novo registro) }
row:= ds.Tables[0].NewRow;
row[ ‘cod_entrevistado’]:= cod.ToString;
row[ ‘nome’ ]:= Nome;
row[ ‘cod_pesquisa’]:= CodPesquisa.ToString;
{ Adiciona a Tinha no DataSet }
ds.Tables[0].Rows.Add(row);
Result := cod;
end;
class function XMLCache.RegistrarResposta(
var ds: DataSet; CodEntrevistado, CodPergunta, CodAlternativa:
var
row: DataRow;
total, cod: Integer;
begin
total:= ds.Tables[0].Rows.Count;
if total = 0 then
cod :=1
else
begin
row:= ds.Tables[0].Rows[total-1];
{ Gera um coédigo local que serd substituido no servidor }

Integer): Boolean;

cod := Convert.ToInt32(row[ ‘cod_resposta_entrevistado’])+1;
end;
row := ds.Tables[0].NewRow;
row[ ‘cod_resposta_entrevistado’] := cod.ToString;
row[ ‘cod_entrevistado’] := CodEntrevistado.ToString;
row[ ‘cod_pergunta’] := CodPergunta.ToString;
row[ ‘cod_alternativa’] := CodAlternativa.ToString;
ds.Tables[0].Rows.Add(row);
Result := True;
end;
|\
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Listagem 5. Salva os dados em Cache (arquivo XML)

uses PesquisaOpiniaoServer.PesquisaOpiniao;

class procedure XMLCache.EnviarCacheXML(
var dskEntrevistado, dsResposta: DataSet);
var
row: DataRow;
row2: DataRowView;
ws: TPesquisaOpiniaoWS;
i, Jj, CodEntrevistado: Integer;

begin
{ Instancia a classe do WebService para acessar suas funcoes }
ws := TPesquisaOpiniaoWS.Create;
try

{ Percorre as linhas do DataSet de entrevistado para enviar
essas linhas ao servidor para serem incluidas no banco }
for i := dsEntrevistado.Tables[0].Rows.Count - 1 downto O do

begin
{ Pega a linha atual }
row := dsEntrevistado.Tables[0].Rows[i];

{ Passa os dados da linha atual do DataSet para a fung¢ao
IncluirEntrevistado do WebService, para incluir estes dados
no banco, retornando o cédigo gerado pelo WebService para o
registro do entrevistado }

CodEntrevistado := ws.IncluirEntrevistado(row[ ‘nome’].
ToString, Convert.ToInt32(row[ ‘cod_pesquisa’]));

{ Se retornou maior que zero é porque o registro foi inclufdo }

if CodEntrevistado > 0 then

begin
{ Filtra o DataSet de respostas retornando somente as respostas

do entrevistado do entrevistado que foi adicionado ao banco
(utilizando o cédigo existente na linha atual (row) do

fi

DataSet dsEntrevistado) }
dsResposta.Tables[0].DefaultView.RowFilter :=

‘cod_entrevistado=" + row[ ‘cod_entrevistado’].ToString;

{ Remove o registro do entrevistado do DataSet, pois esse jd

foi enviado ao servidor |}
dsEntrevistado.Tables[0].Rows.RemoveAt(i);

{ Percorre o DataSet dsResposta pegando todas as respostas

do entrevistado atual }

for j := dsResposta.Tables[0].DefaultView.Count-1 downto 0 do

begin
{ Pega a linha atual do DataSet dsResposta |}
row2 := dsResposta.Tables[0].DefaultView.Item[j];

{ Chama a funcdo RegistrarResposta do WebService, para incluir

no banco os dados do registro atual do DataSet dsResposta.

Se a funcdo retornar True, indica que a resposta foi incluida
no banco(ou atualizada), assim, remove do DataSet, dsResposta o

registro na posigdo atual(j) }
if ws.RegistrarResposta(CodEntrevistado,Convert.
ToInt32(row2[ ‘cod_pergunta’]),
Convert.ToInt32(row2[ ‘cod_alternativa’])) then
dsResposta.Tables[0].DefaultView.Delete(]);
end;
end;
end;
nally
{ Grava as alteracbes nos DataSet’s em arquivo }
dsEntrevistado.WriteXml(argEntrevistado);
dsResposta.WriteXml(arqResposta);

end;

end;
end.

Listagem 6. Unit ClubeDelphi.InputBox.pas

unit ClubeDelphi.InputBox;

interface

uses System.Drawing, System.Windows.Forms, System.ComponentModel;
type

InputBox = class(System.Windows.Forms.Form)

private
TextBox1: System.Windows.Forms.TextBox;

Labell: System.Windows.Forms.&Label;

btnOK: System.Windows.Forms.Button;

btnCancel: System.Windows.Forms.Button;

constructor Create();

procedure TextBoxl_KeyDown(sender: &0bject;
e: System.Windows.Forms.KeyEventArgs);

procedure InitializeComponent();

public
class function Show(Title, Question: string): string;

end;

implementation

constructor InputBox.Create();

begin
inherited Create;
InitializeComponent();

end;

procedure InputBox.TextBoxl_KeyDown(sender: &0bject;
e: System.Windows.Forms.KeyEventArgs);

begin

if e.KeyCode = Keys.Enter then

Self.DialogResult := System.Windows.Forms.DialogResult.0K;
end;
procedure InputBox.InitializeComponent();
begin

Self.Labell:= System.Windows.Forms.&Label.Create;

Self.TextBoxl := System.Windows.Forms.TextBox.Create;

Self.btnOK := System.Windows.Forms.Button.Create;

Self.btnCancel := System.Windows.Forms.Button.Create;

{ As propriedades e métodos que estdo dentro da diretiva $IFNDEF
CF s6 serdo compiladas se ndo estivermos compilando para o
Compact Framework }

{$IFNDEF CF}

Self.SuspendLayout();

{$ENDIF}

Self.TextBoxl.Location := System.Drawing.Point.Create(16, 16);
{$IFNDEF CF}

Self.TextBoxl.Name := ‘textBoxl’;

Self.TextBox1.TabIndex := 0;

{$ENDIF}

end;

Self.TextBox1.Size := System.Drawing.Size.Create(180, 20);

Self.TextBoxl.Text := ‘’;

Self.TextBoxl.Top := 28;

Self.TextBoxl.Left := 10;
Include(Self.TextBox1l.KeyDown, Self.TextBoxl_ KeyDown);
Self.Labell.Text:= ‘Digite o dado’;

{$IFNDEF CF}

Self.labell.AutoSize := true;

Self.Labell.TabIndex := 1;

{$ELSE}

Self.Labell.Size.Width := Self.TextBox1l.Size.Width;
{$ENDIF}

Self.Labell.Top := 10;

Self.Labell.lLeft := 10;

Self.btnOK.Text:= ‘0K’ ;

Self.btnOK.DialogResult := System.Windows.Forms.DialogResult.OK

{$IFNDEF CF}
Self.btnOK.TabIndex := 2;
Self.btnOK.NotifyDefault(true);
{$ENDIF}

Self.btnOK.Top := 55;
Self.btnOK.Left := 10;

Self.btnCancel.Text:= ‘Cancelar’
{$IFNDEF CF}
Self.btnCancel.TabIndex := 3;
{$SENDIF}

Self.btnCancel.Top := 55;

Self.btnCancel.Left := 100;

Self.btnCancel.DialogResult :=
System.Windows.Forms.DialogResult.Cancel;

{$IFNDEF CF}

Self.AutoScaleBaseSize := System.Drawing.Size.Create(5,

{$ENDIF}

Self.ClientSize := System.Drawing.Size.Create(220, 90);

Self.ControlBox := false;

Self.Controls.Add(Self.TextBox1);

Self.Controls.Add(Self.Labell);

Self.Controls.Add(Self.btnOK);

Self.Controls.Add(Self.btnCancel);

Self.FormBorderStyle :=
System.Windows.Forms.FormBorderStyle.FixedDialog;

{$IFNDEF CF}

Self.Name := ‘InputBox’;
Self.Resumelayout(false);
{$ENDIF)

Sy
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a partir do WindowsCE Emulator néo se
comportou muito bem. Assim, vocé pode
utilizar o Device Emulator para executar
o programa. Como jd mencionado, esse
ndo pode ser configurado totalmente
usando o CF Builder.

Assim, vamos usar os links que sdo
criados na pasta Microsoft Windows Mobile
5.0 Emulator no menu Iniciar para executa-
lo. Na pasta do menu Iniciar, indicada
anteriormente, existem seis atalhos para
imagens de dispositivos. Trés terminam
com a palavra Coldboot e outras trés com
a palavra Savestate.

Os Coldboot iniciardo o dispositivo
dando um boot completo, o que vai de-
morar bastante. Os Savestate iniciam o
dispositivo a partir de uma sessdo salva
anteriormente, o que serd bem répido.

Os atalhos Savestate sé vao funcionar de-
pois que cada uma das sessdes dos atalhos
Coldboot forem salvas. Ao salvar a sessdo
no emulador é criado um arquivo DESS,
permitindo reiniciar a imagem a partir
do mesmo ponto onde ela parou de rodar
quando o emulador foi fechado. Para salvar
a sessdo no emulador, acesse o menu File e
clique na opgéo Save State and Exit.

Para configurar o Storage Card para as
imagens, vocé terd que configurar cada
uma das Coldboot. Assim, clique com o bo-
tdo direito em uma e escolha Propriedades.
Na aba Atalho, no campo Destino, adicione
no final alinha “/sharedfolder PastaQue-
DesejarUsarComoStorageCard”.

Se o0 caminho da pasta a ser utilizada
tiver espaco, coloque todo o caminho
“entre aspas”. Apds configurar o Storage
Card nos trés atalhos Coldboot, execute
algum deles.

Para abrir o Storage Card, clique no menu
Iniciar do emulador e escolha File Explorer.
Na parte superior da janela existe um bo-
tao onde vocé pode selecionar Storage Card
para abrir a pasta compartilhada no seu
computador e acessar os arquivos la.

Configurando a rede no Device
Emulator

Com as imagens de Windows Mobile (o
Device Emulator s6 usa essas) 0 acesso a
Internet ou a uma rede local é feito por
Bluetooth, infravermelho ou via Acti-
veSync, esse dltimo quando se conecta
o dispositivo a um PC. Temos também
como emular essa conexdo do emulador

Listagem 7. Método Show do InputBox

class function InputBox.Show(Title,
Question: string): string;

var
box: InputBox;

begin
box := InputBox.Create;
box.Text := Title;
box.Labell.Text := Question;
if box.ShowDialog = System.Windows.Forms.DialogResult.0K then

Result := box.TextBoxl.Text

else Result:= *’;

end;

Listagem 8. Menu Selecionar dados no Servidor

var
ws: TPesquisaOpiniaoWS;
titulo: string;
codPesquisa: Integer
begin
{ Chama o InputBox para solicitar o titulo da pesquisa ao usudrio }
titulo := InputBox.Show(‘Selecionar Pesquisa’, ‘Titulo da pesquisa’);
if titulo <> °° then
begin
{ Instancia um objeto da classe do WebService }
ws := TPesquisaOpiniaoWS.Create;
{ Busca os dados da pesquisa no WebService |}
dsPesquisa := ws.GetPesquisa(titulo);
if (dsPesquisa.Tables[0].Rows.Count > 0) then
begin
{ Liga a tabela do DataSet para que as pesquisas sejam exibidas no ComboBox |}
cbxPesquisa.DataSource := dsPesquisa.Tables[0];
{ Guarda o cédigo da pesquisa retornada |/
codPesquisa := Convert.ToInt32(dsPesquisa.Tables[0].Rows[0][‘cod_pesquisa’]);
{ Armazena os dados da pesquisa localmente em um XML. XMLCache é a classe que criamos
para agrupar as funcoes para manipula¢cdo dos DataSets }
XMLCache.GravarXML(dsPesquisa, XMLCache.arqPesquisa);
dsPergunta := ws.GetPerguntas(codPesquisa);
XMLCache.GravarXML(dsPergunta, XMLCache.argPergunta);
{ Se existe alguma pergunta cadastrada para a pesquisa }
if dsPergunta.Tables[0].Rows.Count > 0 then
begin

dsAlternativa:= ws.GetAlternativas(codPesquisa);

XMLCache.GravarXML(dsAlternativa, XMLCache.argAlternativa);

{ Chama a funcdo GetEntrevistado do WebService informando um nome de pessoa que nao
vai existir, para que seja retornado um DataSet vazio, apenas com a estrutura da
tabela para que se possa armazenar os dados localmente neste DataSet }

dsEntrevistado:= ws.GetEntrevistado( ‘nenhum’)

{ A mesma légica anterior }

end;
end
Ellise

end;
end;

XMLCache.GravarXML(dsEntrevistado, XMLCache.arqEntrevistado);

dsResposta := ws.GetRespostaEntrevistado(-1);
XMLCache.GravarXML(dsResposta, XMLCache.arqResposta);

MessageBox.Show( ‘Nenhuma pesquisa retornada’, ‘Informacdo’);

J

(o dispositivo que temos) ao PC.

Vocé precisard que o Device Emulator
Manager (encontrado na mesma pasta do
menu iniciar indicada anteriormente) e o
ActiveSync estejam rodando. O Active Sync
disponibiliza o icone k= no System Tray.

Clique com o botdo direito nele e escolha
a opcao Configuracoes de conexdo. Na janela
que abre, marque a opgao Permitir conexdo
com um dos seguintes itens e no campo abai-
xo, escolha DMA para permitir conectar
o computador virtualmente ao emulador,
sem uma conexdo fisica. Clique em OK.

Ap6s rodar o emulador, no Microsoft
Device Emulator deverd aparecer a refe-
réncia para o dispositivo, se ndo, clique no
Refresh. Com o botdo direito sobre o link
para dispositivo, dentro do Microsoft De-
vice Emulator, escolha a opgao Cradle, para

simular a conexdo do dispositivo ao PC.

O icone do ActiveSync deve ativar,
ficando verde, indicando que estd conec-
tando ao dispositivo. Apds ele concluir a
conexdo, vocé poderd acessar uma rede
local ou a internet a partir do dispositivo,
sem nenhuma configuragéo adicional.

Caso o dispositivo ndo seja conectado
pelo ActiveSync automaticamente, clique
com o botdo direito no icone do Active
Sync no System Tray e escolha a opcdo
Configuracoes de conexdo. Na janela que
abre, clique em Conectar.

Ap6s o emulador estar conectado no
ActiveSync, acesse o Storage Card e exe-
cute a aplicagdo. Para atualizar o sistema,
basta copiar o executdvel para a pasta
compartilhada e executar novamente no
emulador, sem precisar fechd-lo.
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Listagem 9. SelectedValueChanged do cbxPergunta

var
codPergunta: Integer
begin
{ Se ha alguma pergunta selecionada, mostra no ComboBox de alternativa (cbxResposta),
somente as referentes a pergunta selecionada }
if (cbxPergunta.SelectedIndex <> -1) and (cbxPergunta.SelectedValue <> nil) then
begin
{ Pega o cdédigo da pergunta selecionada }
codPergunta := Convert.ToInt32(cbxPergunta.SelectedValue);
{ Filtra o DataSet de alternativas para exibir apenas as alternativas da resposta selecionada |}
dsAlternativa.Tables[0].DefaultView.RowFilter := ‘cod_pergunta=" + codPergunta.ToString;
{ Vincula os registros filtrados ao ComboBox das Alternativas }
cbxResposta.DataSource := dsAlternativa.Tables[0].DefaultView;
{ Ndo deixa nenhum item marcado no ComboBox }
cbxResposta.SelectedIndex:= -1;
end;
end;

Listagem 10. Incluir Entrevistado

public
CodEntrevistado: integer
begin
{ Inclui o entrevistado no DataSet local, retornando o codigo tempordrio gerado para o
registro, pois este cdédigo é alterado quando o registro é enviado ao banco de dados }
CodEntrevistado := XMLCache.IncluirEntrevistado(dsEntrevistado, txtEntrevistado.Text,
Convert.ToInt32(cbxPesquisa.SelectedValue));
{ Exibe o cédigo gerado }
1bCodEntrevistado.Text := ‘Cédigo:
{ Desvincula o procedimento
cbxPergunta_SelectedValueChanged do evento SelectedValueChanged do cbxPergunta enquanto os
sdo vinculados ao cbxPergunta, para evitar que o evento seja disparado no momento errado }
Exclude(cbxPergunta.SelectedValueChanged, cbxPergunta_SelectedValueChanged);
try
{ Vincula os dados do DataSet dsPergunta ao cbxPergunta para que as perguntas sejam
exibidas no ComboBox }
cbxPergunta.DataSource := dsPergunta.Tables[0];
finally
{ Vincula novamente o procedimento cbxPergunta_SelectedValueChanged
SelectedlValueChanged do cbxPergunta |}
Include(cbxPergunta.SelectedValueChanged, cbxPergunta_SelectedValueChanged);
end;
{ Desmarca a pergunta atualmente selecionada }
cbxPergunta.SelectedIndex:= -1
{ Manda o cursor para o campo }
cbxPergunta.Focus;

* + CodEntrevistado.ToString;

dados

ao evento

Listagem 11. Procedimentos para navegar entre as perguntas

procedure frmMain.PerguntaAnterior
begin
{ Volta a pergunta anterior }
if cbxPergunta.SelectedIndex > 0 then
cbxPergunta.SelectedIndex := cbxPergunta.SelectedIndex - 1;
cbxPergunta.Focus;
end;

procedure frmMain.ProximaPergunta;
begin
{ Avanca a préxima pergunta }
if cbxPergunta.SelectedIndex < cbxPergunta.Items.Count - 1 then
cbxPergunta.SelectedIndex := cbxPergunta.SelectedIndex + 1;
cbxPergunta.Focus;
end;

Listagem 12. Registrar a resposta do entrevistado

{ Registra a resposta do entrevistado no DataSet local e passa para a préxima pergunta }
XMLCache.RegistrarResposta(dsResposta, CodEntrevistado, Convert.ToInt32(

cbxPergunta.SelectedValue), Convert.ToInt32(cbxResposta.SelectedValue));
ProximaPergunta;

Listagem 13. Salva os dados dos DataSets em arquivos XML

procedure frmMain.SalvarCachelocal;
begin
{ Se existe alguma tabela no DataSet e existe algum registro nela, salva os dados em arquivo }
if (dsEntrevistado.Tables.Count > 0) and
(dsEntrevistado.Tables[0].Rows.Count > 0) then
XMLCache.GravarXML(dsEntrevistado, XMLCache.argEntrevistado);
if (dsResposta.Tables.Count > 0) and (dsResposta.Tables[0].Rows.Count > 0) then
XMLCache.GravarXML(dsResposta, XMLCache.arqResposta);
end;

Continuando o desenvolvimento da
aplicacao cliente

Depois de ter testado o Device Emula-
tor, vamos continuar no desenvolvimento
da aplicagdo. Quando o usudrio selecio-
nar uma pergunta, devemos mostrar no
ComboBox de alternativas, somente as
referentes a pergunta selecionada. Assim,
no evento SelectedValueChanged do cbxPer-
gunta adicione o cédigo da Listagem 9.

Agora inclua o cédigo para o Click do In-
cluir, que fard a inclusdo do entrevistado no
DataSet local, conforme a Listagem 10.

Crie os procedimentos “PerguntaAnte-
rior” e “ProximaPergunta” para permitir
ao usudrio navegar entre as perguntas
disponiveis. Veja o cédigo dos dois pro-
cedimentos na Listagem 11.

Agora chame os procedimentos nos
seus respectivos botdes. No evento Click
do Registrar digite o c6digo da Listagem
12, para registrar a resposta do entrevis-
tado no DataSet local.

Testando a aplicacao

Compile a aplicagdo (usando a barra
do CF Builder), copie o executédvel para a
pasta compartilhada e execute-o a partir
do Storage Card no Device Emulator. Vocé
deverd acessar o menu Selecionar dados no
Servidor, caso ainda ndo tenha feito isso,
para guardar os dados da pesquisa, as
perguntas e alternativas, localmente em
arquivos XML no dispositivo mével.

Digite o nome do entrevistado e clique
em Incluir para registrd-lo. Em seguida,
selecione a pergunta, depois a resposta
e clique em Registrar. Repita esse tltimo
passo até responder todas as perguntas.

Para incluir um novo questiondrio de um
entrevistado, digite o nome do mesmo e cli-
que em Incluir, repetindo todo o processo.

Salvando em disco

Vamos agora fazer com que os dados
sejam salvos em disco quando o sistema
for fechado. Poderiamos fazer isso em
outro evento também, como a cada per-
gunta respondida. Assim, crie a funcao
da Listagem 13 e depois chame-a no
evento Closed do FrmMain.

Agora que fizemos a rotina para chamar
afungdo para salvar os DataSets localmen-
te, precisamos criar o c6digo para carregar
esses arquivos quando a aplicagdo inicia-
lizar. Assim, digite o c6digo da Listagem
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Listagem 14. Evento Load do FrmMain para carregar os arquivos XML

if XMLCache.CarregarXML(dsPesquisa,
begin

no ComboBox }
cbxPesquisa.DataSource :=

if XMLCache.CarregarXML(dsPergunta, XMLCache.a
XMLCache.CarregarXML(dsAlternativa,
{ Se carregou o arquivo de entrevistados, enta

XMLCache.CarregarXML(dsResposta,
end;

{ Se carregou o arquivo de pesquisas, carrega oS outros em seguida }
XMLCache.argPesquisa) then

{ Vincula os dados do DataSet dsPesquisa ao cbxPesquisa para exibir o titulo da pesquisa

dsPesquisa.Tables[0];
{ Se carregou o arquivo de perguntas, entdo carrega o de alternativas }

XMLCache.argAlternativa);

if XMLCache.CarregarXML(dsEntrevistado, XMLCache.argEntrevistado) then
XMLCache.arqResposta);

rgPergunta) then

o carrega o de respostas }

14 no evento Load do FrmMain.

Quando o usudrio tiver conexdo com a
rede local da
empresa, ele deve enviar os dados ao ser-

internet ou diretamente a

vidor para serem cadastrados nobanco de
dados, usando o EnviarCacheXML criada
anteriormente.

No FrmMain inclua um novo item no
MainMenu com o titulo (propriedade Text)
igual a “Enviar dados ao Servidor”. No
Click deste item inclua o c6digo a seguir
para chamar a fungdo recém-criada, que
enviard os dados armazenados localmen-
te em XML ao servidor:

XMLCache.EnviarCacheXML(dsEntrevistado,
dsResposta);

Rode a aplicagdo e faga os testes neces-
sérios (Figura 4).

Conclusao

Pronto, agora é s6 fazer os testes. Al-
guns detalhes para melhoria da interface
nao foram incluidos, como a habilitacdo/
desabilitagdo dos botdes nos momentos
adequados, para evitar problemas caso
0 usudrio ndo siga a ordem correta, mas
isso é bem simples de fazer e fica para
vocés poderem melhorar a aplicagéo.

Um recurso muito interessante seria a
inclusdo de um CheckBox para informar
se é para trabalhar off-line. Estando
desmarcado, a aplicacdo ja mandaria os
dados diretamente para o servidor.

Isso também é facil de implementar,
basta chamar as devidas fungdes, que ja
estdo implementadas. Outro detalhe, que
é bastante importante, é quanto ao con-
trole de transagdes que néo foi aplicado,
para garantir, por exemplo, que o registro

Acesse agora 0 mesmo o portal do assinante ClubeDelphi e assista a uma série de

www.devmedia.com.br/articles/listcomp.asp?txtsearch=Compact+Framework+no+Delphi

do entrevistado com os registros das res-
postas sejam todos incluidos ou, em caso
de erro, nenhum ser incluido.

Também ndo me preocupei em verificar
se o usudrio informou valores para os
campos, antes de inserir os dados. Assim,
fica o homework para vocés fazerem.
Neste artigo procurei mostrar a maioria
dos detalhes quanto a montagem do am-
biente de desenvolvimento, configuragdo
e utilizagdo das ferramentas assim como
macetes para permitir que vocé ingresse
no mundo do desenvolvimento de apli-
cagdes para dispositivos moveis.

Espero que tenham gostado e até o
préximo. @

[Pesquisa CuibeDelphi
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[Menoel Campes

IE' Cochgo: 1

Perguirita
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€

Figura 4. Aplicagao sendo testada no Pocket PC

PLLI? www.devmedia.com.br/clubedelphi/portal.asp

video aulas de Jefferson Junglaus, sobre o Compact Framework no Delphi.
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Contas a Pagar e Cobranca

Crie um sistema completo com Delphi, Firebird 2.0 e dbExpress - Parte 4

Adriano Santos

(artes@doiscliques.com)

é desenvolvedor Delphi desde 1998. Professor
e programador PHP. Bacharel em Comunicacdo
Social pela Universidade Cruzeiro do Sul, SP. £
colunista e membro da Comissdo Editorial da
revista ClubeDelphi. £ também Editor Técnico
da Revista ClubeDelphi. Mantém o blog Delphi
to Delphi (www.delphitodelphi.blogspot.com)
com dicas, informacdes e tudo sobre desenvol-
vimento Delphi.

hegamos a quarta parte do nosso

mini-curso Sistema de Contas a

Pagar e Cobranga onde estamos
vendo alguns dos principais recursos em
aplicagdes dessa natureza. Uma aplicagdo
de contas a pagar e cobranga nao se resume
apenas em entradas e saidas de caixa. Deve-
se pensar também em fluxo de caixa e
geragdo deboletos bancérios para cobranga,
um dos carros-chefe da aplicagdo.

Para iniciarmos nosso artigo, veremos
rapidamente o que foi criado no exemplo
anterior:

¢ Cadastro de contas a receber;

* Manutencdo do Data Module principal
para criacdo da tabela Contas_Receber;

* Criacdo do recurso de duplicagdo de
contas parceladas;

Daremos continuidade ao curso enten-
dendo e desenvolvendo outro recurso
bastante importante: Geragdo de texto
para Cobranga Escritural. Nesse artigo
veremos como fazer a geragdo do arquivo

texto para envio a instituicdo bancaria
que por sua vez se encarregard de gerar
os boletos e envio dos mesmos efetuando
desta forma a cobranga bancéria.

Alterando o banco de dados de
exemplo

Diferentemente dos artigos anteriores
ndo precisaremos criar tabelas. Dessa vez
criaremos uma Stored Procedure selecio-
nével que resultard os dados necessdrios
para geracgdo dos arquivos de remessa.

Uma Stored Procedure seleciondvel é
basicamente uma func¢éo criada no banco
de dados capaz de preencher um ou mais
pardmetros de saida que posteriormente
serdo usados pela aplicagdo Delphi como
se fosse uma tabela comum.

Nossa Stored Procedure fara um filtro na
tabela de contas a receber usando como
pardmetros de entrada duas datas. Essas
datas serdo usadas na clausula Where da SP
(“Stored Procedure”) onde faremos o filtro
no campo DT VECTO, ou seja, filtraremos
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todos os registros de contas a receber que
estejam entre as duas datas recebidas.

Serd levado em consideragdo também se
o registro é diferente de “I” (“inativo”) e
“B” (“baixado”). Assim evitamos enviar
um titulo inativo por meio de cancela-
mento/exclusdo ou ainda que tenha sido
liquidado (“baixado”).

Para criar nossa SP seleciondvel abra
o IBExpert e conecte-se a base de dados
de exemplo SysPague. Em seguida cli-
que com o botdo direito em Procedure
e selecione New Procedure. Repare que
o IBExpert exibe, em seu editor, uma
divisdo onde encontramos os botdes
Input Parameters, Output Parameters,
Variables e Cursor. E mais acima pode-
mos ver uma drea vazia com os titulos
Name, Type, Size, Scale, Default Source,
Subtype, Charset e Description. E nessa
drea que criaremos os pardmetros de
entrada (“Input Parameters”) e saida
(“Output Parameters”) que por sinal
se assemelha bastante com a criacgdo de
campos em uma tabela.

Pois bem, clique em Input Parameters
e com o botdo direito do mouse na drea
vazia selecione a opgao Append parameter/
variable ou localize este botdo logo acima
dessa drea e clique-o. Um novo pardmetro
serd criado, agora basta modificar seu
Name para “DT_INICIO” e seu Type para
“Timestamp” deixando o restante dos
itens com seus valores padrdo. Repita o
processo e crie um parametro chamado
“DT_FIM” também como “Timestamp”
em seu Type.

Nesse momento acabamos de criar dois
parametros de entrada que serdo usados
em nossa aplica¢do. Enviaremos para

Campo Tipo/Tamanho

CNPJ VarChar(18)
VALOR_REAL Numeric (15,2)
DT_CADASTRO TimeStamp
DT_VECTO TimeStatmp
(0ODIGO VarChar(20)
RAZAO VarChar(150)
ENDERECO VarChar(100)
BAIRRO VarChar(50)
CIDADE VarChar(50)
ESTADO VarChar(2)
CEP VarChar(9)

Tabela 1. Parametros de saida da SP

a Stored Procedure uma data de inicio e
outra de fim, assim nossa SP selecionara
automaticamente o que deverd ser envia-
do a instituicdo.

Agora vamos aos parametros de saida
chamados de Output Parameters. Sdo eles
que nossa SP alimentard e que serdo
utilizados pelo nosso sistema como se
fosse uma tabela comum do banco. Por-
tanto clique no item Output Parameters e
repita os passos anteriores incluindo os
parametros da Tabela 1.

Modifique o nome da Stored procedure
para “RetornarBoletos” na parte superior
direita do IbExpert. Caso prefira, execute
o script da Listagem 1.

Cobranca Escritural - CNAB

Para que possamos desenvolver a co-
brancga escritural, também chamada de
CNAB, devemos primeiramente entender
exatamente do que se trata e qual sua
finalidade.

CNAB significa “Comissdo de Tecno-
logia e Automacado Bancdria” e é basica-
mente um conjunto de regras estipuladas
para geracdo de dados em formato texto.
Esses dados sdo posteriormente enviados
a institui¢do bancdria para que sejam
processados. Esse conjunto de regras,

também chamado de padrdo, contém
texto em forma de colunas que seguem
regras definidas pela FEBRABAN (“Fede-
racdo Brasileira dos Bancos”). O conjunto
de regras estipuladas pela FEBRABAN é
chamado de layout.

Olayout do arquivo pode variar de ban-
co para banco devido as particularidades
de cada um, porém ndo é permitido que
fuja demais do padrdo estipulado.

Normalmente esses layouts sdo dispo-
nibilizados publicamente no website da
institui¢do para que desenvolvedores
possam adquirir e desenvolver suas pré-
prias solugdes. Contudo em alguns casos
o layout s6 pode ser adquirido por meio
de um correntista que possui usudrio e
senha de acesso ao portal do banco, por
isso muitas vezes é necessario que o pro-
prio cliente adquira o layout e o retrans-
mita ao desenvolvedor responsavel.

Os layouts CNAB seguem dois padroes:

* CNAB 240: Possui 240 posigdes, tam-
bém chamado de colunas, em cada linha.
Sendo que para cada boleto a ser gerado
pela institui¢do hd duas linhas de 240
colunas cada, ou seja, necessitamos gerar
um boleto bancdrio para cada cliente e su-
pondo que temos dez clientes, o arquivo
deverd possuir vinte linhas de registro;

-
Listagem 1. Criacdo da tabela e indices Contas_Receber

~

SET TERM * ;

CREATE PROCEDURE RETORNARBOLETOS (
DT_INICIO TIMESTAMP,
DT_FIM TIMESTAMP)
RETURNS (
CNPJ VARCHAR(18),
VALOR_REAL DOUBLE PRECISION,
DT_CADASTRO TIMESTAMP,
DT_VECTO TIMESTAMP,
CODIGO VARCHAR(20),
RAZAO VARCHAR(150),
ENDERECO VARCHAR(100),
BAIRRO VARCHAR(50),
CIDADE VARCHAR(50),
ESTADO VARCHAR(2),
CEP VARCHAR(9))
AS
begin
FOR SELECT
CP.CODIGO, CP.CNPJ, CP.VLR_REAL,
CP.DT_CADASTRO, CP.DT_VECTO, CL.RAZAO,
CL.ENDERECO, CL.BAIRRO, CL.CIDADE
CL.ESTADO, CL.CEP
FROM
CONTAS_RECEBER CP
INNER JOIN CLIENTES CL
ON (CP.CNPJ = CL.CNPJ)
WHERE

(CP.STATUS NOT IN (°I*, “B’))
INTO

:ESTADO, :CEP
DO
SUSPEND;
end”

"

(CP.DT_VECTO BETWEEN :DT_INICIO AND :DT_FIM) AND

:CODIGO, :CNPJ, :VALOR_REAL, :DT_CADASTRO,

:DT_VECTO, :RAZAO, :ENDERECO, :BAIRRO, :CIDADE,
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* CNAB 400: Sao 400 colunas para cada
linha do arquivo;

Atualmente o formato 240 estd sendo
gradativamente desativado pelas ins-
titui¢des por ter se tornado obsoleto,
complexo e trabalhoso de lidar.

A finalidade do CNAB é poder efetuar a
cobranga bancdria de titulos, ou seja, ap6s
enviada ao banco a remessa é processada
e boletos bancdrios sdo expedidos ao
cliente. O arquivo de remessa possui en-
tre as vdrias colunas dados como: valor,
vencimento, agéncia e conta onde o valor
pago serd creditado, instrugdes de protes-
to e dados do sacado, entre outros.

Além do arquivo Remessa o banco
disponibiliza o arquivo Retorno, que é
justamente o contrdrio de remessa. Com o
arquivo retorno podemos efetuar a baixa
do titulo em nosso sistema informando
valor pago, juros, mora, data de pagamen-
to, agéncia e conta creditada, e etc.

De porte de todas essas informagdes
fica fécil conferir o extrato bancdrio no
inicio ou fim do dia através do sistema
tendo como diferenga pequenas taxas e
tarifas, tais como: taxa de manutengao da
conta corrente e CPMF.

Nota: Nesse artigo veremos somente a
geracao do arquivo Remessa, porém a
operacao inversa segue basicamente a
mesma idéia.

Nota: Para uma melhor compreensao
do artigo é recomendada a leitura do
artigo Sistema EDI na edicéo 84 da re-
vista ClubeDelphi.

Como dito anteriormente, cada banco
possui certas particularidades em relacdo
ao padrao utilizado, portanto o mais sen-
sato é encontrar o layout CNAB do banco
desejado e fazer a leitura completa de
todo o arquivo de ajuda que normalmente
encontra-se em formato PDF ou DOC.

Além do layout as instituigdes cos-
tumam manter um departamento de
suporte ao desenvolvedor para sanar
possiveis duvidas com o layout e/ou
procedimentos de envio e retorno dos ar-
quivos a serem trocados entre instituicao
financeira e cliente.

A grande maioria dos bancos dispo-
nibiliza uma 4rea de testes para o de-

senvolvedor efetuar os primeiros testes
de carregamento e geragdo dos boletos
bancérios.

A geracado destes arquivos de remessa
pode ser feito utilizando-se de compo-
nentes de terceiros, mas por questdes de
didatica e entendimento do mecanismo
de desenvolvimento optei por fazer ma-
nualmente, até mesmo porque o processo
é bastante simples.

Preparando o sistema

Antes de iniciarmos o desenvolvimen-
to da caixa de didlogo e geragdo dos
arquivos, faremos a preparacdo pra a
leitura dos dados que sera feita através
da SP RetornarBoletos criada no inicio
do artigo.

Abra o Delphi 7 e em seguida o projeto
SysPague.dpr de nosso mini-curso. Ap6s
a abertura do projeto abra a Unit do Data
Module principal e inclua um novo grupo
de componentes para acesso a nossa SP.

Insira um componente do tipo SQL-
Query (“sqlBoletos”) e mude sua proprie-
dade SQLConnection para “sqlConexao”.
Em seguida digite a instru¢do SQL a se-
guir na propriedade SQL do componente
SQLQuery.

select * from RetornarBoletos(:DT_INICIO,
:DT_FIM) order by CNPJ

Note que criamos dois parametros na
instrucdo: DT_INICIO e a DT_FIM. Esses
parametros sdo usados para selecionar
quais os dados serdo retornados pela
Stored Procedure para que possamos entao
gerar o arquivo remessa. Em nossa SP
todos os registros da tabela Contas_Re-
ceber que tém data de vencimento entre
as DT_INICIO e DT_FIM e que seu status
ndo seja “I” (inativo) ou “B” (baixado)
serdo retornados.

Poderiamos requerer outros dados,
como por exemplo o CNPJ do cliente,
assim poderiamos gerar o arquivo de
remessa por cliente pagador. Para isso
seria necessdria a criacdo de um novo
pardmetro de entrada na SP.

Feito isso devemos agora configurar
os parametros criados pelo componente
SQLQuery, por isso clique duas vezes
na propriedade Params do sqlBoletos e
veja que ambos os pardmetros foram
criados.

Por se tratar de parametros do mesmo
tipo, faremos a configuragdo de ambos
ao mesmo tempo, por isso selecione-os
simultaneamente usando a tecla CTRL e
clicando com o mouse em cada um.

Agora pressione F11 para alternar para o
Object Inspector e mude a propriedade Da-
taType para “ftTimeStamp” e ParamType
para “ptInput”.

Feito isso, insira todos os pardmetros de
saida, que agora se tornardo campos, no
Fields Editor do sqlBoletos. Para isso clique
duas vezes no sqlBoletos e em seguida
com o botdo direito escolha a opcdo Add
all fields.

Como pode notar ndo hd segredos na
criacdo de SP’s seleciondveis. Faremos
a leitura de sei Result Set (“resultado da
consulta”) como se fosse uma tabela co-
mum do banco de dados.

Insira agora um componente do tipo
DataSetProvider (“dspBoletos”) da paleta
Data Access e configure sua propriedade
DataSet para “sqlBoletos”.

Coloque um ClientDataSet (“cdsBoletos”)
também da paleta Data Access e ligue-o
ao DataSetProvider usando a propriedade
ProviderName. Em seguida clique com o
botdo direito no componente e selecione
Fetch Params para que o cdsBoletos capture
os parametros criados no sqlBoletos.

Use a opgdo Add all fields do Fields
Editor para adicionar todos os campos
da SP seleciondvel assim como fizemos
no sqlBoletos. Se preferir modifique a
propriedade DisplayName de cada cam-
po adicionado conforme desejado. Essa
modificagdo refletird nos componentes
visuais incluidos em tela tais como Labels
e DBGrids. Veja como ficou nosso Data
Module na Figura 1.

Criando a tela gera¢ao da remessa
Nossa tela de geragdo dos arquivos de
remessa consiste apenas em receber o
periodo desejado para geragdo do CNAB
e aescolha de qual banco, agéncia e conta
serdo os mantenedores dos boletos.
Fixaremos a pasta de geracdo do ar-
quivo usando a funcdo ExtractFilePath
passando como parametro o método
ExeName do objeto TApplication mais o
nome do arquivo de remessa, que nesse
caso fixaremos como: “Remessa.txt”.
Fazendo isso garantimos que a pasta de
geracdo seja sempre o local onde nossa
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aplicacdo esteja rodando, ou seja, a pasta
de instalacdo do executdvel. Mostraremos
este caminho em um Label azul para que
o usudrio visualize e identifique rapida-
mente o caminho da remessa.

Vamos iniciar entdo a criagdo de um
novo formuldrio e para isso selecione
File|New>Form. Salve o formuldrio
usando o menu FilelSave as e atribua
a ele o nome “uCobrancaEscritural.
pas”. Em seguida mude a propriedade
Name do formuldrio para “frmCobran-
caEscritural”. Se desejar modifique sua
largura Width e altura Heigth bem como
as configuracdes de bordas: BorderStyle e
Borderlcons. Uma prévia da tela pode ser
vista na Figura 2.

Primeiramente adicione um componen-
te GroupBox da paleta Standard e dentro
dele insira dois DateTimePicker com os no-
mes “dtpDtlnicio” e “dtpDtFim” respec-
tivamente. Acima de cada um adicione
dois Labels com os Captions de “Data de
inicio” e “Data de fim” respectivamente.
Inclua um novo Label entre dtpDtInicio e
dtpDtFim com o Caption “a”.

Ap6s isso insira trés novos Labels e
mude o Caption de cada um para “Banco”,
“Agéncia” e “Conta”. Eles servirdo de no-
mes aos trés Edits que serdo adicionados
agora, sendo que cada um serd responsa-
vel por representar um campo da tabela
CONTAS, ou seja, coloque estes trés com-
ponentes e renomeie-os para “edtBanco”,
“edtAgencia” e “edtConta”.

Ap6s isso inclua um SpeedButton (“sbb-
SelecionarBanco”) e adicione uma ima-
gem ao mesmo usando a propriedade
Glyph. Se preferir copie o botdao de alguma
janela que ja tenhamos adicionado uma
instancia desse componente, como “Ca-
dastro de Clientes”, por exemplo, e cole-o
no formuldrio.

Ao centro dajanelainsira um ProgressBar
(“pgbProgresso”) da paleta Win32. Modi-
fique sua propriedade Step para “1”.

No rodapé da pagina adicone dois Labels
sendo que o primeiro deverd ter o Caption
alterado para “Salvar arquivo como:”. J4
no segundo Label (“IblICaminhoArquivo”)
cujo o Caption serd “C:\Temp” configure
as propriedades o e AutoSize para False.
Redimensione a largura e altura do [bl-
CaminhoArquivo de forma que ocupe a
largura da janela e duas ou mais linhas
de altura.

Adicione dois botdes a tela configuran-
do seus respectivos Captions para “Gerar”
e “Cancelar”. Modifique também a pro-
priedade Name do botdo “Gerar” para
“btnGerar” e do botao “Cancelar” para
“btnCancelar”.

Codificando o formulario

A primeira providéncia a tomarmos em
relagdo a codificagdo, serd alterar a pro-
priedade Caption do IblCaminhoArquivo
em dinamicamente para que o usudrio
possa visualizar onde o arquivo sera
salvo, por isso entre no evento OnShow
do formuldrio e apenas digite o cédigo
a seguir:
1b1CaminhoArquivo.Caption :=

ExtractFilePath(Application.
ExeName)+'Remessa.txt';

Como mencionado anteriormente esta-
mos concatenando o diretério de instala-
¢do do executdvel com o nome de arquivo
que é fixado em “Remesssa.txt”.

Cobranca Escritural
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Figura 1. Data Module alterado
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Figura 2. Tela de sugestao da Cobranga Escritural
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Salvar 0 arquivo como: - - - ...

o
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Listagem 2. Botao de pesquisa de bancos
procedure TfrmCobrancaEscritural.
sbbSelecionarBancoClick(Sender: TObject);
begin
frmPesquisaPadrao := TfrmPesquisaPadrao.Create(Self);
with frmPesquisaPadrao do
begin
FTabela := ‘Contas’;
FDataSetAlvo := dmdPrincipal.cdsContas;
ShowModal;
if (ModalResult = mrOk) and not
(dstGenerico.DataSet.IsEmpty) then
begin
edtBanco.Text := dstGenerico.DataSet.FieldByName( ‘BANCO’).AsString;
edtAgencia.Text := dstGenerico.DataSet.FieldByName( ‘AGENCIA’).AsString;
edtConta.Text := dstGenerico.DataSet.FieldByName( ‘CONTA’).AsString;
end;
FreeAndNil(frmPesquisaPadrao);
end;
& J

Edicao 90 - ClubeDelphi 17



Em seguida faremos a codificagdo do
botéao sbbSelecionarBanco que possui exa-
tamente o mesmo método de pesquisa
padrdo encontrado nas janelas “Baixar
contas a receber” e “Baixar contas a
pagar”, ou seja, faz uso do formuldrio
“Pesquisa padrdo”.

Se preferir abra um dos formularios
de baixa descritos anteriormente e copie
o evento do botdo de pesquisa para o
sbbSelecionarbanco. O c6édigo deste botdo
estd descrito na Listagem 2.

Nota: Nao esqueca de que para funcio-
nar a Pesquisa Padrdo seu formulario
deve ser adicionado ao Uses do formu-
lario Cobranca Escritural e paraisso serd
necessario pressionar ALT+F11 ouirao
menu File|Use unit.

Nessa parte do artigo faremos uso tam-
bém de algumas fungdes e procedimen-
tos especiais para s6 entdo codificarmos

a geracdo da remessa propriamente dita.
Essas fungdes e procedimentos especiais
se fazem necessdrias, pois devemos

adequar nosso arquivo de remessa aos
padrdes de CNAB. Essas fungdes sdo:

e LimparString: Retira caracteres de uma
String conforme o segundo parametro
passado. Ideal para limpar médscaras em
campos do tipo CPF, CEP e CNPJ;

e PadL: Alinha o texto a esquerda in-
cluindo caracteres em branco a direita da
string; Ideal para completar as posi¢des a
esquerda do texto que precisam ser preen-
chidas para se enquadrar com o nimero
de caracteres solicitados pelo CNAB;

* PadR: Ao contrdrio de PadL, ou seja, ali-
nha o texto a direita incluindo caracteres
em branco a esquerda da String.

* Replicar: Repete um determinado ca-
ractere “n” vezes;

* SoNumeros: Retira mdscaras de ntime-
ros deixando somente niimeros inteiros;

Para incluir as fungdes e procedimen-

( )
Listagem 3. Fungdes e procedimentos especiais
function TfrmCobrancaEscritural.
LimparString(ATexto, ACaracteres: string): string;
var
strAux : string;
I : integer;
begin
strAux := *’;
for I := 1 to Length(ATexto) do
if Pos(Copy(ATexto, I, 1), ACaracteres) <= 0 then
strAux := strAux + Copy(ATexto, I, 1);
Result := strAux;
end;
function TfrmCobrancaEscritural.PadL(ATexto: string; ATamanho: Integer): string;
var
I : integer;
begin
Result := ATexto;
for I := 1 to (ATamanho - Length(Result)) do
Result := Result + ° °;
end;
function TfrmCobrancaEscritural.PadR(ATexto: string; ATamanho: integer): string;
var
I : integer;
begin
Result := ATexto;
for I :=1 to (ATamanho - Length(Result)) do
Result := * ° + Result;
end;
function TfrmCobrancaEscritural.SoNumeros(const ATexto: string): string;
var
I: Integer;
S: string;
begin
S 8= ““3
for :=1 to Length(ATexto) do
if (ATextol[I] in [‘0°..°9°]) then
S := S + Copy(ATexto, I, 1);
Result :=S;
end;
function TfrmCobrancaEscritural.Replicar(ATexto: string; AVezes: Integer): string;
var
I: Integer;
begin
Result := “7;
for I := 1 to AVezes do
Result := Result + ATexto;
end;
| J

tos acima, declare-as na se¢do Public do
formuldrio conforme a seguir e pressione
CTRL + SHIFT + C para que o Delphi crie
para nds o cabegalho das mesmas.

function LimparString(

ATexto, ACaracteres: string): string;
function PadL(

ATexto: string; ATamanho: Integer): string;
function PadR(

ATexto: string; ATamanho: integer): string;
function Replicar

(ATexto: string; AVezes: Integer): string;
function SoNumeros(

const ATexto: string): string;

Encontre na drea Implementation do
formulario o cabecalho de cada fungdo
e codifique de acordo com a Listagem 3
onde vocé pode ver o c6digo de todos os
procedimentos e fungdes.

Algumas consideragdes devem ser revis-
tas antes de iniciarmos a codifica¢do do
layout. De acordo com o padrdao CNAB:

* Todo campo de texto deve ser formata-
do com alinhamento a esquerda e preen-
chido com caracteres brancos a direita;

* Todo e qualquer campo numérico deve
ser alinhado a direita precedido de zeros;

* Campos de valor, como juros, mora e
valor do boleto, devem ser apresentados
sem formatagdo monetdria, ou seja, sem
quaisquer separadores seja ele milhar
ou decimal;

* Campos de data devem obedecer ao pa-
drao estipuladonolayout dobanco podendo
variar bastante de um banco para outro, ex:
DDMMYYYY, DDMMYY, DMY e etc.;

Muito bem, agora precisamos apenas
codificar a parte mais importante de
nosso exemplo que é o evento OnClick
botao btnGerar. Por isso clique duas vezes
no botdo em questdo e digite o c6digo da
Listagem 4.

Entendendo o cédigo

O cédigo de geragdo da remessa nao
possui, na verdade, nenhuma madgica ou
efeito especial de cinema. Nas primeiras
linhas do cédigo estamos declarando
duas varidveis que receberdo o endereco
de memoria do arquivo e o ntimero da
linha gerada.

Primeiramente atribuimos o valor dos
parametros DT_INICIO e DT_FIM do
cdsBoletos, presente no Data Module, o
mesmo valor dos campos dtpDtlnicio e
dtpDtFim que sdo as datas de inicio e fim
do periodo de vencimento dos boletos.
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MINI-CURSO

Em seguida abrimos o ClientDataSet que
por sua vez executa a Stored Procedure
RetornarBoletos. Caso o método IsEmpty
do cdsBoletos retorne diferente de True,
ou seja, se houverem dados no Resultset
do ClientDataSet significa que existem
boletos a serem gerados.

Verificamos entdo a existéncia do arqui-
vo Remessa.txt no diretério da aplicacdo
e 0 apagamos caso exista, assim criamos
um arquivo novo no diretério.

Nota: Poderiamos criar uma funcao
para retornar nomes aleatdrios para
que pudéssemos guardar o arquivo an-
terior, porém nao ha necessidade de se
guardar os arquivos de remessa ja en-
viados ao banco.

Os métodos AssignFile e ReWrite, criam e
inicializam o arquivo Remessa.txt criando
em memoria uma instancia deste arquivo
para ser manipulado pelo sistema.

Um arquivo CNAB é composto por
basicamente trés secGes:

* Header: Cabegalho do arquivo conten-
do informacgées sobre o sacador;

* Detail: Sao os boletos em si. No padrao
CNAB 240 sao duas linhas de Detail (“de-
talhe”) para cada boleto gerado;

* Trailler: Rodapé do arquivo, normal-
mente consta somente o nimero de
registros gerados e a data;

A primeira parte do arquivo consiste
em escrever o Header da remessa, ou
seja, o cabecalho do CNAB. Note que
a ultima linha antes do fim do Header

usamos a func¢do WriteLn. O WriteLn es-
creve o texto e quebra a linha enviando
o cursor para a linha posterior ao passo
que Write apenas escreve o texto sem
mover o Cursor.

Ao entrar no lago while..do estamos
escrevendo o Detail do arquivo que é
justamente o detalhe, ou detalhamento de
cada boleto a ser gerado pela institui¢do
financeira. Cadalinha gerada é um boleto
bancdrio que o banco se encarregard de
gerar e enviar ao sacado. Apds o término
do lago escrevemos o Trailler, ou rodapé
do arquivo remessa.

Esses sdo todos os passos efetuados
no cédigo visto agora a pouco. Como
vimos ndo hd segredos. Nas Figuras 3 e
4 podemos ver o sistema em execugdo e
uma prévia do arquivo carregado.

( )
Listagem 4. C6digo do botdo Gerar
procedure TfrmCobrancaEscritural.btnGerarClick(Sender: TObject); Write (Arquivo, Replicar(® “, 4));
var Write (Arquivo, PadL(‘USO DA EMPRESA’, 25)):
Arquivo: TextFile; Write (Arquivo, PadlL(Copy(FieldByName( ‘CODIGO’).AsString, 1, 8), 8));
Contador: Integer; Write (Arquivo, Replicar(‘0’, 12));
begin Write (Arquivo, “109°);
with dmdPrincipal, cdsBoletos do Write (Arquivo, ‘00°);
begin Write (Arquivo, PadL(Copy(FieldByName(‘CODIGO')‘AsStm‘ng, 1, 10), 10));
{ Para uso da fungdo de conversédo Write (Arquivo, FormatDateTime( ‘DDMMYY’
DateTimeToSQLTimeStamp declare SQLTimSt } FieldByName( ‘DT_VECTO’).AsDateTime))
cdsBoletos.Params.ParambyName(‘DT_INICIO"). Write (Arquivo, FormatFloat(* #M######## HE
AsSQLTimeStamp := DateTimeToSQLTimeStamp FieldByName( ‘VALOR_REAL’).AsFloat));
(dbeDtInicio.DateTime); Write (Arquivo, ‘341°);
cdsBoletos.Params.ParambyName( ‘DT_FIM’). Write (Arquivo, PadL(LimparString(edtAgencia.Text, *.-’), 6));
AsSQLTimeStamp := DateTimeToSQLTimeStamp Write (Arquivo, ‘01°);
(dbeDtFim.DateTime); Write (Arquivo, ‘A’);
cdsBoletos.Open; Write (Arquivo, FormatDateTime( ‘DDMMYY’,
if not cdsBoletos.IsEmpty then Fw’eldByName(‘DLCADASTRO‘).AsDateTime));
begin Write (Arquivo, ‘02°);
{ Gera os arquivos para a cobranca escritural } Write (Arquivo, ‘097);
if FileExists(ExtractFilePath(Application. Write (Arquivo, FormatFloat(* ######W### HE
ExeName)+’Remessa.txt’) then Write (Arquivo, FormatDateTime( ‘DDMMYY’
DeleteFile(ExtractFilePath(Application. FierByName(‘DT_VECTO‘).ASDateTTme));
ExeName) +’Remessa.txt’); Write (Arquivo, FormatFloat( ‘JHHHHHHHHHEE.#H . 0));
{ Cabegcalho / Header do Arquivo |} Write (Arquivo, FormatFloat( ‘{HHHHHHHHHHEHE . 0));
Contador := 1; Write (Arquivo, FormatFloat (“{HHHHHHHHHHE #HE' . 0));
AssignFile(Arquivo, ExtractFilePath( Write (Arquivo, ‘02’);
Application.ExeName)+’ Remessa.txt’); Write (Arquivo, PadL(LimparString(edtAgencia. Text, ‘.-’), 6));
ReWrite(Arquivo); Write (Arquivo, PadL(Copy(FieldByName( ‘RAZAO’)
Write (Arquivo, ‘01°); .AsString, 1, 30), 30));
Write (Arquivo, ‘REMESSA’); Write (Arquivo, Replicar(‘ “, 10));
Write (Arquivo, ‘01°); Write (Arquivo, PadL(Copy(FieldByName(‘ENDERECO’).AsString, 1, 40), 40));
Write (Arquivo, °‘COBRANCA’); Write (Arquivo, Padl(Copy(FieldByName( ‘BAIRRO’).AsString, 1, 12), 12));
Write (Arquivo, edtAgencia.Text); Write (Arquivo, LimparString(FieldByName(‘CEP’).AsString, ‘-’), 8);
Write (Arquivo, ‘00°); Write (Arquivo, PadL(Copy(FieldByName(‘CIDADE’).AsString, 1, 15), 15));
Write (Arquivo, edtConta.Text); Write (Arquivo, FieldByName( ‘ESTADO’).AsString);
Write (Arquivo, Replicar(® *, 6)); Write (Arquivo, Replicar(*® *, 42));
Write (Arquivo, °‘CLUBEDELPHI LTDA.’); WritelLn(Arquivo, FormatFloat(‘000000’,Contador));
Write (Arquivo, °341°); Next;
Write (Arquivo, ‘BANCO ITAU SA “); pgbProgresso.Steplt;
Write (Arquivo, FormatDateTime( ‘DDMMYYYY’, Now)); end;
Write (Arquivo, Replicar(® *, 294)); { Rodapé / Trailler do Arquivo }
WritelLn(Arquivo, FormatFloat(‘000000°, Contador)); Inc(Contador);
{ Fim do Header do Arquivo } Write (Arquivo, ‘9°);
pgbProgresso.Position; Write (Arquivo, Replicar(‘ *, 393));
pgbProgresso.Max := RecordCount; WriteLn(Arquivo, FormatFloat(‘000000°, Contador));
while not EOF do { Fim do Header do Arquivo }
begin CloseFile(Arquivo);
Inc(Contador); MessageD1g( ‘Aquivo gerado com sucesso!’, mtInformation, [mbOk], 0)
{ Salva alguns dos principais dados no arquivo de remessa } end
Write (Arquivo, ‘1’); else
Write (Arquivo, ‘02°); begin
Write (Arquivo, LimparString(FieldByName( ‘CNPJ’).AsString, ‘.-’)); MessageD1g(‘Nada selecionado!’, mtWarning, [mbOk]l, 0);
Write (Arquivo, PadL(edtBanco.Text, 4)); dbeDtInicio.SetFocus;
Write (Arquivo, ‘00°); end;
Write (Arquivo, PadL(LimparString(edtAgencia.Text, *.-’), 6)); end;
Write (Arquivo, Replicar(® *, 4)); end;
| J
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Ultimas consideracdes
Além de todas essas informagdes que

vimos hd ainda que se pensar e lembrar
que existem diversas carteiras de co-
branga a serem utilizadas. As carteiras de
cobrangas sdo as regras basicas de como o
banco fard a execugdo da cobranga junto
ao cliente de seu usudrio.

Também é importante salientar as
formas de cobranca que sdo com e sem
registro. Sem registro e com registro sdo
na verdade algumas das modalidades
de cobranga. Em nosso caso estamos
utilizando cobranga com registro o que
significa que estamos registrando previa-
mente os dados de cobranga no banco de
dados da instituicdo através do envio de
arquivos texto.

Para mais detalhes consulte o gerente de
sua conta corrente para que ele possa lhe
passar todas as informagdes necessdrias
a respeito do assunto.

Conclusao

Finalizamos a quarta parte deste mini-
curso gerando a cobrancga escritural,
CNAB, onde tivemos a oportunidade de
ver como fazer na prética a geragao de
um arquivo remessa. Esses sdo apenas
0s passos mais importantes da geracao,
porém o desenvolvimento como um todo
requer um grau de atengdo ainda maior
para que todas as regras impostas no
layout sejam cumpridas.

Sempre que for preciso consulte o su-
porte técnico do banco para qual esteja
desenvolvendo o CNAB para que nado

fiquem dtividas durante a programacéao
do processo.
Um forte abrago e até a préxima. @
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Figura 3. Arquivo gerado com sucesso

I Remessa.txt - Notepad

oL —20012.223.556 CLUBEDELPHI LTDA. 3416 |
10261522552,/000123237 0000712 Us0o DA EMPRESA 20070905000000
10261522552,/000123237 0000712 Uso DA EMPRESA 20070905000000
10261522552,/000123237 0000712 Uso DA EMPRESA 20070905000000
10261522552,/000123237 0000712 Uso DA EMPRESA 20070905000000
10261522552,/000123237 0000712 Us0 DA EMPRESA 20070905000000
10261522552,/000123237 0000712 Uso DA EMPRESA 11225136000000

o

.l | %

Figura 4.Remessa gerada com sucesso
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Leitores de Codigo de Barras

Veja como sua aplicagdo pode trabalhar com esse padrao

Adriano Santos

(artes@doiscliques.com)

é desenvolvedor Delphi desde 1998. Professor
e programador PHP. Bacharel em Comunicagdo
Social pela Universidade Cruzeiro do Sul, SP. 4
colunista e membro da Comisséo Editorial da
revista ClubeDelphi. £ também Editor Técnico
da Revista ClubeDelphi. Mantém o blog Delphi
to Delphi (www.delphitodelphi.blogspot.com)
com dicas, informagoes e tudo sobre desenvol-
vimento Delphi.

uso intenso de cédigo de barras

em documentos e produtos

virou rotina nos mais diversos
meios. Com isso diversas empresas
desenvolveram leitores de cédigo
de barras atendendo a demanda de
mercado. Ha leitores para varios pa-
droes. Nesse artigo veremos algumas
caracteristicas desses leitores, como
se comportam, quais as diferengas e
um pouco de conceito e histéria sobre
Coédigo de Barras.

Vamos montar duas pequenas aplica-
¢des que podem fazer uso destes equi-
pamentos para agilizar determinados
processos.

Nota: Para esse artigo é necessario ter
instalado um leitor de documentos
e um leitor de cédigo de barras. Su-
gestdo para compra: DR-20 e BR-210
respectivamente, ambos da empresa
Bematech.

Entendendo o projeto

Para entendermos como funcionam os
leitores de cédigo de barras e de docu-
mentos, criaremos duas aplica¢des sim-
ples que fardo uso de técnicas, também
simples, para leitura e localizacdo das
informagdes no banco de dados.

Optei por utilizar os equipamentos
DR-20 (“Leitor de Documentos”) e BR-210
(“Leitor de c6digo de barras”) da empresa
Bematech, ambos de baixo custo.

Ambas aplicagdes receberdo o valor lido
do c6digo de barras e entdo fardo a pro-
cura da informagdo no banco de dados
de exemplo. Faremos uma aplica¢do para
entrada de produtos em estoque e outra
para leitura de boletos bancérios.

Conceitos e diferencas entre os
equipamentos

Uma das primeiras coisas que devemos
entender antes de desenvolver qualquer
tipo de aplicacdo que faga uso de cédigo
de barras é: como funcionam?

22 ClubeDelphi - Leitores de Cédigo de Barras



MAO NA MASSA

Segundo o verbete “Cédigo de Barras”
no site da wikepedia.org:

“O cédigo de barras é uma representagdo
grdfica de dados que podem ser numéricos
ou alfanuméricos dependendo do tipo pa-
drdo empregado.

As linhas paralelas e verticais escuras e 0s
espagos entre elas tém diferentes larguras em
fungdo das vdrias técnicas de codificacdo de
dados empregada. A decodificagio dos dados
representados é realizada por um equipamento
chamado “scanner”, dotado de uma fonte lumi-
nosa vermelha, que por contraste das barras e
seus espagos convertem a representagdo grdfica
em "bits” (sequéncias de 0 ou 1), compreendidos
pelo computador, que por suavez converte-os em
letras ou niimeros legtveis para nés.”.

Entendemos entao, que a leitura do c6-
digo somente pode ser efetuada através
de um equipamento que segue as normas
internacionais de decodificacido. Esses
equipamentos “escaneiam” as diversas
barras e traduzem para uma leituralegivel
pelo ser humano através de caracteres
numéricos e/ou alfanumeéricos. E por
falar em normas internacionais, um dos
c6digo de barras mais conhecido é o EAN/
UPC, usado para identificar produtos no
comércio. Esses c6digos sdo impressos nas
embalagens de todo tipo de produto.

H4 diversos EAN’s disponiveis para os
mais variados produtos, como por exem-
plo EANS e EAN13. Veja a seguir alguns
tipos de cédigo de barras.

Em nosso exemplo usaremos o cédigo
de barras numérico para identificagdo de
boletos bancarios e outro alfa numérico
para entrada de dados no estoque.

Cédigo de baras para pesquisa

Gide._ Enirada

Junsisio praplotde. D Peop |

Entrada no estoque

Faremos uma aplicacdo simples,
entdo méaos a obra. Entre no Delphi
7 e crie uma nova aplicagdo usando
File| New>Application. Salve o formuldrio
principal como “uPrincipal.pas” e mude
seu Name para “frmPrincipal”. Modifique
as propriedades Caption, Borderlcons e
BorderStyle a seu gosto. Para este exem-
plo fiz as seguintes alteragdes: Caption
igual a “Entrada de Estoque”, biMaximize
igual a False e bsSingle respectivamente.
Aproveite e salve também o projeto como
“Estoque.dpr”. Desenhe uma janela como
mostrado na Figura 1.

Criaremos uma tabela de estoque com
os campos vistos na Figura 1, portanto
insira um componente ClientDataSet
(“cdsEstoque”) da paleta Data Access e dé
um duplo clique de direita nele. Usando
a opcdo New Field no menu de contexto
do Fields Editor, crie cinco campos no
cdsEstoque conforme a Tabela 1.

Como pode notar, o campo CODIGO,
principal campo da tabela, recebe o
cédigo de barras do produto, é do tipo
String. Isso é necessdrio, jd que estamos
usando o padrdo alfanumérico para
identificagdo do produto.

O correto em caso da identificagdo de
produtos é fazer uso dos padrdes EANS e
EAN13 que sdo cédigo de barras numéri-
cos, porém € perfeitamente possivel fazer
uso de qualquer outro tipo padrao. Nesse
caso estamos levando em consideragdo
que nosso cliente deseja manipular seus
produtos no estoque usando caracteres
alfa, ou seja, letras e nimeros.

Alguns editores de relatérios, como o

Report Builder e QuickReport por exem-
plo, sdo capazes de gerar etiquetas de
cédigo de barras automaticamente com
base em um campo do banco de dados,
desta forma ficaria facil a criacao e leitura
de barras em um estoque.

Ap6s a inclusdo dos campos no Fields
Editor do cdsEstoque, crie o DataSet em
meméria usando a opgao Create DataSet e
em seguida gere um arquivo XML com o
nome de “Estoque.xml”. Para criagdo do ar-
quivo XML use a opcao Save MyBase to Xml
table com o botdo direito no cdsEstoque.

Insira um DataSource da paleta Data
Access e faga as devidas ligagdes entre
DataSource, ClientDataSet e DbGrid.

Nota: Os nomes dos componentes envol-
vidos na programacao sao: Edit (“edtCodi-
goBarras”) e SpinEdit (“speQtde”), Button
“Confirma” (“btnConfirma”), Button “Sal-

var” (“btnSalvar”).

Codificando

Vocé vai notar que a codificacdo desse
exemplo ndo contém nenhuma progra-
macao em especial. Isso porque, diferen-
temente dos dois artigos anteriores, ECF
e Impressdo de Cheques, ndo hd intera-
tividade direta com o equipamento nem
com arquivos DLL, jd que o equipamento
é apenas um periférico de entrada, ou
seja, basta colocar o cursor do mouse no
campo onde se deseja receber o cédigo de

LIMNHABASE

01223455720

(6digo de Barras alfanumérico utilizado
em diversas situaces

(6digo de Barras nimero, utilizado para diversas
finalidades como boletos bancdrios por exemplo.

7oas H FETE “

G-

a7e-12-345-6700-

15BN
g ‘ Ta12324 SG72

SRSTET 20

200

7

o7
EAN8 e EAN13 respectivamente sdo

Figura 1. Exemplo de janela de estoque

ISBN, usado para identificagdo de obras
literdrias como livros, revistas etc.

utilizados em identificagdes de produtos
em todo 0 mundo.
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barras, apontar o leitor para a etiqueta e
aguardar a captura dos dados.
Oleitor faz o “escaneamento” das barras

decodificando os dados e enviando-os
ao componente que espera o cédigo.
Em seguida um “enter” é simulado pelo
proprio dispositivo. Desta forma, basta
codificarmos o evento OnExit do Edit
de maneira que ele busque no banco de
dados o c6digo de barras recebido.

Para testarmos inclua o cé6digo da Lis-

tagem 1 ao evento em questdo. A expli-

Eetorno ao Padrao de Fabeica (Restore Defaull )

Sajda da Habilitagio sem Salvar

Conflguracio Através R5132

Lista de Habilitagio

Plgimal

Figura 2. Exemplo de cartdo de calibraao

cacao é simples: apenas fazemos uso do
método Locate do cdsEstoque para entdo
localizar o produto no campo CODIGO
da tabela Estoque.

Caso encontre, a tabela entra em modo
de edicao e o foco é colocado no SpinEdit
afim de aguardar a digitacdo da quanti-
dade de entrada. E em caso negativo o
sistema pergunta ao usudrio se ele deseja
fazer ainclusdo do produto usando como
cédigo o préprio contetido do Edit.

Na Listagem 2 encontramos o cédigo
dos botdes btnConfirmar e btnSalvar. O bo-
tdo Confirmar incrementa a quantidade
do produto em estoque e o botdo Salvar
persiste os dados no Estoque.xml.

E por fim no evento OnShow do formu-
lario apenas chama o método LoadFromFi-
le do cdsClientes para abrir o arquivo XML
e disponibilizar para uso.

cdsEstoque.LoadFromFile(ExtractFilePath
(Application.ExeName)+'Estoque.xml');
cdsEstoque.Open;

A leitura dos dados da etiqueta é feita
pelo equipamento BR-210 da Bematech
mencionado no inicio do artigo. Segun-

N\
Listagem 1. Evento OnExit
procedure TfrmPrincipal.edtCodigoBarrasExit(Sender: TObject);
begin
if cdsEstoque.Llocate(‘CODIGO’, edtCodigoBarras.Text, []) then
begin
cdsEstoque.Edit;
speQtde.SetFocus;
end
else if not (ActiveControl = btnSair) then
begin
if MessageD1g(‘Produto ndo encontrado no estoque!’ + #13 +
‘Deseja incluir agora?’, mtConfirmation, [mbYes, mbNo]l, 0) = mrYes then
begin
cdsEstoque.Append;
cdsEstoque.FieldByName( ‘CODIGO’).AsString := edtCodigoBarras.Text;
speQtde.SetFocus;
end;
end;
end;
Listagem 2. (ddigo dos botdes btnConfirmar e btnSalvar
procedure TfrmPrincipal.btnConfirmaClick(Sender: TObject);
begin
if cdsEstoque.State in [dsEdit] then
begin
cdsEstoque.FieldByName( ‘QTDE’).AsInteger :
cdsEstoque.FieldByName( ‘QTDE’).AsInteger + speQtde.Value;
cdsEstoque.Post;
end;
end;
procedure TfrmPrincipal.btnSalvarClick(Sender: TObject);
begin
cdsEstoque.SaveToFile(ExtractFilePath(Application.ExeName)+’Estoque.xml’);
end;
& J
. ClubeDelphi h “d' www.devmedia.com.br/clubedelphi/portal.asp
Acesse agora 0 mesmo o portal do assinante ClubeDelphi e assista a uma video aula de Luciano Pimenta que mostra como criar relatérios com cédigo de
barras no QuickReport.

www.devmedia.com.br/articles/viewcomp.asp?comp=3017&hI=c%F3digo%20de%20barras

do o manual do dispositivo bem como o
suporte técnico da empresa, um cartdo
com c6digo de barras para calibragdo e
programacdo do equipamento é enviado
com a ele na compra.

Isso significa que para utilizacdo do
leitor é necessdrio apontd-lo para um dos
cédigo de barras impresso em seu cartdo
de calibracdo para s6 entdo utiliza-lo.
Normalmente essa configuragdo é feita
apenas uma vez. Um exemplo desse
cartdo pode ser visto na Figura 2. Veja o
sistema em funcionamento na Figura 3.

Testando

Da mesma forma que no exemplo
anterior, veremos o que fazer para de-
senvolver uma aplicagdo capaz de ler o
c6digo de barras e localizar um docu-
mento na tabela de contas a pagar. Nesse
caso temos um agravante: 0 campo nao
pode ser do tipo Integer em um Clien-
tDataSet usando como tabela um XML,
pois campos Integer guardam valores
entre -2147483648..2147483647 e o nado
comportaria o cédigo de barras de um
documento que possui 34 nimeros. Por
esse motivo criaremos um campo BOLE-
TO do tipo String no ClientDataSet.

Partiremos do principio que nosso usu-
drio quer ter a possibilidade de localizar
em seu banco de dados boletos bancarios
previamente inseridos e necessita fazer
a baixa dos mesmos. Ou ainda quer
efetuar a baixa de boletos e duplicatas
disparadas ao seus clientes por meio do
contas a receber. Desta forma teria mais
agilidade na hora de localizar e baixar
o registro evitando ainda a baixa de

Campo Tipo/Tamanho

(0DIGO String (8)
PRODUTO String(120)
UNITARIO Float

QTDE Integer
DATA_REAJUSTE DateTime

Tabela 1. Tabela de estoque do sistema

Campo Tipo/Tamanho

BOLETO String(34)
DESCRICAO String (50)
VALOR Float
DT_VECTO DateTime

BAIXA Boolean

Tabela 2. Tabela de contas a pagar
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MAO NA MASSA

. e N
boletos equwocadamente' Listagem 3. Cédigo do evento OnExit do Exemplo 2
Crie uma nova aplicagdo, salve-a como _ _
P . procedure TForml.edtBoletoExit(Sender: TObject);
Leitores.dpr” e desenhe-a semelhante a begin
1 Z . . . if p . ‘ ., T i
Flgura 4. Salve o formuldrio pr1nc1pal lw)em;gsCOr1tas agar.Locate( ‘BOLETO’, edtBoleto.Text, []) then
como “uPrincipal.pas”. Insira um Clien- 1‘bfeg4$;sageD1g(‘Conﬁrma baixa do boleto bancario?’, mtConfirmation, [mbYes, mbNo]l, 0) = mrYes then
tDataSet (“cdsContasPagar”) e crie a es- cdsContasPagar.Edit;
cdsContasPagar.FieldByName( ‘BAIXA’).AsBoolean := True;
trutura de campos conforme a Tabela 2. cdsContasPagar.Post;
Crie a estrutura da tabela em meméria eng(ﬁtsContasPagar.SaveToF11e(E><tractF11ePath(Appl1cat1on.E><eName)+ ContasPagar.xml’);
usando Create DataSet e em seguida salve engﬁd?
o arquivo XML usando a opgdo Save to - -
MyBase Xml table. Crie o XML com o nome
T p—
“ContasPagar.xml”. hminta B
No evento OnShow do formuldrio inclua g‘glﬂ“ de barras para pesquisa
uma chamada ao método LoadFromFile do !
cdsContasPagar conforme a seguir: Gnde: Ente s
o 2| o |
cdsContasPagar.LoadFromFile e b =] =/ Saens
(ExtractFilePath(Application.ExeName) = S = e
+'ContasPagar.xml'); [ [Frogsto |Unitarin Faj[osde. [De. Fuong -
cdsContasPagar.Open; | _faasaerir OO T P At 1am 0 tn/aanat
!_I"EE-I_'"E-" CELLLAR HOV&ETH (] T
| |SSE a0 HOTEECOR ATER ek o 1BTRA00T
Em seguida codifique o evento OnExit
do edtBoleto de maneira que o contetido do ) oAl sdets Mg
Edit seja procurado no campo BOLETO da =1 |
. B L
tabela ContasPagar.xml. Listagem 3. — 3
Novamente note que ndo hd segredos.

Apenas utilizamos o método Locate do Da-
taSet cdsContasPagar e entdo perguntando Figura 3. Sistema de estoque em funcionamento
se o usudrio deseja efetuar a baixa.

Em contato com a Bematech obtive a infor-
magao de que osleitores de documentos ndo |
léem c6digo de barras do tipo EAN, ou seja, | f] freive]
somente c6digo de barras de documentos [ [oetet
como boletos de lojas e concessiondrias de
dgua, luz, gés, telefone e outras, tais como
TIM, Telefonica, Sabesp e etc. Teste a aplica-

¢do e veja o resultado. Figura 5 L L
Lot w et ontr e

Conclusao

Com esse artigo finalizamos a série
demonstrando como trabalhar com
equipamentos de impressdo tais como S
ECEF, Impressoras de Cheques, Leitores Figura 4. Exemplo de Contas a Pagar
de Cédigo de Barras e Documentos. (i Py — NE
Vimos em todos os artigos como é f4cil

trabalhar com esses tipos de dispositivos L
e que ndo hd segredos para se desenvol- | o e =]a [ e
ver um bom aplicativo. [poLETE |pescrscan [vaLom [oT_vEcTo  [mAmea] =~
L, L. FATERT 1 N Tikd TELEFGE A0 IR Fam
Um forte abrago e até a préxima. @ AN 42556 SRRy TELEFINICA 1227 120500 Tam
| FE 00T E05 3 300000005 ] HOSPEDAGEN 53 DenQ0ar Filest

? i b o b ban dea

M Figura 5. Contas a pagar em execugao
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MVC (Model-View-Controller)

Aplique esse poderoso padrao em suas aplicacoes cliente/server

Paulo Roberto Quicoli
(pauloguicoli@gmail.com)

é analista e programador da Control-M Infor-
mdtica. Trabalha com Delphi, desde sua primei-
ra versdo, e Firebird desenvolvendo aplicacdes
cliente/servidor. Formado em Tecnologia de
Processamento de dados pela FATEC, na cidade
de Taquaritinga/SP

grande maioria dos programa-

dores Delphi desenvolve seus

sistemas utilizando o modelo
Cliente/Servidor, dividindo assim teori-
camente seu sistema em duas camadas:
interface e banco de dados.

E muito comum vermos no cédigo de
um formuldrio a construgado de sentencas
SQL e validagdo de regras de negdcio,
tudo muito RAD, jd que é neste ponto
que o Delphi se destaca. E possivel cons-
truir rapidamente um cadastro e sua
manutengdo utilizando Delphi, porém
um sistema completo ndo é composto
apenas por cadastros. Muita logica estd
envolvida.

Além disso existe outro fator que mui-
tos ndo atentam: a vida do sistema. Por
quanto tempo ele vai rodar. Se vocé quer
desenvolver um sistema que tenha uma
vida longa tem que pensar no tempo e
custo das manutengdes que ocorrerao.

Nessa hora que surgirdo os problemas
em se utilizar o RAD sem pensar na

arquitetura do sistema. E muito fécil
construir uma aplicagdo arrastando com-
ponentes, gerar os eventos no formuldrio
e dentro deles mesmo acessar banco de
dados, SQL e etc. O dificil serd reutilizar
rotinas, regras de negocio e aplicacdo de
testes, que juntos garantem uma facili-
dade na adequacao dos sistemas para as
necessidades dos usudrios.

Agora vocé pode estar se perguntan-
do, por onde comeco? A primeira coisa
a se fazer é pensar que seu software é
composto por camadas e ndo apenas
por formuldrios, relatérios e um banco
de dados. Vamos explorar um pouco as
camadas que um sistema pode ter.

Camadas

Em um sistema com boa arquitetura
encontramos algumas divisoes l6gicas
que visam facilitar a manutencdo e adi¢do
de novos recursos. Essas camadas podem
ser vistas na Figura 1.

Para tornar a explicagdo sobre as ca-

26 ClubeDelphi - MVC (Model-View-Controller)



madas mais intuitiva quero que imagine
seu sistema. Com toda certeza nele vocé
possui um formuldrio de cadastro. O
seu formuldrio representa a camada de
apresentacgdo do seu sistema, isto porque
é nela que os dados sdo apresentados.
Se seu sistema é cliente/servidor, a sua
camada de dominio, de base dados e até
mesmo servigos podem ser represen-
tadas pelos Data Modules existentes e
seus componentes de acesso ao banco
de dados. Por dltimo temos a camada
global que pode ser representada pelo
seu conjunto de fung¢des e procedimentos
publicos.

Continuando com o paralelo a um
sistema comum, desenvolvido por um
programador Delphi, nos formuldrios
noés fazemos acesso direto aos Data Mo-
dules, aos ClientDataSets, geramos SQL,
tudo sem preocupacdo alguma, ou seja,
nés misturamos o que seriam nossas
camadas sendo que o correto é separar
as camadas.

Quando essas camadas se misturam
é dito que existe um acoplamento entre
elas. No momento que vocé insere c6digo
SQL em evento OnClick de um botédo o
acoplamento foi realizado. Seu formu-
lario que é sua camada de apresentacao,
estd fazendo acesso direto aos recursos
do que seria sua camada de dados. Isso
impede a reutilizagdo da légica contida
no formuldrio. Tudo isso dificulta a
manutengdo do seu sistema porque vocé
terd SQL espalhado por todo c6digo e ndo
apenas centralizado em uma drea.

Outra prética que é muito comum é de
se criar os eventos e dentro deles escrever
um cédigo tdo longo que para entender
o que estd sendo feito é quase como ler
um livro. Consequentemente a rotina ali
dentro poderia ser quebrada em classes
ou fungoes.

Quando uma rotina faz mais do que
foi projetada a fazer é dito que existe
uma baixa coesdo nela. A baixa coesdo é
outro problema para a boa manutengao
do seu software. Entdo, como podemos
separar as camadas sem, contudo uni-las?
Pensando nessa solugdo alguns arquite-
tos de software criaram os padrdes de
projeto. Os padrdes sdo de uma forma
simplificada, como uma receita de bolo
a ser seguida. Eles expdem o problema e
mostram como soluciond-lo.

CAMADA DE APRESENTACAO
(MVC, MVP, MGM, etc)

Formulanos. Paginas WEB

CAMADA DE BASE DE DADOS
(DAQ, MAPEAMENTO O/R etc)

Chasses que balam deelaments (oM o M de
DA SeNDmEnin

N

Figura 1. Camadas I6gicas de um software

O problema apresentado neste artigo é
como separar a interface do sistema do
restante da aplicagdo. Como tornéa-la in-
dependente. A solucao ja existe, foi desen-
volvida na forma de um padrao de projeto
chamado MVC-Model View Controller,
este é o foco do nosso artigo.

Utilizando o padrao em um exemplo
Nosso primeiro aplicativo de exemplo
serd simples, porém ird mostrar como
iniciar o desenvolvimento utilizando o
padrdo MVC e fazer uso de interfaces.

Constard apenas de uma tela principal
que ird chamar um formuldrio que per-
mite ao usudrio realizar multiplicacdes.
Aqui utilizo o Delphi 2007, contudo, o
exemplo pode ser reproduzido também
no Delphi 5, 6, 7, 2005 e 2006 sem proble-
ma algum e para iniciarmos, inicie um
novo projeto Win32.

Para separar a camada de apresentacao
0 MVC cria trés partes distintas, o Model,
a View e o Controller. Podemos defini-los
da seguinte forma:

* Model - F a representagio da informa-
¢do que a aplicacdo utiliza, que no nosso
exemplo é o cdlculo de multiplicagdo e os
nimeros que serdo calculados.

*View — E a representagio grafica do

Model. Por exemplo, um formuldrio ex-
pondo as informagdes de um cliente. Uma
View estd sempre ligada a um model e
sabe como exibi-lo ao usudrio. E para um
determinado Model podem existir vdrias
views. Além disso também pode ser com-
posta por vérias Views. Aplicando isso ao
exemplo, a view é nosso formuldrio que
ird permitir ao usudrio digitar o valores
e efetuar sua multiplicagao.

Controller — E responsavel em mapear
as acdes do usudrio em agdes do sistema,
por exemplo se um botdo ou item de menu
é clicado é ele que deve definir como a
aplicacdo responderd. No nosso exemplo é
o controller que ird fazer com que ao clicar
no botdo “calcular” o célculo seja feito.

Colocando a mao na massa

Vamos iniciar criando as partes basicas
definidas pelo padrdo, o Model, a View e
o Controller. Adicione uma unit ao pro-
jeto renomeando-a para “MVClnterfaces.
pas”. Nela adicione as seguintes interfa-
ces, conforme listagem Listagem 1.

Como jd foi dito, o Model é nossa regra
de negdcio, ou seja, nosso cdlculo de
multiplicacdo. Existem algumas formas
de se implementar o MVC, variando de
acordo com o entendimento do desen-
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Listagem 1. MV(C

type
TModelChangedEvent = procedure of object;

IModel = interface [*{FDF18F94-0430-4C48-BE64-F4516C4C1011}"]
procedure Initialize;
function GetOnModelChanged: TModelChangedEvent;
procedure SetOnModelChanged(value: TModelChangedEvent);

end;

IView = interface [*{A1F411E9-294D-444D-9D5B-1D6AC9988819} ]
procedure Initialize;

end;

IController = interface [‘{E4BD8853-F6C8-4BD4-B19D-D70B156BD712} "]

procedure Initialize;
end;

Listagem 2. Model

property OnModelChanged: TModelChangedEvent read GetOnModelChanged write SetOnModelChanged;

type
TModelMultiply = class(TInterfacedObject, IModel)

private
FValuel: integer;
FValue2: integer;
FOnModel1Changed: TModelChangedEvent;
FSolution: integer;
procedure SetValuel(const Value: integer);
procedure SetValue2(const Value: integer);
function GetOnModelChanged: TModelChangedEvent;
procedure SetOnModelChanged(value: TModelChangedEvent);
procedure Initialize;
procedure SetSolution(const Value: integer)

public
constructor Create; reintroduce;
function Multiply: integer
property Valuel: integer read FValuel write SetValuel;
property Value2: integer read FValue2 write SetValue?2;
property Solution: integer read FSolution write SetSolution;

end;
implementation
{ TModelMultiply }

constructor TModelMultiply.Create;
begin

Initialize;
end;

function TModelMultiply.GetOnModelChanged: TModelChangedEvent;
begin

result := FOnModelChanged;
end;

procedure TModelMultiply.Initialize;
begin
Valuel := 0;
Value2 := 0;
Solution :=
end;

0;

function TModelMultiply.Multiply: integer;
begin

result := Valuel * Value2;

Solution := result;

if Assigned(OnModelChanged) then OnModelChanged;
end;

procedure TModelMultiply.SetOnModelChanged(value: TModelChangedEvent);
begin

FOnModelChanged := value;
end;

procedure TModelIMultiply.SetSolution(const Value: integer)
begin

FSolution := Value;
end;

procedure TModeIMultiply.SetValuel(const Value: integer)
begin

FValuel := Value;
end;

procedure TModelMultiply.SetValue2(const Value: integer)
begin

FValue2 := Value;
end;

property OnModelChanged: TModelChangedEvent read GetOnModelChanged write SetOnModelChanged;

volvedor. Em sua forma conceitual um
Model possui uma referéncia a View.
Neste exemplo ndo vejo a necessidade
disso, ja que o Model aqui é a regra de
negdcio em si.

Em sistemas mais complexos isso pode
até fazer sentido por que o Model poderd
encapsular vdrias regras e serd um encap-
sulamento para elas. O que quero dizer
é que a parte chamada Model do MVC
nem sempre é diretamente uma classe da
nossa camada de dominio. Isso significa
que a classe TAluno pode conter rotinas
e/ou outras classes que tém relagdo com
TAluno, como por exemplo, TCurso e mé-
todos para matricula.

Adicione uma nova unit ao projeto,
salvando-a como “Multiply.pas” e adi-
cione ao uses da interface a Unit MVCln-
terfaces. Crie uma nova classe conforme
Listagem 2.

Veja que a classe TModel Multiply contém
duas propriedades que armazenardo os
nimeros digitados pelo usudrio e dispo-
nibiliza o método Multiply que realiza a
multiplicacdo. Vamos agora criar nossa
View correspondente.

A finalidade da View é saber como
apresentar ao usudrio os dados contidos
no Model. Adicione um novo formulario
ao projeto e dé a ele o nome de “View1”.
Salve sua unit como “ViewForml.pas”
e adicione ao uses da secdo interface as
Units MV Clnterfaces e Multiply. Construa
o formuldrio conforme Figura 2.

Nesse formuldrio vamos criar um
evento que serd utilizado pelo Controller.
Esse evento representa o clique do botao
calcular. Lembre-se que é o controller
que transfere as agdes do usudrio para
0 Model, portanto nédo é correto fazer o
formuldrio chamar diretamente nosso
cdlculo, que é o Model. Vamos apenas
adicionar uma referéncia ao Model, veja
a Listagem 3.

Observe na Listagem 4 a implemen-
tacdo dos métodos Initilialize e Model-

=2 Fon 5

72 View- Muligh

Vaiar L dor 250 :
Edit1 X Edit1 e et

Figura 2. View
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Changed. O Initialize é responsavel por
inicializar a View, trazendo para ela o
estado inicial do Model. O ModelChan-
ged por sua vez responde ao disparo do
evento OnModelChanged realizado pelo
Model e 1é suas propriedades para atu-
alizar sua representagdo. Veja também
que no OnClick do botdo disparamos o
evento DoCalc.

O evento DoCalc serd implementado
pelo Controller. Adicione uma nova
Unit e a salve-a como “FormController.
pas”, inclua no uses as units Multiply,
MVClInterfaces e ViewForml. Implemente
o controle como na Listagem 5.

Vamos entender o que o controller estd
fazendo. De acordo com a forma conceitu-
al o Controller precisa ter uma referéncia
a View e ao Model. Temos isso repre-
sentado pela varidveis FView e FModel.
Temos também uma procedure Calc que
executa o método Multiply do Model. Essa
procedure é que ird responder ao evento
DoCalc da View, assim ao clicar no botao
Calcular da View, o controller responderd,
criando assim o comportamento da View.
Tudo isso é implementado no método
Initialize. E nele que estamos atando cada
parte que compde a triade MVC.

Executando

No formuldrio principal da aplicacdo
adicione uma referéncia a unit FormCon-
troller. Adicione também um botdo, e
no seu evento OnClick vamos chamar o
controller. Veja Listagem 6 o c6digo e na
Figura 3 o resultado.

Complicou?

A primeira vista pode parecer complica-
do, mas ndo é. O segredo é ter em mente
o que cada parte do MVC deve fazer e
como se dd a comunicagdo entre elas.
Na Figura 4 temos uma ilustra¢do dessa
comunicacao.

Basicamente o Model aponta para a View
0 que permite enviar a ela notifica¢des
de mudanca, no nosso exemplo isso estd
implementado pela defini¢do do evento
OnModelChanged. O Model ndo deve saber
nada sobre a View, portanto esta referéncia
é feita através de uma superclasse da View
que expde meios de ser notificada. Veja
que nossa View (formuldrio) implementa o
evento anteriormente definido pelo Model
e o utiliza para receber a notificacdo de

-
Listagem 3.Definicao da View

type
TCalcEvent = procedure of object;
TViewl = class(TForm)
Labell: TLabel;
Editl: TEdit;
Label2: TLabel;
Edit2: TEdit;
Label3: TLabel;
Label4: TlLabel;
Edit3: TEdit;
btnCalc: TButton;
procedure btnCalcClick(Sender: TObject);
private
FModel: TModelMultiply;
FDoCalc: TCalcEvent;
procedure SetModel(const Value: TModelMultiply);
{ Private declarations |}
procedure SetDoCalc(const Value
public
{ Public declarations }
procedure Initialize;
procedure ModelChanged;
property Model: TModelMultiply read FModel write SetModel;
property DoCalc: TCalcEvent read FDoCalc write SetDoCalc;
end;

: TCalcEvent);

Listagem 4. Atualizando a View

procedure TViewl.btnCalcClick(Sender: TObject);
begin
Model.Valuel := StrToInt(Editl.Text);
Model.Valuez := StrTolnt(Edit2.Text);
if Assigned(DoCalc) then DoCalc;
end;
procedure TViewl.Initialize;
begin
Editl.Text := IntToStr(Model.Valuel);
Edit2.Text IntToStr(Model.Value2);
Edit3.Text := IntToStr(Model.Solution);
end;
procedure TViewl.ModelChanged;
begin
Initialize;
end;
procedure TViewl.SetDoCalc(const Value: TCalcEvent);
begin
FDoCalc := Value;
end;
procedure TViewl.SetModel(const Value: TModelMultiply);
begin
FModel
end;

:= Value;

Listagem 5. Controller

type
TFormController = class(TInterfacedObject, IController)
private
FView: TViewl;
FModel: TModelMultiply;
public
constructor Create; reintroduce;
destructor Destroy; override;
procedure Initialize;
procedure Calc;
end;
implementation
{ TFormController }
procedure TFormController.Calc;
begin
FModel.Multiply;
end;
constructor TFormController.Create;
begin
FModel := TModelMultiply.Create;
FView := TViewl.Create(nil);
end;
destructor TFormController.Destroy;
begin
FView.Free;
inherited;
end;
procedure TFormController.Initialize;
begin
FView.Model := FModel;
FModel.0nModelChanged := FView.ModelChanged;
FView.DoCalc := Calc;
FView.Initialize;
FView.ShowModal;
end;
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atualizagdo do mesmo.

Por outro lado, a View estd diretamente
ligada a um Model e sabe exatamente os
detalhes do Model, de tal forma que seus
atributos possam ser acessados, isso pode
ser visto no acesso que a View faz as pro-
priedades Valuel e Value2 do Model.

Além disso possui também uma re-
feréncia ao Controller que deve estar
ligada a uma classe base do Controller.
Isso, para permitir que um controller
possa ser trocado. Este por sua vez possui
referéncias diretas ao Model e a View
porque é ele que define o comportamento

geral. Observe a existéncia de dois cam-
pos privados, respectivamente dos tipos
View e Model.

Um exemplo mais real

Ainda ficou complicado néo é? Progra-
mador Delphi ndo se dd por satisfeito até
ver sua comum pergunta respondida:
“Mas o que fazer com minhas queries
e tabelas?”. Para provar que nao é tdo
complicado retirar do seu formuldrio
todo SQL que esta 1a vamos transformar
um aplicativo Cliente/Servidor comum,
em um aplicativo Cliente/Servidor com a

( N\
Listagem 6.Executando o controller
procedure TMainF.ButtonlClick(Sender: TObject);
var
1Controller: TFormController;
begin
1Controller := TFormController.Create;
1Controller.Initialize;
end;
_J
e N
CONTATO
I_CONTATO INTEGER
NOME WARCHARCTO0})
TELEFONE WARCHAR(1S)
Wk 1 Wale 3
1 X =
o ] !
Figura 5. Tabela CONTATO
Figura 3. MVCem acdo
e N
Mudanga de
Consulta de estado
eslado
Motificagdo
de mudanga
aEEaEEn
Agdes do
Usuarno
. Métodos
sm @ Eventos
\

Figura 4.A comunicagdo dentro do MVC

interface separada das regras de negécio
e do banco de dados.

Neste exemplo ndo seremos puristas
quanto ao uso da orienta¢do a objetos,
mas vamos utilizar o que hd de melhor
no Delphi, RAD e a orientagdo a objetos,
para que vocé, programador, possa ir se
acostumando e ver que vale a pena apli-
car tudo isso em seus projetos.

0 tradicional

Vamos criar uma agenda de telefone.
Primeiramente vamos crid-la de forma
tradicional e posteriormente vamos apro-
veitar o que ja tem e adaptar um MVC.
Crie um banco de dados Firebird conten-
do a seguinte tabela, vista na Figura 5.

Inicie agora uma nova aplicacdo Win32,
adicione um Data Module e crie uma co-
nexdo DBX com o banco de dados criado.
Adicione ao Data Module um TSQLQuery
que acesse a tabela CONTATO e ligue a
esse TSQLQuery um ClientDataSet. Vamos
utilizar esse ClientDataSet em nossa apli-
cacdo. Configure o formuldrio principal
conforme Figura 6. Adicione um segundo
formuldrio e o deixe como na Figura 7.

Nao vou entrar em detalhes de como
ligar os controles Dataware ao ClientDa-
taset, porque como disse, esta primeira
parte do exemplo vocé usa no seu dia-a-
dia. Observe a Listagem 7, ela contém a
l6gica do sistema, SQL e validagdo. Nao
existiria nada de errado com elas desde
que ndo estivessem dentro dos formu-
larios. Essas listagens mostram o que
a grande maioria dos desenvolvedores
Delphi faz de forma natural.

Aplicando o0 MVC sem perder o RAD

Como ja mencionei anteriormente nao
serei um “purista”, quero aproveitar o
que o Delphi oferece, contudo, aplicando
boas pratica OO. Para relembrar, o MVC
é “Model-View-Controller”. Aproveitando
aestrutura existente a View sdo 0s nossos
formuldrios, o Model sdo as rotinas de
Inclusao, Edigdo, Exclusdo e Localizacao
que podem ser encapsuladas em uma
classe que as represente, por exemplo
ManterContato. Os dados dos contatos con-
tinuardo sendo acessados pela estrutura
SQLQuery, DatasetProvider e ClientDataSet.
O Controller se encarregard de chamar os
métodos do Model de acordo com as ac¢oes
do usudrio em cima da View.
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Semelhantemente ao primeiro exemplo
construido vamos adicionar uma Unit ao
projeto e chamé-la de “MVClnterfaces.pas”.
Adicione a ela o c6digo da Listagem 8.

Agora vamos utilizar essas interfaces

paraimplementar a l6gica do nosso siste-
ma de Agenda. Para comegar vamos criar
o Model. Adicione uma nova Unit, salve-a
como “ModelAgenda.pas”. A ela adicione
uma referéncia na se¢do uses a unit M V-
Clnterface e ao Data Module da aplicacao,
lembre-se que vamos utilizar a estrutura
ja criada. Crie a classe TManterContato
conforme visto na Listagem 9.

Veja que nossa classe TManterContato,
que é nosso Model, centraliza em si a
manipulacdo de SQL, o CRUD e sua va-
lidagdo. Também criamos duas excec¢des
que sdo utilizadas caso algo de errado
aconteca. Entdo vocé pode se perguntar:
Porque nédo exibimos uma mensagem ao
usudrio ao invés de levantar a excegdo?
A razdo é bem simples, a func¢do de in-
teragdo com o usudrio é da View e nédo
do Model. O Model nem sabe como seus
dados serdo exibidos, por isso ele apenas
notifica que algo estd errado. Isso garante
a reutilizacdo desse Model.

Continuando, temos o Controller e é ele
que ird chamar os métodos do Model.
Na Listagem 10 temos a implementacdo
completa do Controller, adicione um nova
Unit e adicione o cédigo.

Vamos agora ajustar nosso formuldrio
principal para agir como uma View.
Adicione na secao Uses da segao Interface
as units MVClnterfaces, ControllerAgenda,
e ModelAgenda. Na declaragdo do formu-
lario indique que ele implementa I View,
conforme abaixo:

TPrincF = class(TForm, IView)

E por implementar IView, ele precisa
ter referéncias ao Model, ao Controller e
deve implementar o método Initialize de
IView. Veja isso na Listagem 11.

Com isso temos nossa View pronta.
Agora vamos remover as chamadas aos
componentes de acesso e adicionar as
chamadas ao controller. A primeira a
ser removida é a que consta no evento
OnShow do formuldrio principal. Substi-
tua o c6digo a seguir:

Self.Initialize;

Veja que o Initialize da View é chamado

e este por sua vez realiza a ligagdo entre
os componentes do MVC e inicia o Con-
troller. Depois, vamos substituir o evento
OnKeyUp do Edit de busca pelo c6digo da
Listagem 12.

Observe o c6digo. Veja que a chamada
ao controller estd dentro de um bloco try..
except. Lembre-se que o Controller chama
o método LocalizarPorNome de TManter-
Contato, que é nosso Model, portanto a
regra para validar se a consulta pode ser
feita ou ndo estd contida no Model e ndo
no formuldrio. Vamos substituir agora o
c6digo do botdo excluir para o cédigo da
Listagem 13.

Para utilizar agora o Controller para
fazer a insercdo e edicdo de um contato
temos que fazer uma alteracdo também
no formuldrio de edicdo (Figura 7). A
primeira coisa a se fazer é adicionar no
uses da segdo Interface uma referéncia as

Units ControllerAgenda e ModelAgenda,
depois vamos criar uma propriedade
publica do tipo IAgendaController, con-
forme a seguir:
public

{ Public declarations |}

property Controller: IAgendaController
read FController write SetController;

Af entdo podemos substituir os cédi-
gos do botdo Salvar e Cancelar pelos da
Listagem 14.

Com o nosso formuldrio de edi¢do pron-
to, podemos agora terminar a alteracdo no
formuldrio principal. Vamos remover os
cédigos dos botdes Inserir e Editar pelo
cédigo da Listagem 15.

Antes de executar a aplicagdo, dé uma
olhada no c6digo do formuldrio principal
por completo. Veja que ndo temos no c6di-
gonenhuma chamada a ClientDataSet ou

p:.

%Agenda RAD

Informe um nome e pressione [ENTER]

=)

==

Telefone

Incluir ] |

Excluir

Figura 6. Formuldrio principal

p
a Editar Contato

: EDITNOME

: DBEDIT1

Salvar

Cancelar

Figura 7. Formuldrio de edicao
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Listagem 7. Evento onKeyUp do Edit de busca

procedure TPrincF.editBuscaKeyUp(Sender: TObject; var Key: Word; Shift: TShiftState);
begin
if (Key = VK_RETURN) then
begin
if (length(Trim(EditBusca.Text)) >= 3) then
begin
dm.cdsContatos.Close;
dm.qgryContatos.SQL.Clear
dm.qgryContatos.SQL.Add( ‘SELECT * FROM CONTATO’);
dm.qgryContatos.SQL.Add( ‘WHERE NOME STARTING WITH * + QuotedStr(editBusca.Text));
dm.qgryContatos.SQL.Add( *ORDER BY NOME®);
dm.cdsContatos.0Open;
end
else
begin
if Trim(EditBusca.Text) = ‘’ then
begin
dm.cdsContatos.Close;
dm.qryContatos.SQL.Clear
dm.qryContatos.SQL.Add( *SELECT * FROM CONTATO’);
dm.qryContatos.SQL.Add( ‘ORDER BY NOME’);
dm.cdsContatos.Open;
end
else
begin
ShowMessage( ‘Para realizar a busca vocé deve informar no minimo 3 caracteres’);
editBusca.SetFocus;
end;
end;
end;
end;

procedure TPrincF.btIncluirClick(Sender: TObject);
begin
dm.cdsContatos.Insert;
EditarContatoF := TEditarContatoF.Create(nil);
EditarContatoF.ShowModal;
FreeAndNil(EditarContatoF);
end;

procedure TPrincF.btEditarClick(Sender: TObject);
begin
dm.cdsContatos.Edit;
EditarContatoF := TEditarContatoF.Create(nil);
EditarContatoF.ShowModal;
FreeAndNil(EditarContatoF);
end;

procedure TPrincF.btExcluirClick(Sender: TObject);
begin
if Application.MessageBox(‘Confirma exclusdo de contato ?’, Atencdo’,MB_YESNO + MB_ICONQUESTION +
MB_DEFBUTTON2)=ID_YES then
begin
dm.cdsContatos.Delete;
dm.cdsContatos.ApplyUpdates(-1);
end;
end;

procedure TEditarContatoF.btSalvarClick(Sender: TObject);

begin
if trim(DBEditl.Text) = °* then
begin
ShowMessage( ‘Nome de contato invalido’);
exit;
end;

dm.cdsContatos.Post;
dm.cdsContatos.ApplyUpdates(-1);
Close;

end;

procedure TEditarContatoF.btCancelarClick(Sender:
TObject);

begin
dm.cdsContatos.CancelUpdates;
Close;

end;

Listagem 8. Interfaces basicas do MVC

unit MVCInterfaces;
interface
type
IModel = interface [‘{FDF18F94-0430-4C48-BE64-F4516C4C1011}°1]
procedure Initialize;
end;
IView = interface [‘{A1F411E9-294D-444D-9D5B-1D6AC9988819} ]
procedure Initialize;
end;
IController = interface [‘{E4BD8853-F6C8-4BD4-B19D-D70B156BD712}"]
procedure Initialize;
end;
implementation
end.

& J

instrugdo SQL. Execute agora e vocé verd
tudo funcionando. Insira um breakpoint
por exemplo na chamada ao Controller.
LocalizarPorNome e v debugando. Vocé
ird perceber como se dd a passagem de
chamadas de um item a outro do MVC.

Na Figura 8 temos uma simplificacdo
desse processo.

Conclusao

Neste artigo vimos que podemos
utilizar o RAD e utilizar ao mesmo
tempo boas préticas, que neste artigo é
a separacdo da interface (formuldrios)
com o restante do sistema. Utilizamos
uma adaptacdo do modelo MVC para
a realidade dos programadores Delphi,
conseguimos retirar dos formuldrios
as chamadas SQL e chamadas diretas a
ClientDataSet passando isso ao Controller
que por sua vez passa ao Model.

Dessa forma obtivemos um formuldrio
que ndo possui regra de negdcio e com
isso, pode ser substituido por outro for-
muldrio qualquer, desde que implemente
a interface IView. As regras do negocio
ficaram encapsuladas em classes e po-
dem ser reutilizadas em outras varia¢des
da agenda, por exemplo uma agenda
pra web.

Ao utilizar os ClientDataSets como ca-
mada de dados ganhamos em agilidade
na montagem do formuldrio e no acesso
ao banco de dados, isto porque nos pren-
demos em melhorar um sistema ja pronto.
Com a separagdo do formuldrio podemos
agora aplicar testes unitdrios ao controller
e model, coisa que é impossivel de se fa-
zer programando do “jeitdo” comum.

Sem muito esforgo acrescentamos qua-
lidade ao nosso software e ganhamos
conhecimento, lembrando que aplicar
essa separagdo de formuldrios é apenas
um passo para se conseguir uma sepa-
ragdo ideal das camadas de um sistema,

porém ji temos um comeco utilizando o
RADeOO. ®

32 ClubeDelphi - MVC (Model-View-Controller)



Ve

Listagem 9. Manter contatos

uses MVCInterfaces, dmU, SysUtils;
type
IManterContato = interface(IModel)
[“{0LAFE56E-1787-4B79-9B48-A018B2859B0C} "]
procedure LocalizarPorNome(Nome: string);
procedure Inserir;
procedure Excluir;
procedure Editar;
procedure Salvar;
procedure Cancelar;
end;

TManterContato = class(TInterfacedObject, IManterContato)
public

procedure LocalizarPorNome(Nome: string);

procedure Inserir;

procedure Excluir;

procedure Editar;

procedure Salvar;

procedure Cancelar;

procedure Initialize;
end;

TQuantidadeCaracteresInvalidaEx = class(Exception);
TDadosInvalidosEx = class(Exception);

implementation
{ TManterContato }

procedure TManterContato.Cancelar
begin

dm.cdsContatos.CancelUpdates;
end;

procedure TManterContato.Editar;
begin

dm.cdsContatos.Edit;
end;

procedure TManterContato.Excluir;
begin
dm.cdsContatos.Delete;
dm.cdsContatos.ApplyUpdates(-1);

procedure TManterContato.Initialize;
begin
dm.cdsContatos.Close;
dm.qryContatos.SQL.Clear
dm.qryContatos.SQL.Add( *SELECT * FROM CONTATO ORDER BY NOME’);
dm.cdsContatos.Open;
end;
procedure TManterContato.Inserir;
begin
dm.cdsContatos.Insert;
end;
procedure TManterContato.lLocalizarPorNome(Nome: string);
begin
if (length(Trim(Nome)) >= 3) then
begin
dm.cdsContatos.Close;
dm.qryContatos.SQL.Clear;
dm.qgryContatos.SQL.Add( ‘SELECT * FROM CONTATO’);
dm.qryContatos.SQL.Add( ‘WHERE NOME STARTING WITH ° +
QuotedStr(Nome));
dm.qgryContatos.SQL.Add( ‘ORDER BY NOME’);
dm.cdsContatos.Open;
end
else
begin
if Trim(Nome) = *°
begin
Self.Initialize;
end
else
begin
raise TQuantidadeCaracteresInvalidakx.Create(
‘Para realizar a busca vocé deve informar no minimo 3
caracteres’);

then

end;
end;
end;
procedure TManterContato.Salvar;
begin
if Trim(dm.cdsContatosNOME.AsString) = *’ then
begin
raise TDadosInvalidosEx.Create( ‘Nome de contato invadlido’);
end;
dm.cdsContatos.Post;
dm.cdsContatos.ApplyUpdates(-1);

end; end;
|
(
Listagem 10.Controller
interface FModel.Cancelar;
uses MVCInterfaces, ModelAgenda, SysUtils; end;
type procedure TAgendaController.Editar
IAgendaController = interface(IController) begin
[“{E52C60DD-181B-4272-A3DF-72610E9BA2F7} "] FModel.Editar;
procedure LocalizarPorNome(Nome: string); end;
procedure Inserir; procedure TAgendaController.Excluir;
procedure Excluir; begin
procedure Editar; FModel.Excluir;
procedure Salvar; end;
procedure Cancelar; function TAgendaController.GetModel: IManterContato;
procedure Initialize; begin
procedure SetModel(const Value: IManterContato); result:= FModel;
procedure SetView(const Value: IView); end;
function GetView: IView; function TAgendaController.GetView: IView;
function GetModel: IManterContato; begin
property Model:IManterContato read GetModel write SetModel; result := FView;
property View: IView read GetView write SetView; end;
end; procedure TAgendaController.Initialize;
TAgendaController = class(TInterfacedObject, IAgendaController) begin
private FModel.Initialize;
FModel: IManterContato; end;
FView: IView; procedure TAgendaController.Inserir;
procedure SetModel(const Value: IManterContato); begin
procedure SetView(const Value: IView); FModel.Inserir;
function GetView: IView; end;
function GetModel: IManterContato; procedure TAgendaController.LocalizarPorNome(Nome: string);
public begin
procedure LocalizarPorNome(Nome: string); FModel.LocalizarPorNome(Nome) ;
procedure Inserir; end;
procedure Excluir; procedure TAgendaController.Salvar
procedure Editar; begin
procedure Salvar; FModel.Salvar;
procedure Cancelar; end;
procedure Initialize; procedure TAgendaController.SetModel(const Value: IManterContato);
property Model:IManterContato read GetModel write SetModel; begin
property View: IView read GetView write SetView; FModel := Value;
end; end;
implementation procedure TAgendaController.SetView(const Value: IView);
{ TAgendaController } begin
procedure TAgendaController.Cancelar; FView := Value;
begin end;
|
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Listagem 11.Implementando a View Listagem 13. Utilizando o controller para realizar uma excluséo
type procedure TPrincF.btExcluirClick(Sender: TObject);
TPrincF = class(TForm, IView) begin
if Application.MessageBox(
private ‘Confirma exclusdao de contato ?’,’Atencdo’,
FController: IAgendaController; MB_YESNO + MB_ICONQUESTION + MB_DEFBUTTON2)= ID_YES then
{ Private declarations } begin
procedure Initialize; Controller.Excluir;
procedure SetController(const Value: IAgendaController); end;
end;
public
{ Public declarations } . -
property Controller: IAgendaController read FController Listagem 14. Utilizando Controller para Salvar e Cancelar
write SetController; procedure TEditarContatoF.btCancelarClick(Sender: TObject);
end; begin
Controller.Cancelar;
procedure TPrincF.Initialize; Close;
var end;
TModel: TManterContato; procedure TEditarContatoF.btSalvarClick(Sender: TObject);
begin begin
Controller := TAgendaController.Create; try
1Model:= TManterContato.Create; Controller.Salvar;
Controller.Model := 1Model; Close;
Controller.View := Self; except
Controller.Initialize; on e: TDadosInvalidosEx do
end; begin
ShowMessage( ‘Nome de contato invalido’);
exit;
Listagem 12. Utilizando o controller para realizar a busca end;
end;
procedure TPrincF.editBuscakKeyUp(Sender: TObject; var Key: Word; end;
Shift: TShiftState);
begin q - n
Listagem 15.Passando o controller para o formuldrio de edicao
if (Key = VK_RETURN) then
begin procedure TPrincF.btIncluirClick(Sender: TObject);
begin
try Controller.Inserir;
Controller.lLocalizarPorNome(editBusca.Text); EditarContatoF := TEditarContatoF.Create(nil);
except EditarContatoF.Controller := Self.Controller;
on e: TQuantidadeCaracteresInvalidaEx do EditarContatof.ShowModal;
FreeAndNil(EditarContatoF);
begin end;
ShowMessage(e.Message); procedure TPrincF.btEditarClick(Sender: TObject);
editBusca.SetFocus; begin
end; Controller.Editar;
EditarContatoF := TEditarContatoF.Create(nil);
end; EditarContatoF.Controller := Self.Controller;
EditarContatoF.ShowModal;
end; FreeAndNil(EditarContatoF);
end; end;
- J
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Figura 8. Comunicacao do MVC
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Graficos

Dicas praticas para a criagao de graficos em aplicac6es

Maikel Marcelo Scheid

(maikelscheid@gmail.com)

ClubeDelphi.

é técnico em Informatica com énfase em Anali-
se e Programacao de Sistemas. Atua na drea de
Desenvolvimento de Softwares em Delphi para
plataforma Win32 e .NET com banco de dados
Firebird e MSSQL. E membro da Equipe Editorial

riado por Descartes para desenhar

um raciocinio, a utilizagio de re-

presentagéo por Gréficos (graphi-
kés), possibilita transmitir um significado
de planilhas ou tabelas complexas de uma
forma mais eficiente e simples. Em nossos
sistemas, com informagdes armazenadas
em banco de dados, a necessidade de
mostrar as informagdes de uma forma de
facil compreensdo muita vezes nos obriga
a utilizarmos esses recursos.

Baseados nessa metodologia veremos
no decorrer deste artigo como construir
graficos a partir de informacoes armaze-
nadas em um banco de dados. Utilizare-
mos o Delphi 7, que fard acesso através
dos componentes da paleta dbExpress a
base de dados Employee.fdb, que acompa-
nha a instalag¢do do Firebird. Para criar
os gréficos utilizaremos o componente
DBChart da paleta Data Controls.

Nos gréficos que iremos criar, vamos
utilizar duas formas distintas de exibir os
registros. Na primeira iremos exibir os re-

gistros absolutos que serdo retornados de
uma consulta SQL. E na segunda iremos
parametrizar a quantidade de registros
a ser exibida, onde o restante das infor-
macdes nado atingidas pelo pardmetro de
limite da busca serd mostrado em uma
categoria “OUTROS” criada no gréfico
com a devida porcentagem de valores a
quantidade correspondida.

Criando a aplicacdo

Utilizaremos no decorrer deste artigo
para criacdo do exemplo de graficos o Del-
phi 7, mas qualquer outra versdo poderd
ser utilizada. Crie uma nova aplicagdo
no menu Filel New>Application. Altere o
nome do formuldrio para “frmPrincipal”
e defina o Caption do formuldrio principal
para “Graficos com Win32”. Salve a Unit
como “uGraficos.pas” e o projeto salve
como “Graficos.dpr”.

Crie agora um novo formuldrio, a
partir do menu Filel New>Form, que uti-
lizaremos para exibir todos os registros
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resultantes de uma pesquisa SQL a base
de dados sem nenhum parametro de li-
mitagdo de registros. Altere o nome para
“frmCustomerCountry” e a propriedade
Caption para “Clientes por Pais”. Salve a
Unit do formuldrio como “uCustomer-
Country.pas”.

Adicione também, através do menu
File| New>Data Module, um Data Module ao
projeto, que serd utilizado para configura-
¢do do componente de conexdo ao banco de
dados e também dos componentes de con-
sulta. Altere o nome do Data Module para
“DM” e salve a Unit como “uDM.pas”.

Adicione ao Data Module um compo-
nente SQLConnection (“sqlConexao”) da
paleta dbExpress. Altere a propriedade
LoginPrompt para False e com um duplo
clique abra o didlogo de configuragdo da
conexdo. Na caixa de didlogo que aparece
clique no botdo “+” e adicione uma nova
conexdo. Selecione, em Driver Name, a op-
¢do Interbase e em Connection Name digite
“Employee” e confirme.

De volta ao didlogo faremos as confi-
guragdes do caminho da base de dados
e também do usudrio e senha de acesso.
Em Database informe o caminho para o
banco de dados Employee.fdb, normalmente
localizado em C:\Arquivos de Programas\
Firebird\Firebird_2_0\exemplos, que acom-
panha a instalagéo do Firebird. Também
é necessdrio incluir o nome de usudrio
em User_Name e a senha padrdo de acesso
em Password. Caso nado tenha modificado
o usudrio e senha do Firebird eles sdo
SYSDBA e masterkey, respectivamente.

Também é de fundamental importan-

cia que se defina o dialeto de conexao
em SQLDialect como dialeto 3. Defina
também o ServerCharSet como Win1252
(Figura 1).

Criando e configurando a consulta
de registros

Adicione ao Data Module um com-
ponente SQLDataSet (“sqlCustomer-
Country”) também da paleta dbExpress.
Ligue a propriedade SQLConnection ao
componente “sqlConexao” e altere a
propriedade Name para “sqlCustomer-
Country” e adicione a seguinte instru-
¢do SQL a propriedade CommandText:
select country.country as pais,
count(customer.cust_no) as clientes from

country, customer where customer.country =
country.country group by country.country

Na instrucdo SQL anterior estamos
buscando dois campos dos registros do
banco de dados. Um com o nome do pais
e outro com a contagem da quantidade de
registros em cada pais da selegdo.

Com um duplo clique sobre o compo-
nente SQLDataSet abra o Fields Editor e
com o botdo direito do mouse selecione a
opcao Add All Fields para adicionar todos
os campos retornados pela SQL.

Criando o grafico

Para criar o gréfico, volte ao frmCus-
tomerCountry e adicione primeiramente
um componente Panel da paleta Standard,
alterando a propriedade Align paraalTope
exclua o texto da sua propriedade Caption.
Adicione ao formuldrio um componente
DBChart da paleta Data Controls alterando

¥
T = e

sua propriedade Align para alClient.

Nota: Nao esqueca de adicionar o Data
Module ao Uses do formulario para que
possa ter acesso aos componentes de
conexao com o banco. Para isso selecio-
ne File|Use unit...ou pressione ALT + F11.

Agora para realizar a configuracdo do
componente, dé um duplo clique sobre o
mesmo para que possa acessar suas pro-
priedades de configuragdo. No didlogo
de configuragdo do gréfico, a primeira
escolha que temos a fazer é quanto ao
tipo de gréfico. Utilizando o botdo Add,
selecione primeiramente o gréfico do tipo
Pizza (“Pie”) e confirme.

Aparecerd uma nova série selecionada,
altere o nome da mesma para “Pie” utili-
zando o botdo Title. Repetindo o processo
selecione também o gréfico do tipo Bar e
confirme. Altere seu nome para “Bar”.

Pronto, vocé terd disponivel agora dois
tipos de graficos (Figura 2).

Com o grafico Pie selecionado, clique na
aba Series ao lado da aba Chart e, dentre
as abas de configuracdo, selecione Data
Source. Nesta aba iremos configurar o
acesso do componente de grafico ao
componente sqlCustomerCountry onde
preparamos a instrucdo de consulta a
base de dados.

Logo na primeira caixa de opgdes,
selecione DataSet, a qual ird habilitar as
demais opg¢oes de configuragdo. Na opgao
DataSet abaixo, ao clicar deverdo aparecer
os componentes aos quais o DBChart
possui compatibilidade de conexao, no
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Figura 1. Configurando a conexdo a base de dados
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Figura 2. Adicionando os tipos de Graficos
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caso desse exemplo, ird aparecer somente
o sqlCustomerCountry que configuramos
no DM, que ao seleciona-lo ird habilitar
outras duas configuragbes que precisam
ser feitas.

Em Labels selecione PAIS, que corres-
ponde ao campo onde serdo informadas
as descrigdes de paises para exibigdo no
gréfico. Na propriedade Pie selecione
CLIENTES, que corresponde ao campo
de contagem de ocorréncias dos clientes
para cada pais que serd exibido, de acordo
com a instrugdo SQL configurada ante-
riormente (Figura 3).

Realizada a configuragdo da série Pie,
selecione agora a série Bar nesta mesma
aba Series. Na primeira op¢do de escolha
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selecione novamente DataSet e ligue ao
sqlCustomerCountry configurado no Data
Module. As propriedades de configuragao
deste tipo de grédfico serdo um pouco
diferentes quanto a configuragdo do
primeiro, pois este tipo de grafico esta
solicitando um valor para a coluna X e
outro valor para a coluna Bar.

Na propriedade Labels ndo se tem di-
ferenca, portanto selecione novamente
o campo PAIS. Agora nas outras duas
propriedades, iremos informar um valor
apenas ao campo Bar, selecionando o
campo CLIENTES (Figura 4).

Se fossemos informar o campo CLIEN-
TES também na propriedade X, nosso
grafico iria agrupar os valores idénticos,
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ou seja, se tivéssemos dois paises com
cinco clientes em cada um deles, uma
Unica barra seria exibida ao valor cor-
respondente e somente na legenda que
apareceriam os nomes de ambos os paises
com o0 mesmo nuimero de clientes.

Configuragoes e aparéncia do Grafico

Veremos agora como configurar algu-
mas das muitas op¢des de configuracao
das propriedades do componente DB-
Chart. Logo na aba Marks, dentro da aba
Series, que corresponde especificamente
ao tipo do gréfico selecionado, teremos
as opgdes de configuragdo do corpo do
gréfico, onde vocé poderd escolher de
que forma serdo exibidos os Labels para
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Figura 5. Configuracdes de fundo do corpo do gréfico

Figura 6. Exibicdo do gréfico de clientes por cidade
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cada barra do gréfico. Se desejar, poderd
exibir somente o valor (“Value”) ou a
descrigdo e o valor (“Label and Value”),
entre outras.

Poderd também alterar a cor de fundo
(“Back Color”) dos Labels, tipo de fonte,
tipo de borda, entre as demais configu-
racOes. Na aba General ao lado, vocé tera
as opgOes para definir o estilo de forma-
tagdo dos campos de valor. Na aba Format
vocé encontrard intimeras opgdes das
configuragdes da aparéncia do gréfico
individuais para cada tipo.

No gréfico do tipo Pie marque a opgao
Circled Pie que ird garantir um gréfico
sempre em forma de circulo, indepen-
dente da resolucao em que o formuldrio
que carrega o grafico for aberto.

Voltando agora para a aba Chart, que
corresponde as configuragdes gerais do
grdfico independente do tipo selecio-
nado, vd até a aba Titles e digite o texto

“Graéfico de Clientes por Pais” no campo
Memo de edigdo do titulo. Altere também
sua fonte e tamanho para destacar o titulo
no grafico.

Na aba Panel ative a op¢do Visible no grupo
Gradient do canto direito infeiror”, a qual
ird possibilitar que vocé configure uma
combinacdo de duas cores para o fundo
do grafico.

Ap0s selecionadas as cores, escolha a
direcdo em que as mesmas serdo exibi-
das (Figura 5). Todas as configuragdes ja
estardo valendo para o grafico, utilize o
botao Close para sair.

Vocé poderd ir testando todas as demais
propriedades de configuragdes que ndo
mencionei aqui neste artigo.

Ainda no mesmo formuldrio precisa-
mos adicionar dentro do compoente Panel
um RadioGroup da paleta Standard para
alternar de um tipo de grafico para outro
em tempo de execugao.

-
Listagem 1. C6digo para alteracao do tipo de gréfico em runtime

var
I : Integer;
begin
for I:= 0 to DBChartl.SeriesCount -1 do
DBChartl.Series[i].Active := False;

end;

Listagem 2. (6digo exibigao dos registros na montagem do grafico

procedure TfrmCustomerCountry.RadioGrouplClick(Sender: TObject);

DBChartl.Series[RadioGroupl.ItemIndex].Active

:= True

dinamico.

var
soma:
begin
if ((edtQntde.Text <>
begin
DM.cdsDinamicoGrafico.Open;
with DM.cdsDinamicoGrafico do
begin
while not eof do Delete;
DM.sqlDinamicoGrafico.Close;
DM.sqglDinamicoGrafico.CommandText :=
‘ skip 0 department.department * +
‘count(employee.emp_no) as clientes
‘where employee.dept_no = * + *
‘department.department’;
DM.sqglDinamicoGrafico.Open;
soma := 0;

Integer;

begin
DM.cdsDinamicoGrafico.Append;
DM.cdsDinamicoGraficoDEPARTAMENTO. Va
DM.cdsDinamicoGraficoCLIENTES.Value

DM.cdsDinamicoGrafico.Post;
DM.sqlDinamicoGrafico.Next;
end;
DM.sqglDinamicoGrafico
DM.sqglDinamicoGrafico
‘ as departamentos, ‘ + °
IntToStr(Soma)+’ as integer) as
DM.sqglDinamicoGrafico.Open;
DM.cdsDinamicoGrafico.Append;

.Close;
.CommandText :=

DM.cdsDinamicoGrafico.Post;
end;
end
else
ShowMessage( ‘0 valor deverad ser superio
end;

"

procedure TfrmGraficoDinamico.BitBtnlClick(Sender: TObject);

“’) and (StrTolnt(edtQntde.Text) > 0)) Then

department.dept_no group by ‘+

while not DM.sqlDinamicoGrafico.Eof do

soma := soma + DM.sqlDinamicoGrafico.Fields[1].AsInteger;

cast( (select (count(a.emp_no))
‘+*CLIENTES from rdb$database’;

DM.cdsDinamicoGraficoDEPARTAMENTO.Value
DM.cdsDinamicoGraficoCLIENTES.Value :=

‘select first ‘ + edtQntde.Text +
‘as departamento, © +
‘+ ° from department, employee ‘+

Tue := DM.sqglDinamicoGrafico.Fields[0].AsString;
:= DM.sqlDinamicoGrafico.Fields[1].Value;

‘select cast(‘’OUTROS’’ as varchar(70)) * +
‘ + ‘from employee a) - * +

:= DM.sqglDinamicoGrafico.Fields[0].AsString;
DM.sqlDinamicoGrafico.Fields[1].Value;

rao.’);

Adicione a sua propriedade Iterms em
duas linhas os valores “Pie” e “Bar”.

Adicione também dentro do Panel dois
componentes Button alterando o Cap-
tion do primeiro para “JPG Export” e
do segundo para “Print”. Esses botdes
serdo usados para exportar o grafico
para uma imagem no formato JPG e
fazer a impressdo direta do grafico,
respectivamente.

Adicione ao evento OnClick do Ra-
dioGroupl o cédigo da Listagem 1 que
serd o responsdvel por alterar os tipos
de gréficos em tempo de execugdo. O
cédigo desabilitard todos os tipos de
graficos para que ndo ocorra a sobrepo-
sicdo de algum deles e apés isso ativa
um novo tipo de acordo com o indice
selecionado.

No botéo de exportagdo do gréfico para
o formato JPG inclua a seguinte linha
de c6digo, onde chamamos o método
SaveToBitmapFile do componente DbChart,
passando um caminho onde a imagem
serd arquivada. Se preferir, poderd salvar
também em outros formatos de imagens,
como Bitmap por exemplo.

DBChartl.SaveToBitmapFile('C:\Grafico.jpg');

Ao componente de impressao, simples-
mente adicione ao evento OnClick o c6di-
go abaixo, que fard aimpressdo do gréfico
na impressora padrao instalada.

DBChartl.Print;

Nota: Tanto na opcdo de exportar quan-
to para imprimir,leve em consideracao a
resolucao de tela e do formulario onde
o gréfico se encontra. As proporcoes de
exportacdo e/ou impressdo serdo exta-
mente as mesmas as quais o grafico se
encontra no momento da requisicao.

Rodando a aplicacao

Retornando agora até o formuldrio prin-
cipal, adicione um Button com o Caption
“Clientes por Pais” e adicione ao evento
OnClick o c6digo para chamar o formuld-
rio do grafico conforme a seguir:

frmCustomerCountry.Show;

Execute agora sua aplicagdo, exibindo
o formuldrio onde criamos o gréfico.
Veja as formatagdes e valores do gréfico
construido (Figura 6).
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Gréfico dinamico

Chamo esta forma de gréfico como
dindmica devido ao fato de vocé ter a
liberdade de definir a quantidade de
registros que deseja exibir, sendo que
o restante dos mesmos, que ndo sao
atingidos pela condigdo de limite da
quantidade, serdo somados e adicionados
ao grafico em uma categoria “OUTROS”.
Sua construgdo ndo é muito complicada,
portanto maos a obra.

V4 até o Data Module do projeto e adicio-
ne trés novos componentes, sendo eles:

SQLDataSet: altere a propriedade Name
para “sqlDinamicoGrafico”, ligue sua pro-
priedade SQLConnection ao componente
“sqlConexao” e adicione a seguinte ins-
trucdo SQL a propriedade CommandText:

select first 5 skip 0 department.department
as departamento,

count(employee.emp_no) as clientes from
department, employee

where employee.dept_no = department.dept_no
group by department.department order by 2
desc

DataSetProvider: altere o Name para “ds-
pDinamicoGrafico” e conecte a proprie-
dade DataSet ao sqlDinamicoGrafico;

ClientDataSet: altere o Name para “cds-
DinamicoGrafico” e ligue a propriedade
ProviderName ao dspDinamicoGrafico. Abra
o Fields Editor e adicione todos os campos
retornados pela SQL.

Crie agora um novo formuldrio, altere
o nome para “frmGraficoDinamico” e o
Caption para “Gréfico de empregados por
Departamento”. Salve a Unit do formuldrio
como “uGraficoDinamico.pas”. Adicione

agora ao formuldrio um componente Panel
com sua propriedade Align definida
para alTop e dentro do Panel adicione
um componente Edit (“edtQntde”) para
receber a quantidade de registros a ser
exibida e um Button com o Caption “Exibir
Gréfico” para ativar a pesquisa. Adicione
ao formuldrio um componente DBChart
definindo sua propriedade Align para al-
Client, deixando os componentes organi-
zados de forma semelhante a Figura 7.

Com um duplo clique sobre o gréfico,
adicione uma nova série do tipo Pie, aces-
se a aba Series ao lado de Chart e faca a
configuragdo na aba DataSource, de forma
semelhante ao exemplo de grafico ante-
rior, porém agora nao ligando o DataSet
ao SQLDataSet, mas sim ao componente
ClientDataSet configurado no Data Modu-
le. Na instrugdo SQL que adotamos para
este exemplo, estamos selecionando o
nimero de empregados por departamen-
to. Atribua a propriedade Labels o campo
DEPARTAMENTOS e a propriedade Pie
o campo CLIENTES. Faga as demais confi-
guragdes do grafico da mesma forma que
no gréfico do exemplo anterior.

Atribua ao evento OnClick do botao
“Exibir Gréfico” o c6digo da Listagem 2,
que serd responsdvel por fazer a pesquisa
dos registros no banco de dados e arma-
zenar os valores no ClientDataSet.

Ao final da selegdo de todos os registros,
de acordo com o limite de informagées a
serem exibidas, um célculo serd realizado
e designard uma nova busca no banco
de dados, que trard como resultados os
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registros ndo atingidos pela primeira con-
digdo de pesquisa, adicionando um novo
registro ao ClienteDataSet com a descri¢do
de OUTROS e o valor correspondente.
Volte agora para o formuldrio princi-
pal e adicione mais um botdo, altere o
Caption para “Empregados por Depar-
tamento” e adicione a seguinte linha
de cédigo ao evento OnClick do botéao:

frmGraficoDinamico.Show;

Execute sua aplicacdo acessando o grafi-
co que ird trazer por padrdo os 5 primeiros
registros que deixamos configurados na
instru¢do SQL, mas que ao receber um
parametro de limite de valores exibira
o grafico com registros selecionados e
um ultimo registro com o rétulo “OU-
TROS” e a quantidade a ele relacionado
(Figura 8).

Conclusao

Vimos nesse artigo exemplos praticos do
uso e da empregabilidade de graficos em
nossos sistemas. Agora de uma forma fécil
vocé poderd apresentar uma ferramenta a
mais nos seus sistemas para seus clientes,
possibilitando uma visualizagdo mais en-
tendivel dos contetidos e planilhas de infor-
magoes. Até o préximo artigo. Abragos. @

www.devmedia.com.br/clubedelphi/portal.asp

Acesse agora 0 mesmo o portal do assinante ClubeDelphi e assista a

uma video aula de Fabricio Desbessel que mostra como trabalhar com
gréficos no Delphi.

www.devmedia.com.br/articles/viewcomp.asp?comp=4906
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Figura 7. Componentes para montagem do grafico dindmico

Figura 8. Grfico dindmico com limitagdo de registros
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o passado, principalmente

quando se programava para

MS-DOS, a quantidade de me-
moria RAM disponivel era irriséria, o
que obrigava os programadores muitas
vezes a usar técnicas complexas para
economizar alguns poucos bytes de me-
moria de leitura.

Atualmente os computadores possuem
grande quantidade de meméria RAM dis-
ponivel, mas isto ndo é motivo para que
se aloque memoria desnecessariamente,
j& que nem sempre a aplicacdo rodard
localmente. Por exemplo: uma aplicacao
instalada num servidor pode ser acessada
simultaneamente por diversos usudrios
via Windows Terminal Services (WTS).
Estes usudrios podem estar em qualquer
lugar do mundo, mas rodardo a aplicacdo
diretamente no servidor. Se o sistema e
o nimero de usudrios forem grandes, e
o desenvolvedor abusar da alocagdo de
memoria, pode haver problema de falta
de memoéria mesmo em computadores

com mais de 1 GB de RAM.

Este artigo mostra passo a passo uma
técnica simples e eficaz para criar Data
Modules em tempo de execucdo em apli-
cagdes Cliente/Servidor, o que torna a
inicializacdo da aplicagdo mais rdpida
€ a0 mesmo tempo consome menos me-
moria RAM.

Entendendo a arquitetura

Data Module nada mais é do que um
repositério de componentes nao visuais
assim como o préprio nome sugere. Sua
finalidade é alocar componentes de
acesso a dados a fim de separar regras
de negdcio da interface. Com isso tem-se
uma maior facilidade na manutengéo e/
ou em uma possivel migragéo de Cliente/
Servidor (duas camadas) para n-tiers (trés
ou mais camadas).

A Figuralilustra como fica a arquitetu-
ra de uma aplicagdo usando Data Modules,
onde os componentes de acesso a dados
e as regras de negocios estariam neles,
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ficando somente na parte do formuldrio
0s componentes visuais e 0s que nado
acessam dados.

Criando a Aplicacao

Essa aplicacdo serd constituida de um
formuldrio principal e 4 Data Modules.
Portanto crie uma nova aplicacdo utilizan-
do o menu Filel New>Application. Salve o
projeto na pasta de sua preferéncia. Paraa
Unit dé o nome de “uPrincipal.pas” e para
o projeto dé o nome de “Employee.dpr”,
por tdltimo altere a propriedade Name do
formuldrio para “frmPrincipal”.

Configurando os Data Modules

Adicione um Data Module usando o
menu Filel New>Data Module e salve-o
com nome de “uDMConexao”, altere a
propriedade Name para “dmConexao”.
Coloque o dmConexao para que seja criado
antes do frmPrincipal. Para isso acesse
Project>Options ou use o atalho Ctrl +
Shift + F11 e na aba Forms mude a ordem
para que o dmConexao esteja primeiro que
o frmPrincipal.

Por padrao, todos os formuldrios e Data
Modules sdo criados automaticamente
quando o programa € inicializado, para
alterar isso vd em Tools|Environment
Options>Designer e desmarque a opgao

EASY DELPHI

Formularios

&
CligntDrataSet CligmtD ataS et CligmtD ataSet ClientDrataSet

LI LI e e

die i s s

HiE A HIE HIE
D ataSetProvider DrataSetProvider [DrataSetProvider [DrataSetProvider

DEX B DEX DEX

SOLAueny SQLQuer_l,l SOLOuem SOLOueny

SQLCDnnectlon

I

DBEXxpress

Base de
Dados

SOINPOW e1eqg

Auto create forms & data modules. Outra
forma de fazer a mesma coisa é a partir |

da janela Project>Options, apds criar o Figura 1. Arquitetura de uma aplicagdo com Data Module

Project Options for, Employee.exe E‘ 2 dbExpress Connections: C:\irquivos de programas\Wirquivos com... @
Directonies/Conditionals ] Yerzion Info ] Packages ] ﬂ j ﬂ v
Farms l Application ] Cormnpiler ] Compiler Messages ] Linker ] Bifer e Bl Seiits
[0 | ke Value
Main farm: |frmPrincipa| j LConnection Name Dirivvert are Interbase
Artigo Databaze WFirebirdexamples\EMPLOVEE. FDB
Auto-create forms: Available forms: DE2Connection Frolehame Folehame
draConexan < drCustomer ! -
frraPrincipal J dmlista InformixConnection User_Name spedba
dmSales M350 Connection Password rasterkey
A MySQLConnection
OracleConnection ServeiCharSet
ﬂ SOLDidlect 3
ErnorResourceFile
ﬂ LocaleCode naoa
BlobSize -1
CommitR etain Falze
WaitOnLocks True
Interbaze Translsolatio BeadCommited
Trirn Char Falze
QK | Cancel Help ak | Cancel Help

Figura 2. Opgdes do projeto com todos os Data Modules criados Figura 3. Exemplo de Conexdo com o FireBird
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formuldrio ou Data Module selecionar os
que ndo serdo criados com a aplicagdo e
arrasté-los para o lado (Avaliable forms).
No final do desenvolvimento do aplica-
tivo mostrado neste artigo, deverd ter-se
a mesma configuracdo apresentada na
Figura 2.

O préximo passo é configurar a conexao
com a base de dados. Para este aplica-
tivo serd usada a base de exemplo que
acompanha o FireBird. Para isso adicione
um componente SQLConnection (“sqlCo-
nexao”), que estd na aba dbExpress, ao
sqlConexao dé dois cliques no componente
para configurar suas propriedades.

Crie uma nova conexdo clicando no
botdo “+”. Na caixa de didlogo que se
abre selecione o driver Interbase em
Driver Name, dé um nome a conexdo em
Connection Name e confirme.

Nota: O Delphi traz por padrao algu-
mas conexdes previamente configura-
das, como é o caso de IBConnection.

Ap0s criar a conexdo configure a pro-
priedade DataBase informando o enderego
completo para o arquivo EMPLOYEE.
FDB, normalmente localizado na pasta
C:\Arquivos de Programas\Firebird_1_5\
Firebird\Examples\empbuild\. A proprieda-
de User_Name é o usudrio que serd usado
para conectar no servidor, por padrdo é
SYSDBA e a senha é masterkey (atributo
Password). Mude o SQLDialect para 3 e
pressione OK, a configuragdo deverd ficar
semelhante a mostrada na Figura 3.

No Object Inspector mude as proprie-
dades LoginPrompt para False e ative
a conexdo mudando para True a pro-
priedade Connected. Pronto, a conexdo
com o servidor de banco de dados estd
estabelecida.

Adicione um novo Data Module ao proje-

to. Ele conterd a query que serd usada para
mostrar os dados da tabela Country. Sal-
ve-0 com o nome de “uDMLista”, mude
a propriedade Name para “dmLista” e
adicione uma referéncia a Unit dmConexao
usando para isso o menu File>Use Unit
ou o atalho Alt + F11. Agora adicione um
componente do tipo SQLQuery ao Data
Module, renomeie-o para “qryCountry” e
na propriedade SQLConnection coloque a
conexao criada no dmConexao. Coloque a
seguinte consulta na propriedade SQL:

select * from COUNTRY

Ative e desative a query para verificar
se a consulta inserida esta correta. Feito
isso adicione mais dois componentes: um
DataSetProvider(“dspCountry”) alterando
a propriedade DataSet para “qryCoun-
try”. Um ClientDataSet(“cdsCountry”)
com a propriedade DataSetProvider apon-
tada para o dspCountry. Dé dois cliques
no cdsCountry e com o botdo direito do
mouse selecione a opcao Add all fields,
com isso estard adicionando todos os
campos da tabela ao Fields Editor.

Adicione outro SQLQuery que seréd uti-
lizado para mostrar os dados da tabela
Customer. Mude as propriedades Name
para “qryCustomerLista”, SQLConnection
para “dmConexao.sqlConexao”, e para o
SQL adicione a instrugdo a seguir:

select * from CUSTOMER

Adicione agora um DataSetProvider(“d
spCustomerLista”) e mude seu DataSet
para “qryCustomerLista”. Finalmente
adicione um ClientDataSet(“cdsCustom
erLista”). Seu ProviderName devera ser
apontado para dspCustomerLista. Por fim
dé dois cliques no cdsCustomerLista e
com o botdo direito do mouse selecione
a opcao Add all fields (Figura 4).

Adicione mais um Data Module para a

tabela Customer da nossa base de dados.
Salve com o nome de “uDMCustomer.
pas” e mude a propriedade Name para
“dmCustomer”. Adicione uma referéncia
ao dmConexao usando Alt + F11 assim
como foi feito anteriormente.

Nesse ponto serdo adicionados os
componentes que permitem inserir
novos registros na tabela. Para isso
adicione trés componentes sendo: um
SQLQuery(“qryCustomer”), SQLCon-
nection como “dmConexao.sqlConexao”
e propriedade SQL com a instrucdo a
seguir:

select * from CUSTOMER

Um DataSetProvider(“dspCustomer”)
com a propriedade DataSet apontada
para qryCustomer e por ultimo um
ClientDataSet(“cdsCustomer”) com sua
propriedade ProviderName igual a dsp-
Customer.

Assim como nos demais ClientDataSets
adicione todos os campos da tabela
usando a opcao Add all fields encontrado
no menu de contexto do Fields Editor, ou
seja, clique duas vezes no cdsCustomer e
em seguida com o botdo direito escolha
a opg¢ao mencionada(Tabela 1).

No evento BeforeOpen do cdsCustomer
digite:

{ Cria o dmlLista }
dmLista := TdmLista.Create(nil);

{ Abre o cdsCountry }
dmLista.cdsCountry.Open;

E no evento AfterClose digite:

{ Fecha o cdsCountry }
dmLista.cdsCountry.Close;

{ Libera de meméria o dmLista |}
FreeAndNil(dmLista);

Nota: Nao esqueca de adicionar a
Unit do Data Module dmLista ao Uses
do Data Module dmCustomer. Utilize
File>Use unit ou Alt + F11.

Componente Propriedade Valor 2‘. dmlLista E@@
Name qryCustomer
a q i FLAiEe] i
SQLQuery1 SQLConnection dmConexao.SQLConnection1 O E=
. DE:, Tl !!
S0 SELECT* FROM CUSTOMER greCountry dzpCountry cdzCauntry
DataSetProvider] Name dspCustomer R .
ataSetProvider i fod i
DataSet qryCustomer e
[ ]
Name cdsCustomer qmCustomerLizta  dspCusztomerLista  cdsCustomerlista
ClientDataSet1
DataSetProvider dspCustomer

Tabela 1. Configuracao dos componentes utilizados no dmCustomer

Figura 4. dmLista depois de configurado
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Com estes dois eventos garante-se que Customer digite o c6digo da Listagem 1. 7 dmSales
o dmlLista serd criado quando for aberto o Para tornar mais clara a utilizagdo serd _ -
cdsCustomer e quando ele for fechado serd criado agora mais um cadastro para a tabe- é =
DEX =z
liberado de memoria, ndo permanecendo  la SALES que tem relacionamento “n” para S ales depSales ot s
em memoria quando desnecessario. 1 com a tabela CUSTOMER. Seguindo a

Adicione também a este Data Module ~ mesma idéia usada anteriormente parao  Figura5.dmSales depois de configurado
mais um SQLQuery que desta vez sera p <
usado pelo Generator CUST_NO_GEN, Listagem 1. (édigo do evento Afterlnsert do cdsCustomer
que vai garantir que ndo se tenha cha-

procedure TdmCustomer.cdsCustomerAfterInsert(DataSet: TDataSet);

imari i begin
ves primdrias repetidas para a tabela 7 Abre a qryGenCustomer )
Customer, altere as propriedade Name qryGenCustomer.0pen;
» P . { Atribui o valor do qryGenCusomerGEN_ID para o cdsCustomerCUST_NO }
Ppara qryGenCustomer , SQLConnection cdsCustomerCUST_NO.Value := qryGenCustomerGEN_ID.AsInteger;

{ Fecha a qryGenCustomer }
qryGenCustomer.Close;

que neste caso é sqlConexao, e insira o L end;
seguinte select na propriedade SQL:

coloque a conexdo criada no dmConexao,

select GEN_ID(cust_no_gen,1) from q
rdbSdatabase Componente Propriedade Valor
Name qrySales
Nota: Generator é um objeto do banco SQLQuery1 SQLConnection dmConexao.SQLConnection1
de dados Firebird que, com o auxilio da sQL SELECT * FROM SALES
funcdo GEN_ID também do banco, gera : Name dspSales
numeros sequenciais, os famosos Auto DataSetProviderl DataSet qrySales
Incrementados.
Name cdsSales
ClientDataSet1 X
De dois cliques na guery e adicione todos PEENEREIS tgiels
os campos. No evento Afterlnsert do cds- Tabela 2. Configuracdo dos componentes utilizados para o dmSales

D 0 B F &« d [#] b W = Imprimir 5 H & i * Fechar

Impressao Rapida em Matricias... =13
\

O mais completo componente para impressao em MATRICIAIS !
LIDERANCA absoluta na sua categoria !

Ideal para Notas Fiscais, Duplicatas, Boletos Bancarios, etiquetas e relatérios em geral.

- Opgéo para impressao colorida Rdprint Setup

- Ajustes de margens para impressao grafica

- Opgao para ocultar a barra de progresso Configuragao da Impressao
- Variaveis PAGINAS, DATA, HORA e TITULO
Novo form de SETUP com : ¥ NP Deskial 8700 =] Bopoedates. |
- Mapeamento das impressoras e Modelos Modelo:  [Gidiico - Compalivel com Windows =] T
- Selegao de paginas igual ao word (1-5,7,8) . o
- Opgao para Inverter e Agrupar copias na impressao C~ Todss Mo deCias
Novo form de PREVIEW com: " Pagina Atusl .
- Fungao para Procura de TEXTO no relatério ® Pagnas 157 : 1 ¥ Agupa
- ROLAGEM com salto automatico de pagina Imprimic: [ Todas as péginss do mtervalo v T T Ordeminversa
- ARRASTO da imagem do preview
- StatusBar com informagdes da impress&o e v 0 | % Corcoln
- Novos icones personalizados
* Disponivel para Delphi 5, 6, 7, 2005 e 2006 (VCL) - Del tr@ss Fone/Fax (14) 3454-7880
* Compativel com todas as versoes do Windows - i - www.deltress.com.br
* Imprime em portas LPT / COM e USB (modo grafico) = Informatica = 3

Pagina: 2 de 19 87%  Impressoa: HP DeskJet 870Cxi Grafico * O RDprint 4.0 ndo imprime gréficos !
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Listagem 2. (ddigo do botao Novo

procedure TfrmPrincipal.btnNovoClienteClick(Sender: TObject);
begin
{ Verifica se jd foi instanciado a o dmCustomer |}
if dmCustomer = nil then
{ Instancia a varigvel dmCustomer }
dmCustomer := TdmCustomer.Create(nil);
{ Abre o cdsCustomer }
dmCustomer.cdsCustomer.Open;
{ Insere um novo registro no cdsCustomer }
dmCustomer.cdsCustomer.Insert;
end;

Listagem 3. (ddigo do botao Salvar

procedure TfrmPrincipal.btnSalvarClienteClick(Sender: TObject);
begin
{ Verifica se ja foi criada o dmCustomer }
if dmCustomer <> nil then
begin
{ Guarda uma linha no cdsCustomer }
dmCustomer.cdsCustomer.Post;
{ Salva as alteracoes guardadas no cdsCustomer para o banco |}
dmCustomer.cdsCustomer.ApplyUpdates(0);
{ Libera da memoria o dmCustomer. }
FreeAndNil(dmCustomer)
end
else
{ Caso ndo exista em meméria ainda o dmCustomer emite uma mensagem }
ShowMessage( ‘Vocé deve clicar em novo antes de salvar um registro’);
end;

Listagem 4. (ddigo do botao Cancelar

procedure TfrmPrincipal.btnCancelarClienteClick(Sender: TObject);
begin
{ Verifica se jd foi criada o dmCustomer }
if dmCustomer <> nil then
begin
{ Cancela tudas as alteracdes realizadas no cdsCustomer. }
dmCustomer.cdsCustomer.Cancel;
{ Libera da meméria o dmCustomer. }
FreeAndNi1(dmCustomer)
end
else
{ Caso ndo exista em memoria ainda o dmCustomer emite uma mensagem. }
ShowMessage( ‘Vocé deve clicar no novo antes de cancelar um’ + ‘registro’);
end;

Eadashar]
Customer
5

Nova o
CUST_NO  CUSTOMER CONTACT_FIRST CONTACT_LAST
|DBEdit!  |DBEdit2 |DEEdits |DEEditd
ADDRESS_LINE1 ADDRESS_LINE2 oY PHONE_NO
|DBEdits |DBEdit? |DEEditS |DEEdiS
STATE_PROVINCE POSTAL_CODE COUNTRY
[DBEd#a [DBEdi [ cbCauntry =] wu| Selvr | Fancelar |
Sales +

+ou
Nova
LRy

PO_NUMBER CUST_NO w0 AGED ORDER_STATUS
[DEEdD | chxCustamer " " %] |DBEdizs DBEdit15
ORDER_DATE DATE_NEEDED DISCOUNT SHIP_DATE
|DBEditE |DBEditE |DBEditzz |DBEiN7
aTv_ORDERED TOTAL_VALUE ITEM_TYPE
[DEEdiZ0 [DEEdZ1 [DBEiZ3 Sabvar | Corcelar |

Figura 6. frmPrincipal depois de alterado para o cadastro da tabela Customer

cadastro da tabela CUSTOMER crie um
novo Data Module salve com o nome de
“uDMSales.pas” e mude a propriedade
Name para “dmSales”. Figura 5
Adicione um componente SQLQuery, um
DataSetProvider e um ClientDataSet confi-
gurando-os de acordo com a Tabela 2.
Dé dois cliques no cdsSales com o botao
direito do mouse selecione a opgao Add
All Fields. Para o evento BeforeOpen do
cdsSales digite:
{ Cria o dmLista }
dmLista := TDMLista.Create(nil);

{ Abre o cdsCustomerlLista }
dmLista.cdsCustomerLista.Open;

E para o evento AfterClose do cdsSales
digite:
dmLista.cdsCustomerLista.Close;
{ Fecha o cdsCustomerlista }

FreeAndNil(dmLista);
{ Libera de memoria o dmLista /

Com isto tem-se somente em memoria o
dmLista enquanto o cdsSales estiver aberto.

Configurando o formulario principal

Abra o frmPrincipal adicione uma re-
feréncia aos Data Modules dmCustomer,
dmlLista e dmSales. Adicione dois GroupBoxs
mudando a propriedade Narme para “gbx-
Customer” e “gbxSales” respectivamente.
Adicione também 4 DataSources alterando
a propriedade Name de cada um deles
para dsCustomer, dsSales, dsCountryLista e
dsCustomerLista. Altere a propriedade Da-
taSet de cada um deles apontando-os para
seus respectivos ClientDataSets O dsCusto-
mer receberd “dmCustomer.cdsCustomer”,
para o dsSales coloque “dmSales.cdsSales”,
no dsCountryLista receberd “dmLista.cds-
Country e para o dsCustomerLista coloque
“dmLista.cdsCustomerLista”.

Dentro do gbxCustomer adicione 10 DBE-
dits, 11 Labels e um DBLookupComboBox.
Para os componentes DBEdit configure a
propriedade DataSource para dsCustomer
e a propriedade DataField faga com que
cada um receba um campo diferente.

No DBLookupComboBox altere as seguin-
tes propriedades: Name para “cbxCoun-
try”, ListSource para “dsCountryLista”,
ListField para “CURRENCY”, KeyField
para “COUNTRY”, DataSource para ds-
Customer e DataField para “COUNTRY”.

Dentro do “gbxSales” adicione 10 DBE-
dits, 11 Labels e um DBLookupComboBox.
Altere a propriedade DataSource dos DBE-
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dit para dsSales e ajuste o DataField para
que nenhum DBEdit fique com 0 mesmo
campo. Ja para o DBLooKupComboBox alte-
re as seguintes propriedades: Name para
cbxSales, ListSource para dsCustomerLista,
ListField para “CUSTOMER”, KeyField
para “CUST_NO”, DataSource para dsSales
e DataField para “CUST_NO”.

Ap6s concluidas essas configuragdes o
formuldrio principal deverd se parecer
com a Figura 6.

Codificando o exemplo

Faremos agora a parte de codificacdo
do exemplo. Antes de codificar, insira 6
componentes Button sendo 3 no GroupBox
superior com os nomes btnNovoCliente,
btnSalvarCliente e btnCancelarCliente. Re-
pita esses passos modificando os nomes
dos 3 outros Buttons do GroupBox para
btnNovaVenda, btnSalvarVenda e btnCan-
celarVenda.

Comegaremos pelo botdo novo cha-
mado de btnNovo. Dé um duplo clique
no btnNovoCliente que estd dentro do
gbxCustomer e insira o seguinte cédigo
da Listagem 2.

Para o evento onClick do btnSalvar que
estd dentro do gbxCustomer digite o c6di-
go da Listagem 3.

Para o evento onClick do btnCancelar
que estd dentro do gbxCustomer digite o
cédigo da Listagem 4.

Em seguida codifique o btnNovaVenda
que esta dentro gbxSales digite o c6digo
da Listagem 5.

Ja para o botdo btnSalvarVenda que
também estd dentro do gbxSales digite o
cédigo da Listagem 6.

Por dltimo o btnCancelar digite o seguin-
te cédigo da Listagem 7.

-
Listagem 5. (ddigo do botao Nova Venda

begin
{ Verifica se jé& foi criado o dmSales }
if dmSales = nil then
{ Instancia a varidvel dmSales }
dmSales := TdmSales.Create(nil);
{ Abre o cdsSales }
dmSales.cdsSales.Open;
{ Insere um novo registro no cdsSales }
dmSales.cdsSales.Insert;
end;

Listagem 6. (4digo do botao Salvar Venda

procedure TfrmPrincipal.btnNovaVendaClick(Sender

TObject);

procedure TfrmPrincipal.btnSalvarVendaClick(Send
begin
{ Verifica se ja foi criado o dmSales }
if dmSales <> nil then
begin
{ Guarda uma linha no cdsSales }
dmSales.cdsSales.Post;
{ Salva as alteracdes guardadas no cdsSales
dmSales.cdsSales.ApplyUpdates(0);
{ Fecha o cdsSales }
dmSales.cdsSales.Close;
{ Libera da memoria o dmSales }
FreeAndNil(dmSales);
end
ellise
{ Caso ndo exista em meméria ainda o dmCusto
ShowMessage( ‘Vocé deve clicar no novo antes
end;

Listagem 7. (4digo do botao Cancelar Venda

er: TObject);

para o banco }

mer emiti uma mensagem }
de salvar um registro’);

procedure TfrmPrincipal.btnCancelarVendaClick(Se
begin
{ Vrifica se ja foi criada o dmSales }
if dmSales <> nil then
begin
{ Cancela tudas as alteracdes realizadas no
dmSales.cdsSales.Cancel;
{ Fecha o cdsSales }
dmSales.cdsSales.Close;
{ Libera da meméria o dmSales }
FreeAndNil(dmSales);
end
else

ShowMessage( ‘Vocé deve clicar no novo antes
end;

-

{ Caso ndo exista em memoria ainda o dmCustomer emiti uma mensagem }

nder: TObject);

cdsSales }

de cancelar um registro’);

Conclusao

Embora os computadores de hoje possu-
am grande quantidade de meméria RAM
disponivel, ainda é preciso que se tenha
cuidado com o desenvolvimento, pois nem
sempre as aplica¢Oes sdo executadas numa

+ de 80.000 membros cadastrados
+ de 15.000 exemplos com fontes

+ de 900 apostilas
+ de 4.000 dicas
Forum Delphi
Artigos

redelocal. Este artigo mostrou passo a pas-
souma técnica simples e eficaz para criar os
componentes de acesso a dados em tempo
de execugdo, o que torna a inicializagdo da
aplicagdo mais rdpida e ao mesmo tempo
consome menos memdria RAM. @

www.delphi.eti.br

Um dos maiores sites de apoio a desenvolvedores Delphi do Brasil!!!
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Treinamento em ASP.NET - Parte 1

Primeiros passos com ASPNET

Renato Haddad

Autor de diversos treinamentos multimidia
NET e SQL Reporting Services para Microsoft
Brasil e América Latina.

¢é Microsoft Most Valuable Professional (MVP).

objetivo deste treinamento é

mostrar a vocé, leitor, como criar

aplicacdes para Internet por
meio dos controles mais utilizados no
dia-a-dia de uma pdgina. A linguagem
utilizada serd o Delphi for .NET. A dnica
ferramenta que vocé precisa é o Borland
Developer Studio 8/2005/2006, na qual
é possivel criar desde o banco de dados
até componentes, classes e WebServices.
O ASP.NET vem conquistando enorme
espago entre os desenvolvedores devido
a sua facilidade de uso, manutengio e
performance.

O processamento das pdginas ocorre
no servidor, o que significa dizer que,
quando o internauta navega nas péginas,
estas sdo requisitadas ao servidor, que
verifica a solicitacdo, realiza o parse das
pdginas, monta um HTML e as envia para
o navegador que as solicitou.

E, ja que mencionei HTML, néo se pre-
ocupe, pois é possivel desenvolver toda
a aplicagdo sem usar nenhuma TAG de

HTML. Tudo o que vocé precisa saber
é a linguagem Delphi for .NET. Cabe
ressaltar que o Framework é o respon-
sédvel por todo esse processo (por isso a
necessidade de té-lo instalado no servi-
dor), juntamente, é claro, com o Internet
Information Server.

No Borland Developer Studio 2006,
selecione o menu File| New>ASP.NET
Web Application — Delphi for .NET e crie
um projeto do tipo ASP.NET Web Appli-
cation chamado “DelphiMag”. Na caixa
de didlogo (Figura 1) que se abre digite
o nome da aplicacdo como citado ante-
riormente, configure seu caminho item
Location e escolha o servidor no item de
mesmo Server.

Clique nobotao “OK” para criar automa-
ticamente o site virtual dessa aplicagao.
Note que ja existe um arquivo chamado
WebForm1.aspx. Clique em File>Save as...
e salve o arquivo como “Listas.aspx”. No
fundo do documento, digite o texto “Con-
trole de Listas ASPNET” e utilize a barra
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de ferramentas de formatagdo acima da
pégina para melhorar a aparéncia do
texto. Exiba a paleta de componentes do
Delphi no menu View>Tool Palette (CTRL
+ ALT + P) caso ndo esteja visivel e veja
toda a lista de controles disponiveis.

Monte uma pagina com os seguintes
controles: Um Label onde sua proprie-
dade text serd “Prato”, um TextBox com a
propriedade ID igual a “txtPrato”, cinco
Buttons com os ID’s iguais a “btnIncluir”,
“btnExcluir”, “btnLimpar” e “btnPesqui-
sar” respectivamente. Modifique tam-
bém a propriedade Text de cada Button
digitando o nome da func¢do que cada
um exercerd no exemplo. Em seguida
adicione também um ListBox sendo que
seu ID serd (“IstCardapio”) e Selection-
Mode igual a Multiple. Inclua um novo
Button com Text igual a “Selecionados” e
ID “btnSelecionados”. Por tltimo inclua
um Label e altere suas propriedades ID
para “lblltems” e Text para “”. Observe
na Figura 2 uma sugestdo de layout para
o exemplo.

Para criar os cédigos, dé um duplo
clique em cada bot&o e digite os cédigos
relativos a eles apresentados na Listagem
1. A explicagdo dos cédigos é mostrada
nos préprios comentdrios das linhas.

Salve o arquivo e exiba novamente
o formuldrio usando o atalho F12. No
Delphi, defina esse arquivo como Default
clicando com o botéo direito do mouse no
item Listas.aspx e em seguida em Set as
Start Page na janela Project Manager. Para
compilar o formuldrio, selecione o menu
Project>Build DelphiMAG ou pressione
CTRL + F9. Para executar, selecione o
menu Run>Run ou F9. Essa opcdojd salva,
compila, abre o navegador e executa a
aplicacdo. Veja o resultado da execugao
na Figura 3.

Vocé deve estar se perguntando onde
é que entra o Delphi for .NET, ou seja,
o cédigo que criamos para cada botao.
A resposta é simples: quando vocé com-
pila a aplicacdo, é gerado um arquivo
DelphiMag.dll contendo todos os cédigos
criados. Quando vocé abre uma pagina
ASP.NET, ela é processada no servidor,
que por sua vez identifica o navegador
que a solicitou, monta um HTML e a
envia ao navegador. As vantagens desse
processo completo sdo muitas, dentre as
quais destaco:

EASY DELPHI

Listagem 1. Cddigo dos botdes Incluir, Excluir, Limpar, Pesquisar e Selecionados

var
I : Integer;
begin
{ Apaga o conteudo do Label }
1blItems.Text := “7;
{ Adiona os itens selecionados ao Text do Label}
for I := 0 to 1stCardapio.Items.Count-1 do
if 1stCardapio.Items[I].Selected then
1b1Items.Text := 1blItems.Text + ‘<br>’ + l1stCardapio.Items[I].Text;
end;
procedure weblistas.btnPesquisar_Click(sender: System.Object; e: System.EventArgs);
begin
{ Desmarca qualquer item da lista }
IstCardapio.SelectedIndex := -1
{ Pesquisa o item na lista |}
1stCardapio.Items.FindByText(txtPrato.Text.Trim()).Selected := True;
{ Zera o campo }
txtPrato.Text := “’;
end;
procedure weblistas.btnlLimpar_Click(sender: System.Object; e: System.EventArgs);
begin
{ Limpa toda a lista /
TstCardapio.Items.Clear();
end;
procedure weblListas.btnExcluir_Click(sender: System.Object; e: System.EventArgs);
begin
{ Verifica se hd um item selecionado |/
if I1stCardapio.SelectedIndex >= 0 then
{ Remove o item da lista |}
IstCardapio.Items.RemoveAt(1stCardapio.SelectedIndex);
end;
procedure weblListas.btnIncluir_Click(sender: System.Object; e: System.EventArgs);
begin
{ Verifica se o txtPrato contém algo digitado }
if txtPrato.Text <> °’ then
{ Inclui o item na lista |}
TstCardapio.Iltems.Add(txtPrato.Text.Trim());
{ Apaga o campo }
txtPrato.Text := *’;
end;
&

procedure weblListas.btnSelecionados_Click(sender: System.Object; e: System.EventArgs);

New ASP.NET Web Application

Application Name

Twpe the name that vou want to use for this application. Use the same naming
conventions that you would For naming a direckory.

=

Location: |c:'l,inetpub'l,wwwroot‘l,Webnpplicati0n2 A
View Server Opki

Server: |Cassini Web Server X aris

]

Figura 1. Criacao de projeto ASPNET no Delphi

Cancel | Help |

T ——
48 » ¢ BHE -2

Pireul =l Temihewionan =0 &

Controle de Listas ASP.NET

Prate

|inclur | | Exchar || Lmpar | | Pesquisar |

-
Linbtund

]
| Seaciensdes |

i T

Figura 2. Exemplo de formuldrio ASPNET
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Listagem 2. C4digo do Page_Load

procedure TWebForml.Page_Load(sender: System.Object; e:
var

ArrayMarca : Array[l..4] of string;
begin

if not Page.IsPostBack then

begin
{ Define um ArraylList com as opgdes }
ArrayMarcal[l] := ‘Citroen’;
ArrayMarcal[2] := ‘Ford’;
ArrayMarcal[3] ‘GM”
ArrayMarcal4] := ‘Volks’

dropMarca.DataSource := ArrayMarca;
{ 0 DataBind preenche o controle }
dropMarca.DataBind();
{ Insere um item na primeira opcdo do DropMarcas }
dropMarca.Items.Insert(0, ‘marca...’);
end;
end;

Listagem 3. C4digo do evento SelectedIndexChanged do dropMarca

System.EventArgs);

var
tabModelos DataTable;
newRow : DataRow;

begin

{ Limpa o contetido do dropModelos |}
dropModelo.Items.Clear();
{Define a tabela que serd criada apenas na meméria }
tabModelos := DataTable.Create;
{Define as colunas com os nomes e tipos }
tabModelos.Columns.Add( ‘codigo’);
tabModelos.Columns.Add( ‘modelo’);
{ Verifica qual o item selecionado }
if dropMarca.SelectedItem.ToString() = ‘GM’ then
begin
{ Cria uma nova linha }
newRow := tabModelos.NewRow();
{ Define os conteddos }
newRow[ ‘codigo’] := ‘10°;
newRow[ ‘modelo’] := ‘Vectra’;
{ Adiciona a linha a tabela }
tabModelos.Rows.Add(newRow) ;
end
else if dropMarca.SelectedItem.ToString() = ‘Citroen’ then
begin
{ Cria uma nova linha }
newRow := tabModelos.NewRow();
{ Define os conteddos }
newRow[ ‘codigo’] := ‘50°;
newRow[ ‘modelo’] := ‘Xsara Picasso’;
{ Adiciona a linha & tabela }
tabModelos.Rows.Add(newRow) ;
end
else if dropMarca.SelectedItem.ToString() = ‘Volks’ then
begin
{ Cria uma nova linha }
newRow := tabModelos.NewRow();
{ Define os conteddos }
newRow[ ‘codigo’] := ‘32°;
newRow[ ‘modelo’] := ‘Gol Special’;
{ Adiciona a linha a tabela }
tabModelos.Rows.Add(newRow) ;
end
else if dropMarca.SelectedItem.ToString() = ‘Ford’ then
begin
{ Cria uma nova linha }
newRow := tabModelos.NewRow();
{ Define os conteddos }
newRow[ ‘codigo’] := ‘80°;
newRow[ ‘modelo’] := ‘Escort’;
{ Adiciona a linha & tabela }
tabModelos.Rows.Add(newRow) ;
end;
{ Informa a origem do dropModelos que é a tabela
definida com os respectivos modelos }
dropModelo.DataSource := tabModelos;
{ Define o campo que serd exibido no dropModelos |}

dropModelo.DataTextField := ‘modelo’;
{ Define o campo que serd armazenado para cada item |}
dropModelo.DataValueField := ‘codigo’;

{ Preenche o dropModelos }
dropModelo.DataBind();
end;

-

procedure TWebForml.dropMarca_SelectedIndexChanged(sender: System.Object;

EH]

System.EventArgs);

*O arquivo de layout (“Listas.aspx”)
fica separado do arquivo de c6digos
(“Listas.pas”);

* Que a propriedade intelectual (c6digos)
fica protegida, pois estd dentro da DLL;

*Quem se encarrega de montar um
HTML que seja suportado pelo navega-
dor é o Framework, e ndo vocé. Portanto,
o codigo criado é apenas um, mas pode
haver vdrios produtos finais.

No Delphi, adicione um novo formula-
rio usando a opgao Filel New|Other>New
ASP.NET Files>ASP.NET Page e dé o nome
aele de “Carros.aspx” usando paraisso a
opcao File>Save as.... Insira os seguintes
controles: dois DropDownList com seus
respectivos ID’s iguais a “dropMarca”
e “dropModelo”. Marque como True a
propriedade AutoPostBack do componente
dropMarca. Isso é fundamental para que o
formuldrio seja submetido ao servidor.

Insira também um Calendar. Clique
com o botdo direito nele e selecione Auto
format..., selecione um layout de sua pre-
feréncia e confirme. Figura 4.

Agora inclua um Button e defina sua
propriedade Text como “Verificar Dados”
e ID igual a “btnVerificar”. Logo abaixo
coloque um Label (“IblCarro”). Veja um
exemplo de layout na Figura 5.

Como esses controles sdo utilizados
com freqtiéncia, o funcionamento ocor-
re da seguinte forma: no momento em
que o formuldrio é carregado, apenas na
primeira vez é montado o DropMarcas.
Assim que o internauta seleciona uma
marca, é montado o DropModelos com os
modelos especificos a marca selecionada.
Em seguida, o internauta escolhe uma
data no calenddrio e, quando pressiona
o botao Verificar, os dados sdo capturados
dos controles e seus contetidos sdo exibi-
dos no Label.

O DropMarcas seré carregado assim que
o formuldrio for aberto, portanto, digite o
cédigo da Listagem 2 no Page_Load.

Dé um duplo clique no dropMarcas e
digite o c6digo apresentado na Listagem
3. Como esse controle tem a propriedade
AutoPostBack definida como True, assim
que um item for selecionado, o formulario
serd enviado ao servidor, que montara
o dropModelo de acordo com a marca
selecionada.

Em seguida, crie o c6digo para o btnVe-
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rificar que exibe no [blDados o contetido Conclusao

da compra selecionada. Codifique como O ASP.NET ¢ atualmente o meio mais
a seguir no evento Click: produtivo e rdpido de se criar aplicagdes
para Internet, além, é claro, de oferecer

1b1Dados.Text := 'Vocé selecionou a Marca: ' +
dropMarca.SelectedItem.Text + ', o modelo: ' + melhor performance e facilidade de ma-
dropModelo.SelectedItem.Text + ', cédigo: ' + ~ L. .
dropModelo.SelectedItem.Value + nutengao. No proximo art1go, abordare-
', data de compra: ' + t trol b d
Calendarl.SelectedDate.ToShortDateString mos outros controles € acesso a banco de
dados. Aproveitem a leitura, e até 14! “No
Defina Carros.aspx como pagina De- stress, think .NET”. @

fault assim como fizemos com a pagina
Listas.aspx. Salve, compile e execute a
pagina no navegador. Veja o resultado
na Figura 6.

= Wil flecalhosk: BIBINT A plal A0 ki Winleres Inleriel Explores

é = @ hitpiiecelhost OIS TephMAGRE ¥ 7 A o
Bl Gk Yew Fpocies Ioh Bew

Podr et ALY B~ @ #-rieee s Ot

Controle de Listas ASP.NET
Prate

[mehur | [ Extiur | [ Limpar | [ Pesguisar |

J
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Fil¢ de frango
Pirsia de peine

(ﬁ- ‘Welcome Page ] .E] Carros.aspx |

]Normal L”Verdana LHS || B 72 U |E

Vendas de Carros - ASP.NET
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Figura 3. Exemplo de formuldrio ASPNET em execucao

Calendar. Auto Format g|

Select a scheme: Freview:
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Figura 4. Escolha de layout para o componente Calendar

Figura 5. Exemplo de formuldrio de Carros
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compra: 25/10/2007
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Figura 6. Formularios Carros.aspx em execugao
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Nesta secdao vocé encontra artigos sobre

-

Secao PHP

a linguagem PHP e a ferramenta Delphi for PHP

3
¢

Delphi for PHP

Crie um site de publicacdo de noticias — Parte 3

ando seqiiéncia ao mini-curso
DDelphi for PHP, onde estamos

vendo como criar um site de
noticias, vamos criar uma opgao de envio
de fotos para cada noticia. Na verdade,
criaremos um gerenciador de arquivos,
onde serd possivel enviar e excluir ima-
gens para cada noticia.

Outra implementagdo serd a seguranga
da aplica¢do onde criaremos login e res-
tricdo de pédginas pelo nivel do usudrio.
Criaremos uma forma de diferenciar usu-
drios comuns de administradores através
de niveis de acesso. Isso é importante,
pois determinamos como e quem pode
ter acesso ao sistema. Entdo, coloque a

Fabricio Desbessel mao na massa e vamos a pratica.

(fabricio@fabricio.pro.br) . .
é professor de Linguagem de Programagdo do Upload e InStaIagaO do Componente

Curso Técnico em Informdtica do Colégio Fre- EditU ploadFiIe
derico Jorge Logemann de Horizontina/RS e Para permitir o envio de fotos das no-

da FAHOR Faculdade Horizontina. Delphiano de L. . L. .
I ) ticias, é necessario criar uma forma de
coracdo, esta sempre disposto a provar que com

0 Delphi sempre teremos a melhor solugdo. Site upload de arquivos do tipo jpeg. Infeliz-
www.fabricio.pro.br. mente o Delphi For PHP ndo trouxe um

componente especifico para isso, mas
atendendo as solicitacdes dos usudrios, o
pessoal da CodeGear criou e disponibili-
zou o componente EditUploadFile. Baixe o
componente do link codecentral borland.
com/Item/24670 e descompacte-o em um
pasta de sua preferéncia. Localize o ar-
quivo edituploadfile.inc.php e copie-o paraa
pasta de instalacdo da VCL, normalmente
localizada em C:\Arquivos de programas)\
CodeGear\Delphi for PHP\1.0\vcl.

O arquivo edituploadfile.package.php deve
ser copiado para a pasta package dentro
do diretério da VCL, e o arquivo editu-
ploadfile.bmp para dentro da pasta icons
dentro de packages.

Agora é necessdrio instalar o compo-
nente no IDE. Para tanto, acesse o menu
Component>Packages, clique no botdo Add,
localize o arquivo edituploadfile.package.
php, clique em Abrir e depois confirme.
Verifique a paleta de componente Stan-
dard para confirmar que o componente foi
instalado corretamente. (Figura 1)
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e N
Agora abra o formuldrio noticias.php e Listagem 1. Cédigo do botdo Enviar
insiraum ListBox da paleta de componentes global $UDados:
Standard. Insira um EditUpLoadFile, um But- ;f ($_FILESL*EditUpToadFilel” ][ name’] != ")
ton com o Caption definido como “Enviar” $diretorio = “C:/CD/Jornal/fotos/n”.$UDados->tbnoticiasl->id_noticia.”/”;
. . if (lis_dir($diretorio)){
para efetivamente fazer o envio da foto, il e Pt eI 0)

}

$nome_arquivo = $diretorio . $_FILES[ ‘EditUploadFilel’][ ‘name’];

botéoparaprocurararquivosnaméquina, move_uploaded_file($_FILES[*EditUploadFilel’] [“tmp_name’], $nome_arquivo);
}

e outro Button com o Caption “Excluir”.

pois o componente, na verdade, s6 cria um

. . J
Com esses componentes o usudrio po-
derd enviar fotos para um diretério que (" j j
L. . [ [ Novo l [ Alterar ] . [ Deletar H Valtar
serd criado, utilizando como nomenclatu- [ . .
ra o c6digo da noticia, exibir os arquivos
enviados em um ListBox e permitir que
exclusoes sejam efetuadas. Vejana Figura
2 como ficou o layout do formuldrio de
cadastro de noticias.
Agora vamos aos cédigos. Primeira- [ ¥ [ |id_usuario
mente, codifique o botdo Enviar confor- o s o o s
me a Listagem 1.
No cédigo da Listagem 1 utilizou-se
uma varidvel $diretorio que deverd ser | ppx e
modificada conforme a localizacdo do
projeto em sua maquina. Achei interes-
sante criar um subdiretério fotos para
separar melhor os arquivos. Como co-
|HI Tool Palette 01X
[+  EditUploadrils
-/ standard |
[=T Frame
[= Frameset
= MainMenu
:{y  PopupMenu
‘= Label [
(i Edit b | R RS RSSO RS DRI
L F t ......................................................
Memo e S
fonte i
Button | b
% CheckBox | Status 0 DataPublicacgio - Data Alteracdo
| | Aguardando w | | |data_publicacae |
@ RadioButbon b [ e
= ListBox
B comboBox
HE ScrollBar
araupBos: [ [
¢} RadioGroup | f::::::::::::::::::f
0 penel | ST NS
gl ActionList I [ Il
I ZZIIIIZZZIIIIZZZZIIII
|17 EditUploadFile -
(| eI [ e
Figura 1. Paleta de Componentes Standard com o EditUploadFile Figura 2. Formuldrio de cadastro de noticias com componentes necessérios para upload e exclusao de fotos
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mentado anteriormente, pega-se o cédigo
da noticia para criar um subdiretério
com o nome iniciando com a letra “n”
e seguindo com o cédigo propriamente
dito. Lembre-se também que todos os
usudrios deverdo ter permissdo de escrita
e leitura nessa pasta para que o sistema
efetivamente faga o upload do arquivo.
Inicialmente faz-se um teste para veri-
ficar se o diretdrio existe e, caso ainda
nao exista, cria-se 0 mesmo usando a
funcdo mkdir.

A funcgdo move_uploaded_file é a res-
ponsével por efetivamente fazer o upload
do arquivo. Para utiliza-la, é necessdrio
passar como parametro o arquivo e o
caminho de destino. Para passar o para-
metro, usamos a variavel $_FILES com
o nome do componente, acrescentando
tmp_name para efetivamente pegar o
nome fisico do arquivo.

Antes de testar o envio de uma foto,
precisamos alterar o formato de envio
dasinformagdes para que o browser saiba
que o formuldrio estard enviando dados
e arquivos. Para isso acesse o evento On-
BeforeShow do formuldrio noticias.php e
acrescente a seguinte linha de c6digo ao
ja existente. (c6digo da parte II):

$this->FormEncoding="multipart/form-data";

Agora vocé jd pode abrir uma noticia
existente e fazer o teste enviando fotos
para a mesma. Depois va até o diretério
“fotos” que estd dentro do diretério da
aplicagdo e veja se foi criada uma pasta
iniciando com a letra “n” e terminando
com o cédigo da noticia. Para que as fo-
tos de cada noticia aparegam no ListBox,
codifique o seu evento OnBeforeShow
conforme a Listagem 2.

No cédigo da Listagem 2 utiliza-se um
lago de repetigdo (while) para percorrer
o diretério em busca de arquivos. Ini-
cialmente é preciso testar o filetype para
impedir a listagem de subdiretdrios e
depois utiliza-se a fungdo getimagesize
para confirmar que o arquivo é de ima-
gem. Isso impedird que arquivos que ndo
sdo imagens sejam exibidos no ListBox.
Para finalizar, codifique o botdo Excluir
conforme a Listagem 3.

No cédigo da Listagem 3 verifica-se a
existéncia de algum item selecionado no
ListBox e, se existir, faz-se a exclusdo do
arquivo utilizando a fungao unlink.

Para seguranca, é interessante fazer
uma pergunta ao usudrio para confirmar
se ele tem certeza que deseja excluir o
arquivo. Para fazer isso selecione o botao
Excluir, acesse a aba Javascript no Object
Inspector e, no evento OnClick, abaixo do
comentério //Add your javascript code here,
digite o seguinte cédigo:

return(confirm("Vocé tem certeza que deseja
excluir a foto selecionada?"));

Esse cédigo vai incluir uma fungao
Javascript que exibird uma mensagem
ao usudrio com a opgdo de continuar
a exclusdo ou canceld-la. Conforme a
escolha do usudrio, o post da pagina serd
executado ou ndo. Pronto! Agora vocé
colocou a disposi¢do do usudrio a manu-
tengdo de fotos para as noticias de forma
bem organizada, criando um diretério
especifico para cada noticia e sem limitar
a quantidade. O usudrio poderd enviar
quantas fotos quiser para a noticia.

Formulario Principal

Chegou a hora de criamos o formuldrio
principal, que serd a primeira pdgina dos
usudrios administradores do site. Acesse
o menu File| New>Form, mude a proprie-
dade Name para “UPrincipal” e salve a
Unit como “principal.php”.

Nesse formuldrio vocé pode colocar o
logotipo de sua empresa ou cliente, bem
como ajustar sua apresentagdo visual.
Esse formuldrio servird como caminho
de acesso aos formuldrios da aplicagdo,
e para isso acontecer, utiliza-se um com-
ponente MainMenu.

Adicione um MainMenu nesse formu-
ldrio e, para criar as opgdes, acesse a
propriedade Items que abrird um editor
conforme mostra a Figura 3.

Inicialmente, o editor j& vem com o
primeiro item adicionado bastando
apenas colocar o texto. Para incluir um
sub-item clica-se no botdo New Subltem.
Entdo o trabalho baseia-se em adicionar

p
Listagem 2. Evento OnBeforeShow do ListBox

$this->ListBox1->Clear();

$diretorio = “C:/CD/Jornal/fotos/n”.$this->
fdnoticiasl->Text.”/”;

if (is_dir($diretorio)) {

if (getimagesize($diretorio.$file))
$this->ListBox1l->addItem($file);

Listagem 3. (4digo do botao Excluir

{

{

if ($dh = opendir($diretorio)) {
while (($file = readdir($dh)) !== false)
if (filetype($diretorio.$file) == “file”) {

if ($this->ListBoxl->Items[$this->ListBox1->
ItemIndex] != null){
$diretorio =
fdnoticiasl->Text.”/”;
unlink($diretorio .$this->ListBoxl->
Items[$this->ListBox1->ItemIndex]);

“C:/CD/Jornal/fotos/n”.$this->

p
Items Editor

Ikems Irems

Text:

Tag:

Image Index:
Selected Index:

State Index:

[ cancel |

Help

Figura 3. Editor de itens do menu
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itens e sub-itens informando o Text, que
é a informacdo que aparece no menu, e
informar a propriedade Tag.

A propriedade Tag serd utilizada para
saber em qual menu o usudrio realmente
clicou, uma vez que o componente possui
um tnico evento OnClick, bem diferente
do MainMenu do Delphi 7.

Entdo, para esse sistema, montei um
menu com a estrutura apresentada na
Tabela 1. Veja também na Figura 4 como
o menu serd estruturado. Utilize amesma
estrutura e, principalmente, 0S mesmos
valores para a propriedade Tag, para
ndo termos problemas nas codifica¢des
futuras.

Acesse o evento OnClick do menu e
codifique conforme a Listagem 4.

Na Listagem 4 hd um teste para cada
opcdo do menu, verificando a proprie-
dade Tag através da varidvel $params que
o evento recebe. Nesse c6digo ndo foi
incluido agdo para o menu “Sair” (Tag
41), pois isso serd codificado depois da
implementagdo do controle de acesso ao
sistema.

Controle de Acesso

Agora vamos criar um controle de aces-
so ao sistema, com formuldrio de login
e, principalmente, restrigdo de acesso as
péginas pelo nivel do usudrio.

Comece com a criagdo do formuldrio
de login. Acesse o menu Filel New>Form,
altere a propriedade Name para “ULo-
gin” e salve a Unit como “login.php”.
Adicione ao formuldrio dois Label’s e dois
Edit’s para solicitar ao usudrio o nome de
usudrio e senha. Altere a propriedade
Name dos Edit’s para “edtUsuario” e “edt-
Senha”, respectivamente. Essa alteracdo
de Name é necessdria para a codificagdo
funcionar tanto para vocé como para
mim. Adicione um Button e altere seu
Caption para “Logar”. Para ndo exibir a
senha é necessdrio definir a propriedade
IsPassword do edtSenha para True. Abaixo
do botdo insira mais um Label, altere seu
Name para “IbIMensagem” e apague sua
propriedade Caption.

Abaixo coloque um outro Label, mude
0 Name para “1blUrl” e também apague o
Caption. Esse tltimo Label ird servir para
guardar a URL da pdgina que chamou o
login e, consequentemente, para onde o
usudrio serd redirecionado se o login for

aceito. Nesse label vocé pode configurar
a propriedade Visible para False, escon-
dendo essa informacédo do usudrio final.
No final dessa configuragdo o layout do
formuldrio de login deve ser parecido
com a Figura 5.

Antes de codificar precisamos adicionar
um componente Query (“sqlUsuarios”) ao
formuldrio delogin, para fazer abuscano
banco de dados. Para ligé-lo a proprieda-
de DataBase lembre-se de acessar o menu
File>Use unit e escolher dados.php. Depois,

ligue a propriedade DataBase ao UDados.
dbjornall. Altere a propriedade Name para
“sqlUsuarios” e na propriedade SQL in-
sira a seguinte instrugao:

select * from usuarios

Clique no botdo Logar e codifique o
evento conforme a Listagem 5.

Na Listagem 5 passa-se um filtro para
sqlUsuarios utilizando o campo e-mail,
que servird como nosso login, e também
a senha. Entdo se o usudrio ndo passar

( A
Listagem 4. Evento OnClick do MainMenu

if ($params[‘tag’]==11) {
redirect(‘noticias.php’);
}

if ($params[‘tag’]==12) {
redirect(‘pesNoticias.php’);
}

if ($params[‘tag’]==21) {
redirect(*instituicoes.php’);
}

if ($params[‘tag’1==22) {
redirect(‘pesInstituicoes.php’);
}

if ($params[‘tag’]==31) {
redirect(‘usuarios.php’);
}

if ($params[‘tag’]==32) {
redirect( ‘pesUsuarios.php’);

item Sub-item Tag
Noticias
Nova 11
Pesquisar 12
Instituicdes
Nova 21
Pesquisar 22
Usuérios
Novo 31
Pesquisar 32
Sistema

F——— sair 41

\,

& J Tabela 1.ltens do menu
e ———— 2
4 1
E feita para desanvolvedores !

[ = ]
h 1
': 1
) !
R S
Moticias Instituigbes Usudrics Sistema [

A\ -/

Figura 4. Formuldrio principal (principal.php)

feita para desanvolvedores

-1 | 2= 1

| R S R NP

Figura 5. Formuldrio de Login
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corretamente o e-mail e a senha para o
acesso, serd retornada a mesma pdagina
de login exibindo uma mensagem de
usudrio ou senha incorreta. Para evitar
SQL Injection (utilizagdo de aspas parain-
jetar instrucdo SQL) e burlar a seguranga,
utiliza-se a fungdo addslashes que adiciona
barras de escapes antes de aspas.

Nota: SQL Injection é uma técnica muito
utilizada por Hackers para executar co-
mandos SQL no banco a partir de con-
troles de entrada de dados.

Se sqlUsuarios retornar algum registro
o login serd aceito e, portanto coloca-se
em varidveis de sessdo ($_SESSION) o
id, nome e nivel do usudrio. Se o usu-
drio chamou diretamente a pédgina de
login ele serd redirecionado para pagina
principal.php. Caso ele tenha tentado
acessar uma outra pdgina do sistema,
o que resultou no direcionamento dele

para o login, ele serd encaminhado para
essa pagina. Para esse redirecionamento
funcionar precisamos ainda colocar o
cédigo a seguir no evento OnBeforeShow
da pagina de login:

$this->1bTUr1->Caption = $_GET['url'];

$this->1b1Mensagem->Caption = "<font
color="red'>".$_GET['erro']."</font>;

No cédigo anterior, buscamos valores
passados no link da pdgina através de
campos de consulta (“$_GET"). Esses valo-
res serdo enviados quando alguma pdgina
chamar o login, informando a pégina de
destino do usudrio, apds o login ser aceito.
Nesse momento uma mensagem de suces-
so é enviada para o usudrio.

Nota: Note que nessa mensagem pode-
se utilizar tags HTML para formatacao
de fontes. Isso é possivel em qualquer
componente que tenha a propriedade
Caption.

Listagem 5. Evento OnClick do botao Logar

addslashes($this->edtSenha->Text).”’”;
$this->sqlUsuarios->0pen();
if ($this->sqlUsuarios->RecordCount > 0){

$this->sqlUsuarios->Filter="email="".addslashes(
$this->edtUsuario->Text).”’ AND senha ="~

$_SESSION[ “id_usuario’] = $this->sqlUsuarios->id_usuario;
$_SESSION[ ‘nome’] = $this->sqlUsuarios->nome;
$_SESSION[ ‘nivel’] = $this->sqlUsuarios->nivel;
if ($this->1blUr1->Caption != NULL){
redirect($this->1blUrl->Caption);
} else {
redirect(‘principal.php’);

Jelse{
$this->1bIMensagem->Caption=“<font color="red’>Usudrio ou senha incorreta!
</font>”;
}
$this->sqlUsuarios->Close();

Listagem 6. Funcao seguranca

function seguranca($pagina, $nivel){
if (!($_SESSION[ ‘nome’1)){
redirect(‘login.php?url="
Jelsel{
if ($_SESSION[ ‘nivel’] < $nivel){
redirect(‘login.php?erro=Sem permissdo para essa pagina’);

. substr($pagina, 1, strlen($pagina)-1));

}
}
}

Listagem 7. (ddigo acrescentado no OnClick do MainMenu

if ($params[‘tag’]==41) {
$_SESSION[ “id_usuario’J=NULL;
unset($_SESSION[ “id_usuario’1);
$_SESSIONL ‘nome” J=NULL;
unset($_SESSION[ ‘nome’]);
$_SESSIONL ‘nivel’”1=NULL;
unset ($_SESSIONL ‘nivel’]);
redirect(‘login.php’);

Falta ainda fazer a exigéncia de login em
todas as paginas. Para tanto, cria-se uma
funcdo em uma nova Unit. Entdo acesse
o menu File| New>Unit ou usando o atalho
Ctrl+N para criar um arquivo de Unit e
salve-o com o nome “funcoes.php”. Nesse
arquivo poderemos adicionar fung¢des
que serdo utilizadas por vdrios formu-
larios da aplicagdo. Entdo, codifique a
fungdo “seguranca” conforme é exibido
na Listagem 8.

A funcdo sequranca verifica se o usu-
drio j4 estd logado, testando se existe
uma varidvel de sessdo chamada nome
(“$_SESSION['nome’]”). Lembrando que
quando é efetuado o login, essa varidvel
é criada na aplicacdo. Se ela ndo existir, o
usuadrio é redirecionado através da funcgao
redirect. Foi necessdrio utilizar a fungdo
substr para tirar uma barra (“/”) do nome
da pégina que chamou o login. Se o usudrio
estiver logado, verifica-se seu nivel de per-
missdo buscando o valor de uma varidvel
de sessdo, e testando com o nivel exigido
como parametro. Por isso, para funcionar
é interessante utilizar um pardmetro
numérico para definir o nivel e, com isso,
coloca-se um valor maior para o usudrio
administrador que acessard as paginas.

Depois da fungao seguranca ter sido
criada é necessdrio em cada pagina da
aplicagdo, exceto login.php, no evento
OmnBeforeShow adicionar, a chamada da
fungdo abaixo:

seguranca($_SERVER['PHP_SELF'], 1);

Para a chamada da fungio funcionar é
preciso acessar o menu File>Use Unit e es-
colher o arquivo funcoes.php pois é 14 que
estard a fun¢do. Na chamada utilizamos
a varidvel $PHP_SELF para passar como
pardmetro a pdgina que estd chamando
a fungdo, que é para onde o usudrio serd
redirecionado depois do login.

O segundo pardmetro é o nivel do
usudrio, onde pode-se definir para
cada pdgina um nivel diferente. Nesse
exemplo estou exigindo o nivel “1”
na pagina principal.php, nivel “2” nas
pédginas de pesquisa e o nivel “3” nas
pédginas de manutencdo de dados. En-
tdo se um usudrio de nivel “1” tentar
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acessar uma pagina de pesquisa ou
manutencdo serd redirecionado para
pégina de login onde serd apresentada
uma mensagem de erro, dizendo que
0 usudrio ndo possui permissdo para
acessar essa pagina.

Pronto! Agora vocé jd pode comecar
a fazer os testes. Crie trés usudrios,
sendo um para cada nivel. Lembre-
se que o usudrio de nivel ”"1” poderd
somente acessar a pdgina principal.
php. Os usudrios de nivel “2” poderdo
acessar a pagina principal.php e também
as paginas de pesquisa, e os de nivel
“3” poderdo acessar todas as pdginas.
Qualquer acesso indevido deve ser redi-
recionado para a pdgina de login. Tente
também executar uma pédgina que nao
seja a de login para certificar-se que o
login serd exigido.

Na pégina principal.php coloque um
Label e altere a propriedade Name para
“IblUsuario”. Nesse Label vamos exibir
uma mensagem contendo o nome do
usudrio que logou-se na aplica¢do. Aces-
se o evento OnBeforeShow desse Label e
coloque o seguinte cédigo:

$this->1blUsuario->Caption =
"Usudrio logado: ".$_SESSION[ 'nome'];

Veja na Figura 6 um usudrio devida-
mente logado no sistema.

Para finalizar vamos codificar a agdo
Sair do menu. Entdo acesse o evento On-
Click do MainMenu do formuldrio prin-
cipal e acrescente, ao c6digo existente, o
cédigo da Listagem 7.

No cédigo da Listagem 7 passamos o
valor NULL para todas as varidveis de
sessdo, bem como destruimos com o co-
mando unset. Sua aplicacdo estd com toda
a parte administrativa funcionando.

Conclusao

Agora temos a aplicacdo com o Backend
funcionando e preparado para receber
as noticias. Na préxima etapa do mini-
curso vamos trabalhar na parte acessivel
por todos os usudrios, o Frontend, onde
serdo aplicados templates (“modelos”) e
apresentaremos nossas noticias. Entéo,
nao perca a proxima parte. @

feita para desanvolvedores

Moticias Instituigies Usudrios Sistema

Usuario logado: Fabricio Desbessel

\

Figura 6. Usudrio logado no sistema
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Introducao ao PHP — Parte 2

Tipos de Dados e arrays

Ewald Geschwinde
Hans-Juergen Schoenig

as segdes anteriores, n0sjd vimos

que o PHP suporta variaveis,

mas por enquanto sé apren-
demos a utilizar nlimeros e seqiiéncias.
Como estruturas de controle, os tipos de
dados sdo um componente fundamental
de toda linguagem de programagao.

Tal como a maior parte das linguagens
de alto nivel, o PHP trabalha normalmen-
te sem tipos de dados e tenta reconhecer
o tipo de dado de uma varidvel por conta
prépria. Contudo, o PHP fornece um
conjunto de tipos de dados diferentes,
como mostrado na Tabela 1. Nesta secao,
aprenderemos a utilizar estes tipos de
dados eficientemente.

Variaveis e nomes

Como ja vimos nos exemplos discutidos
nas se¢Oes anteriores, as varidveis em PHP
sdo marcadas com o caractere “$”. Dife-
rentemente do Perl, o PHP marca todas as
varidveis com um caractere “$” e ndo usa
os caracteres “@” e “%"” como simbolos.

Em PHP, os nomes de varidveis sdo sen-
sitivas, o que significa que faz diferenga
se 0 nome € escrito com caracteres mi-
nusculos ou maitsculos. O nome de uma
varidvel pode iniciar com um caractere
de “a” a “z” ou com o caractere “_' (“un-
derscore”). Depois do primeiro caractere,
todas as demais letras e ntimeros, assim
como o caractere “_” serdo permitidos.
Contudo, recomendo fortemente utilizar
s6 letras no nome da varidvel, pois caso
contrdrio, os programas ficardo con-
fusos e dificeis de entender, sobretudo

quando se misturam letras maitisculas

Tipo de dado Descrigao

Int, Integer Numéricos, valores sem virgule
Double, real Numeéricos de ponto flutuante
String Seqiiéncia de caracteres

Array Conjunto de valores
Object Tipo de d:(i(l)oaurzfl;:laol definido

Tabela 1.Tipos de dados no PHP
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e mintsculas em nomes de varidveis. O
exemplo a seguir, mostra que $a ndo serd
interpretado como $A:

<?php
$a = "Eu sou uma seqliéncia.";
$A = "Eu também sou uma seqiiéncia.";
echo "a: $a; A: $A<br>\n";

(>

Como podemos ver no resultado, as
duas frases ndo representam a mesma
varidvel.

Reconhecimento automatico de
tipo de dados

Quando uma varidvel é processada
pelo PHP, o interpretador segue algu-
mas regras pré-estabelecidas para reco-
nhecer que tipo de dado uma varidvel
pertence:

* Se uma seqiiéncia de caracteres inicia
e termina com aspas simples, serd tratada
como um literal do tipo string: $a = ‘abc’
- atribui a seqiiéncia “abc” a $a, pois a
seqliéncia estd entre aspas simples;

*Se um niimero ndo contiver um pon-
to decimal, é tratado como um valor
inteiro: $a = 23, indica que o ndimero
inteiro 23 serd atribuido a $a. O valor 23
é um valor inteiro porque ndo contém
nenhum ponto decimal;

*Se um ndmero contiver um ponto
decimal, serd tratado como um ntime-
ro de ponto flutuante: $a = 3.14159 faz
com que o PHP atribua um valor ponto
flutuante a $a;

O conhecimento dessas trés regras tor-
na fdcil a previsao do resultado de uma
operacao e facilita a escrita de aplicagoes
sem erros de codificagdo.

Verificacdo de tipos de dados e
formatacao explicita

As vezes é necessario modificar explici-
tamente o tipo de dado de uma varidvel.
Embora o PHP faca internamente a for-
matacdo de tipos em alguns casos poderia
ajudar, caso seja necessdrio que uma vari-
avel seja atribuida com determinado tipo
de dado. Para executar operag¢des assim, o
PHP fornece as fung¢des necessarias. Antes
de aprendermos sobre essas fungdes, ve-
remos como podemos descobrir o tipo de
dado de uma varidvel na Listagem 1.

Com o auxilio da fun¢do chamada get-
type, é possivel recuperar facilmente o
tipo de dado de uma varidvel. Se utilizar-
mos as regras descritas na segdo anterior,

Listagem 1. Verificando o tipo de uma varidvel

<?php
$a = 3.14159;
$b = 12;
$c = “Eu sou uma seqléncia.”;

$d = array(l, 2, 3);

echo ‘$a is a

echo “$b is an

echo ‘$c is a

echo ‘$d is an
?>

Listagem 2. Outra forma de verificar um tipo de dado de uma variével

‘.gettype($a).” value<br>\n”
‘.gettype($b).” value<br>\n”;
‘.gettype($c).” value<br>\n”;
‘.gettype($d).” value<br>\n”;

<?php
$a = 3.14159;
$b = 12;
$c = “Eu sou uma seqliéncia.”;
$d = array(1l, 2, 3);
echo ‘$a: ‘.is_double($a).”<br>\n”;

echo ‘$b: ‘.is_integer($b).”<br>\n”;

echo “$c: ‘.is_string($c).”<br>\n”;
echo “$d: ‘.is_array($d).”<br>\n”;
echo “$d: ‘.is_object($d).”<br>\n”;

>

Listagem 3. Exemplo de formatagdo de varidveis

<?php
$a = 3.14159;
$b = 12;
$a_cast = (int)$a;
$b_cast = (double)$b;

echo “a_cast: $a_cast<br>”;
echo “b_cast: $b_cast<br>”;

serd facil prever o resultado do script:

$a is a double value
$b is an integer value
$c is a string value
$d is an array value

z

O primeiro valor é um valor ponto
flutuante porque contém uma virgula.
O segundo é um valor inteiro porque
ndo contém uma virgula. O terceiro estd
entre aspas e por isso é tratado como um
string. O tltimo valor é um array, pois a
expressao no lado direito do caractere “=",
retorna um array de valores inteiros.

Outro modo de verificar o tipo de dado
de uma variavel seria utilizar a funcéo es-
pecifica de tipo de dados como mostrado
na Listagem 2.

Utilizamos as funcgdes is_double, is_in-
teger, is_string, is_array e is_object. Se o
valor passado para a fungdo tiver o tipo
de dado apropriado, serd retornado 1. A
listagem a seguir, contém o resultado do
script que acabamos de ver:

$a: 1
$b: 1
$c: 1
$d: 1
$d:

Todos os valores menos o dltimo serdo
“true”. A tltima linha mostra que $d ndo

é um objeto.

Se executarmos uma formatacgdo ex-
plicita, poderemos facilmente perder
os dados armazenados na varidvel que
desejamos formatar. Isto ndo representa
um ponto fraco do PHP, pois a formatagdo
ndo poderia ser feita de outra forma pelo
interpretador PHP. (Listagem 3).

A varidvel $a é um ndmero de ponto
flutuante que é formatado para nimero
inteiro e exibido na tela. A varidvel $b é
formatada como double e exibida tam-
bém na tela. Se observarmos o resultado,
veremos que $a_cast ndo serd tdo preciso
como $a_cast, pois ndo é permitido que
um valor inteiro armazene os digitos
ap6s a virgula. As varidveis $b_cast e $b
serdo iguais, pois os nimeros inteiros
também podem ser representados como
valores double sem perda de dados:

a_cast: 3
b_cast: 12

Algumas regras gerais e dicas devem
ser levadas em consideragdo quando
forem executadas formatagdes. A Tabela
2 contém uma compilag¢do das infor-
magdes mais importantes a respeito de
formatagoes.
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Regras em PHP

Nessa tabela, podemos facilmente
constatar os perigos que iremos enfrentar
executando operagdes de formatagéao.

Funcoes

As funcdes sdo a base de toda lingua-
gem de programagdo. Elas sdo utilizadas
paraisolar certas tarefas de um programa
e ajudar o programador a reutilizar o
mesmo c6digo em vdrios lugares sem
necessidade de copid-los. As fungées sdo
chamadas com parametros e executam
um conjunto fixo de instrugdes. Se neces-
sdrio, uma fungdo pode retornar valores
para a fungédo ou objeto que a chamou.

Nos jé trabalhamos com fungdes. Uma
das fungdes com as quais jd lidamos é a
funcao gettype, que retorna o tipo de dado
de uma varidvel. Esta fun¢do é um bom
exemplo a respeito do que o tépico todo
aborda: passamos uma varidvel e um
valor é retornado.

Nos tiltimos anos, a expressao fungao tem
sofrido alguma perda de popularidade,
pois no paradigma da programagéo orien-
tada por objetos, ela ndo mais existe.

Funcoes de saida e trabalhando
com strings

Assim como no Pascal, uma lingua-
gem de programacdo especificada pelo
professor Niklaus Wirth em 1970, o PHP
suporta um tipo de dado chamado string.
As strings consistem de um conjunto de

caracteres e muitas vezes sao utilizadas
para armazenar texto. Diferentemente do
C/C++, a manipulagdo de strings é uma
tarefa facil em PHP, pois o programador
ndo tem que se preocupar com o geren-
ciamento de memdria e com as falhas de
segmentacdo que ocorrem por causa de
problemas de alocagdo de memoéria. Isto
torna o PHP conveniente para o desenvol-
vimento de software rdpido e confidvel.

A lista de fungdes utilizadas para tra-
balhar com strings em PHP parece ser
infinita. Nesta secdo, tentaremos cobrir
as mais importantes.

Para exibir caracteres ASCII na tela,
o PHP prové uma fungdo chamada chr.
Simplesmente passamos o cédigo ASCII
para a fungdo e o caractere desejado serd
retornado. O exemplo a seguir, mostra
como o endereco de e-mail de um dos
autores pode ser "facilmente" exibido
utilizando a fungéo:
<{?php
echo chr("103").chr("117").chr("105").

chr("110").chr("116").chr("104").

chr("101").chr("114") .chr("64").
chr("100").chr("101").chr("118").
chr("109").chr("101").chr("100").
chr("105").chr("97").chr("46") .chr("99").
chr("111").chr("109") .chr("46").

chr("98").chr("114")."<br>\n";
>

E o resultado é

guinther@devmedia.com.br

Temos certeza que existem modos mais
eficientes de exibir enderecos de e-mail.
Normalmente a fungdo chr é utilizada

Tipo de Dados de Tipo de dados antes B
Resultado da Formatacgao Alteragoes

Integer Double 0s dados a direita do ponto decimal sao omitidos - o valor ndo serd arredondado.
Integer String Se nenhum ndmero for reconhecido, serd retornado 0.
Double Integer Sem alteracdo.
Double String Se nenhum ntimero for reconhecido, sera retornado 0.
String Integer Retorna o nlimero como uma seqiiéncia de caracteres.
String Double Retorna o niimero como uma seqiiéncia de caracteres.
Array Object Serd diretamente convertido.
Array Integer Serd criado um array de valores inteiros.
Array String Serd criado um array de valores string.
Array Double Serd criado um array de valores de ponto flutuante.
Object Array Serd diretamente convertido.
Object Integer Serd gerado um object com as mesmas propriedades de um valor inteiro.
Object String Serd gerado um object com as mesmas propriedades de um valor string.
Object Double Serd gerado um object com as mesmas propriedades de um valor double.

Tabela 2. Tipos de dados no PHP

para exibir caracteres que ndo sdo encon-
trados no teclado.

A contrapartida da funcao chr é a fungéo
Ord, que pode ser utilizada para mostrar
o valor ASCII de um caractere:

<?php
$a = "a";
echo Ord($a);
k>

Atualmente a encriptagdo de dados é
uma tarefa extremamente importante,
pois os padrdes de seguranga estdo au-
mentando e os piratas poderiam ameagar
as redes de computador. Com a chegada
de todos aqueles virus que se propagam
através das redes, a seguranga tornou-se
um tépico importante. No exemplo a
seguir, veremos como uma string pode
ser facilmente encriptada utilizando as
fung¢bes embutidas do PHP:
<?php

$a = "Eu sou uma seqliéncia.";

echo crypt($a);
7>

Simplesmente passamos a string que
desejamos processar para a funcao crypt,
e o resultado sera codificado utilizando
o algoritmo DES. O resultado serd uma
seqiiéncia de caracteres que ndo conse-
guiremos ler:

i34vSr3Aueg2A

Como ja vimos, o c6digo HTML é um
conjunto de caracteres especiais que tém
certo significado. Um bom exemplo para
isto é o caractere “<”, que é utilizado
para definir o ponto de partida de uma
tag HTML. O questdo é: o que podemos
fazer quando desejamos exibir um ca-
ractere “<” na tela? O problema pode
ser facilmente resolvido utilizando a
fungdo chamada htmlspecialchars, a qual
converte todos os caracteres que tém
certo significado ou cuja utilizagdo ndo
é permitida no c6digo HTML correto. O
seguinte trecho de c6digo mostra como
isto funciona:
<?php

$b = "1 > 0";

echo htmlspecialchars($b);
k>

A expressdo “1>0" serd exibida na tela,
porém, o cédigo HTML gerado pelo PHP,
terd um aspecto ligeiramente diferente:

1 &gt; 0
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O caractere “>", foi substituido pela
seqiiéncia “&gt” e é exatamente isto que
nos desejamos.

Outro caractere importante na lista de
simbolos especiais é o simbolo “&”. No
c6digo HTML o simbolo "&” deve ser co-
dificado como “&amp;”. Como podemos
ver no exemplo a seguir, a funcao htmlspe-
cialchars toma conta deste particular:

<?php
$b = "Sr. Adriano Santos &
Sr. Guinther Pauli sdo do Brasil";
echo htmlspecialchars($b)." <br>\n";
2>
Se observarmos o c6édigo HTML gerado,
podemos ver que o caractere ‘&' foi subs-
tituido por "&amp;".

Sr. Adriano Santos &amp;
Sr. Guinther Pauli sdo do Brasil.

A fungdo printfé a fungdo "antediluviana"
para processamento de textos e strings. Ela
permite exibir o texto formatadona tela. Os
programadores C estardo familiarizados
com esta fungdo. A versdo PHP da funcdo
printf é muito semelhante a fungdo do C.
Vejamos um exemplo na Listagem 4.

Na primeira linha definimos uma va-
ridvel que contém o nome do autor. Na
linha seguinte, desejamos exibir esta
varidvel como parte de uma seqtiéncia no
texto. Por isso, utilizamos a fungdo printf.
Os caracteres “%s” sdo substituido por
$a. A string $a é interpretada como um
literal e é exibida na tela como um texto.
A seguir, $b é definido como um valor
inteiro. Depois disto, $b é exibido como
valor inteiro utilizando '%d"

Na linha seguinte $b é exibido como um
valor bindrio e como um valor octal. Esta
é a primeira vez que utilizamos a funcao
printf com mais de um parametro. Como
duas substitui¢des serdo executadas, é
necessdrio passar dois pardmetros para
a funcdo printf.

Uma linha depois, tentamos interpretar
$b como um valor inteiro exibido como
um caractere. Em outras palavras, tenta-
mos exibir na tela o caractere $b pelo seu
valor ASCIIL.

Finalmente, acrescentamos 2/12 a $b ($b
+=2/12 é equivalente a $b = $b + 2/12)
e 0 exibimos como um ntéimero de ponto
flutuante utilizando '%f. O ndmero de
ponto flutuante tem um comprimento to-
tal de cinco digitos, sendo que trés destes
digitos tém que estar do lado direito do

ponto decimal.

Executando o script, obteremos este
resultado:
Este é o didrio de Adriano.
Ele tem 30 anos de idade.
30 pode também ser escrito em 10111 (bindrio)
ou 27 (octal).
Vamos imprimir 30 novamente mas nesse momento
como um inteiro impresso como o caracter: ff.
Para ser mais preciso: Adriano tem 30.166666666667

anos e 2 meses de idade Como ponto flutuante ele
seria representado assim: 30.167.

A funcao printf suporta uma grande
variedade de parametros de formatagao.
A Tabela 3, contém uma lista de atalhos
suportados pela funcao printf.

Formatos aceitos pela funcao printf

A fungdo printfretorna 0 ou 1 se o coman-
do foi executado com sucesso. Se quisermos
recuperar a string gerada pela fungdo printf,
devemos utilizar em seu lugar a funcao
sprintf. Diferentemente da fungdo printf,
sprintf retorna a string que foi gerada mas
ndo a exibe na tela. Vejamos um exemplo:

<?php
$a = "Adriano";
$result = sprintf ("Este é o diario de

%s.", $a);
echo "Result: $result<br>\n";
7>

Desta vez o resultado é atribuido a uma
variavel chamada $result e exibido na tela
utilizando o comando echo.

Se desejarmos que uma caractere “\”
(barra invertida) seja colocado antes dos
caracteres “\\”, “+”, “*?7, “[”, N1 (7
“$” ou )", podemos utilizar a func¢do
QuoteMeta. Caso estejamos construindo
interfaces para outros produtos de sof-
tware ou trabalhando com expressoes
regulares, esta fungdo pode ser inte-
ressante, pois nos auxilia quando nao
queremos exibir caracteres especiais.
Vejamos um exemplo de como a fungdo
pode ser utilizada:

<?php
$a = "Is 1+2*¥3=7?7";
$result = QuoteMeta ($a);
echo "$result";

7>

O resultado conterd vdrias barras in-
vertidas:

Is I\+2\*3=7\7?

Se quisermos remover as barras inver-
tidas inseridas por QuoteMeta, podemos
utilizar a funcao stripslashes.

A fungao strcmp pode ser utilizada para
comparar string e é outra funcao que foi

Listagem 4. Exemplos de uso de printf

~

<?php
$a = “Adriano”;

$b = 30;

* (binario) ou %o (octal). <br>”, $b,

momento ele é um inteiro”.

$b += 2/12;
* anos e dois meses de idade. “.
“ %5.3f.<br>\n”, $b);

>
.

printf (“Este é o didrio de %s.<br>\n”, $a);
printf (“Ele tem %d anos de idade.<br>\n”, $b);
printf ($b pode também ser escrito em %Zb .”
printf (“Vamos imprimir $b novamente, mas nesse” .

* impresso como um caracter: %c.<br>”, $b, $b);

printf (“Para ser mais preciso: %s e $b *

* Como numero de ponto flutuante pode ser:”

v,

Formatacao Significado

%b Interpretar o valor como um valor inteiro, mas exibi-lo como um valor bindrio.

%c Interpretar o valor como um valor inteiro, mas exibi-lo como um valor caractere.

%d Interpretar o valor como um valor inteiro, mas exibi-lo como um valor decimal.

%f Interpretar o valor como um valor inteiro e exibi-lo como um nimero de ponto flutuante.

%0 Interpretar o valor como um valor inteiro, mas exibi-lo como um valor octal.

%s Interpretar e exibir o valor como uma seqiiéncia.

%X Interpretar o valor como um valor inteiro, mas exibi-lo como um valor hexadecimal, utilizando letras em mindsculas.
%X Interpretar o valor como um valor inteiro, mas exibi-lo como um valor hexadecimal, utilizando letras em maitisculas.

Tabela 3. Variacdes da funcéo printf
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emprestada do C. O uso da fungdo strcmp
em PHP é muito semelhante a do C, como
podemos ver no seguinte exemplo:

<?php
$a = "abc";
$b = "bcd"

echo strcmp($a, $b)."<br>";
echo strcmp($b, $a)."<br>";
” echo strcmp($a, $a)."<br>";

Nas duas primeiras linhas as varidveis
foram definidas e serdo comparadas uma
com a outra nas trés linhas seguintes.
O primeiro comando da fungéo strcmp
retorna -1, pois as duas varidveis foram
passadas para a fungdo em ordem alfabé-
tica. Os pardmetros foram passados para
o segundo comando em ordem inversa,
portanto é retornado 1. Se ambos os
valores forem iguais, a fungdo strcmp re-
tornard 0. Nas linhas seguintes, podemos

ver a safda do script:

-1
1
0

A fungéo strlen é largamente utilizada e
pode ser aplicada para retornar o tama-
nho de um string. Em primeiro lugar, é
definida uma string chamada $a. No pas-
so a seguir, o comprimento desta string é
verificado e exibido na tela:

<?php
$a = "Esta é uma string";
echo strlen($a)."<br>\n";
?>%a

Em alguns casos poderia ser ttil remo-
ver caracteres em branco do comeco e
do fim de um string. Para isto, podemos
utilizar a fungao trim:

<?php
$b =" Eu sou uma string "
echo inicio:".trim($b).":fim";
>

A varidvel $b contém uma seqiiéncia
com alguns espagos em branco no come-
¢o e no fim da mesma. Com a ajuda da
funcdo trim, esses espacos em branco sdo
facilmente removidos:

inicio:Eu sou uma string:fim

O resultado ndo mais contém espagos
em branco. Se quisermos apenas remo-
ver os espagos em branco a esquerda da
string, a funcao Iltrim pode ser utilizada.
E se quisermos remover os espagos em
branco a direita, a fungdo rtrim pode ser
utilizada.

Podemos converter strings em maitiscu-
las e vice-versa, utilizando duas fung¢des
simples do PHP chamadas strtoupper e
strtolower. No exemplo a seguir, veremos
como estas fungdes sdo utilizadas:
<?php

$a = "eu sou uma string";
$b = strtoupper($a);

echo "$b<br>\n";
echo strtolower($b);
7>

Em primeiro lugar, uma seqiiéncia é de-
finida. A seguir, é convertida para maits-
culas e atribuida a $b. Finalmente ambas
as seqiiéncias sdo exibidos na tela:

EU SOU UMA STRING
eu sou uma string

Em muitos casos ndo desejamos con-
verter todos os caracteres para letras
maitisculas ou mintsculas. Com a ajuda
da funcao ucfirst, é possivel converter s6
a primeira letra para maitiscula. A fungdo
ucwords, garante que cada palavra em
uma string ird comegar com maitscula:

<?php
$a = "eu sou uma string ";

echo ucfirst($a)."<br>";
echo ucwords($a)."<br>";
2
A saida do script ndo é de modo ne-
nhum surpreendente:

Eu sou uma String
Eu Sou Uma String

O PHP suporta muitas fung¢des relacio-
nadas a strings (“textos”), porém, estdo
além do escopo deste artigo abordar
todas essas fungdes detalhadamente.
Decidimos mencionar apenas as fung¢des
mais importantes e as mais largamente
utilizadas.

Trabalhando com arrays
unidimensionais

A capacidade de lidar fécil e eficiente-
mente com arrays, é uma das caracteris-
ticas que fez com que PHP se difundisse
nestes tltimos anos. Ndo s6 os arrays
podem ser facilmente manipulados, mas
temos também disponiveis muitas fun-
¢Oes relacionadas a arrays. Nesta secao
aprenderemos sobre essas funcoes.

Os arrays podem ser unidimensionais ou
multidimensionais. Um array unidimensio-
nal é uma estrutura de dados utilizada

para armazenar uma lista de valores.
Nos ja aprendemos nesse mesmo artigo,
que os arrays constituem um dos tipos de
dado primitivo do PHP. Contudo, os ar-
rays sao de certa forma diferentes de tipos
de dados tais como integer ou double.

Um array ndo é um valor atémico, o
que significa que é composto de um ou
mais valores que podem, por sua vez, ser
também arrays.

Comegaremos com um exemplo, onde
veremos como podemos descobrir se uma
varidvel é um array:

<?php
$a = 12;
$b = array(30, "Adriano", "Sdo Paulo", 1.67);
echo "a: ".is_array($a)."<br>";
echo "b: ".is_array($b);
>

Podemos ver que foram definidos um
valor inteiro e um array. O array compde-
se de um ndmero inteiro, duas strings e
um valor de ponto flutuante. Como po-
demos observar, ndo faz absolutamente
nenhuma diferenca quais valores serdo
inseridos em um array, pois 0 mesmo
é apenas um container para armazenar
todas as espécies de variaveis. Executan-
do o script, podemos ver que a funcao
is_array retorna 1 caso a varidvel passada
for um array:

a:
b: 1

Agora que aprendemos a criar arrays
e descobrir se uma varidvel é um array,
aprenderemos a acessar 0os componentes
de um array. A primeira coisa a saber, é
como descobrir quantos valores estdo
armazenados em um array. Isto pode ser
feito utilizando a fungao count. Assim que
conhecermos o nimero de componentes,
é fécil exibirmos o contetido da tabela
na tela:
<{?php

$a = array(30, "Adriano", "Sdo Paulo", 1.67);
$vals = count($a);
echo "N° de valores no array: $vals<br><br>\n";

for($i = 0; $1 < $vals; $i++){
echo "Valor numero $i: $al$il<br>";

(4

A saida do script mostra que quatro
registros foram encontrados no array.
Finalmente, todos os registros sdo exi-
bidos na tela. As vdrias células da tabela
sdo acessadas utilizando parénteses e o
indice do valor:
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Nimero de valores no array: 4
Valor ntmero 0: 30

Valor numero 1: Adriano
Valor numero 2: Sdo Paulo
Valor namero 3: 1.67

A exibicdo de todos os registros na tela,
pode ser feita também de outra maneira:

<?php
$a = array(30, "Adriano", "Sdo Paulo", 1.67);

foreach ($a as $x){
echo "$x<br>";

}
i

(o

Depois de definir a tabela, foi incluida
uma repetigdo que é executado para cada
valor no array. Todo valor em $a é atri-
buido a $x, que é exibido na tela usando
um comando echo:

30
Adriano
Sdo Paulo
1.67

Um array néo precisa ser consecutiva-
mente numerado. Em muitos casos é ttil
utilizar strings para identificar os valores
em um array:
<?php

$a = array(idade => 30, nome => "Adriano",
residéncia => "Sdo Paulo", altura => 1.67);

foreach($a as $x){
echo "$x<br>";
7 }

No exemplo anterior, um array asso-
ciativo é inicializado e o contetido é exi-
bido na tela como mostrado na seguinte
listagem:

30
Adriano
Sdo Paulo
1.67

Muitos podem jd ter trabalhado com
arrays associativos em Perl. No PHP, as
coisas funcionam de forma bastante se-
melhante ao Perl. Um array associativo é
apenas um array indexado com strings. A
principio deste tipo de array, é capaz de
armazenar cada tipo de dado em um array
e indexa-lo com qualquer dado desejado.

A recuperagdo de dados de um array
associativo pode ser feita da mesma
forma vista com arrays indexados com
ntmeros (Listagem 5).

Todos os valores serdo exibidos na tela:
Idade: 30 anos
Nome: Adriano

Residéncia: Sdo Paulo
Altura: 1.67 centimentos

Nessa secdo ja mencionamos que um

( )
Listagem 5. Array indexado
<?php
$a = array(idade => 30, nome => “Adriano”,
residéncia => “Sdo Paulo”, altura => 1.67);
echo “Idade: “.$al[“idade”].” years <br>”;
echo “Nome: “.$a[“nome”].”<br>”;
echo “Residéncia: “.$a[“residéncia”l.”<br>”;
echo “Altura: “.$al“altura”].” centimetros<br>”;
2>
- J

array também pode conter outros arrays.
O exemplo a seguir mostra um array que
tem um elemento que por sua vez, contém
outro array com dois elementos:

<?php
$a = array(nome => array("Adriano", "Santos"));
$b = $al"nome"];

- echo "$b[0] - $b[1]<br>\n";

Podemos inserir um array em outro
array como farfamos com qualquer outro
registro. O tnico aspecto que devemos
levar em consideragdo, é a recuperacdo
dos valores. Isso é ligeiramente mais
dificil do que se tratdssemos apenas de
um valor comum.

Se executarmos o script, os valores que
inserimos serdo recuperados:

Adriano - Santos

Com a ajuda de arrays, podemos cons-
truir estruturas de dados complexas.
Contudo, se as estruturas de dados fica-
rem muito complexas, é melhor utilizar
o PHP orientado a objetos em lugar de
arrays e procedimentos complexos.

Um comando importante quando
trabalhamos com arrays, é o comando
reset. Diferentemente do que poderiamos
esperar o comando reset ndo é utilizado
para remover elementos de um array,
mas para posicionar o ponteiro no pri-
meiro elemento do mesmo. Se estivermos
trabalhando com um array, o ponteiro
poderd ndo estar posicionado no primeiro
elemento e teremos problemas, portanto,
para usarmos com seguranga comandos
como next (“préximo”) e prev (“anterior”)
necessitamos usar reset. No exemplo a
seguir, veremos como definir um array,
posicionar o ponteiro no primeiro ele-
mento e exibir todos os registros na tela,
inclusive as chaves:

<?php
$a = array(23, 16, 8, 99);
reset($a);
while (Tist($key, $val) = each ($a)){
echo "$key: $val<br>\n";
7> é

Como podemos verificar, cada valor no
array tem uma chave.

23
16
8

99

WO

Achar a chave de um valor é uma tarefa
importante, pois a estrutura de dados
pode ser colocada no indice utilizando
qualquer outra varidvel.

A ordenagdo de dados é outra operagao
importante:

<?php
$a = array(23, 16, 8, 99);
sort($a);

foreach ($a as $val)f
echo "valor: $val<br>\n";
}
>

Para construir estruturas de dados
eficientes, é importante ordenar os
dados antes de trabalhar com elas. A
safda do script que acabamos de ver é
exibida ordenada porque utilizamos o
comando sort para modificar a ordem

dos elementos.

valor: 8
valor: 16
valor: 23
valor: 99

Para ordenar os dados em ordem in-
versa, utilizamos a funcdo arsort em vez
de sort:

<?php
$a = array(23, 16, 8, 99);
arsort($a);

foreach ($a as $val)f
echo "valor: $val<br>\n";
}
7>

Como podemos ver, os dados serdo exi-
bidos agora em ordem decrescente:
valor: 99
valor: 23

valor: 16
valor: 8

Para obtermos um efeito contrario ao
de ordenar um array devemos utilizar a
funcao shuffle a qual coloca os valores de
forma desordenada:
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<{?php
$a = range(l, 7);
shuffle($a);
while (1ist ($key, $val) = each ($a)){
echo "$key: $val<br>\n";
}

7>

Em primeiro lugar, criamos um array
que contém os valores 1 até 7 utilizando
a funcdo range. A seguir, os valores da
tabela sdo misturados e todos os valores
sdo exibidos na tela.

U REWN O
OV O W

Os valores ndo estdo mais ordenados.
Desordenar arrays pode ser ttil em mui-
tas situagdes. Imaginemos uma situagao
em que desejamos exibir registros em or-
dem aleatdria. A fungao shuffle faz isto.

Nés vimos como um array pode ser
acessado utilizando um indice ou um
comando foreach. Outro modo de proces-
sar todos os valores de um array consiste
em utilizar os comandos reset e next. O
comando next, posiciona o ponteiro no
proximo valor do array e retorna o valor
atual. Utilizando uma repeticdo while, é
fécil de percorrer o array (Listagem 6).

Como podemos ver a seguir, todos os
valores serdo exibidos na tela:

valor: 23
valor: 16
valor: 8
valor: 99

Arrays Stacks

Os arrays do tipo stacks, sdao um tipo
especial de array. Consistem em uma
estrutura de dados fundamental e sdo
largamente utilizados por muitos pro-
gramadores. Se quisermos processar a
comandos utilizando a notacdo posfix,
os arrays stacks representam um instru-
mento essencial.

Duas operagdes sdo predefinidas para
stacks:

* A operacdo push, adiciona um valor
ao stack;

* A operacdo pop retorna o tltimo valor
que foi adicionado ao array e o remove
da lista.

Em outras palavras, arrays stacks utilizam
um algoritmo LIFO (LIFO = Lastin first out
- iltimo a entrar primeiro a sair).

Para esclarecer o que acabamos de
aprender vejamos a Listagem 7.

Na primeira linha, foi definido um
array vazio. Nas trés linhas seguintes,
os valores sdo adicionados ao array stack,
utilizando o comando array_push, e todos
os valores sdo exibidos na tela. Entao, dois
valores sdo retirados da stack e exibidos
na tela. Como podemos ver, o valor de
retorno de array_pop é retornado e remo-
vido do array. Depois de ter adicionado
trés valores ao array e ter retirando dois
valores do mesmo, somente restou um
valor o qual é exibido na tela:

0: o primeiro valor
1: o segundo valor
2: o terceiro valor

removendo: o terceiro valor
removendo: o segundo valor

0: o primeiro valor

A contagem dos valores de um array
pode ser feita utilizando a fungédo ar-
ray_count_values. A idéia desta funcdo é
a de contar a freqiiéncia com a qual um
determinado valor ocorre na tabela.

As vezes é necessario remover valores du-
plicados de uma tabela. A fungao array_uni-
que faz este servico. Vejamos alguns exem-
plos de ambas fungées na Listagem 8.

Depois de definir um array contendo
algum valor, um array é inicializado
contendo a freqtiéncia com a qual vdrios
valores em $a ocorrem. Na primeira co-
luna a chave é exibida. A segunda coluna
diz-nos com que freqiiéncia a chave foi
encontrada no array.

Em seguida a funcdo array_unique é uti-
lizada para remover entradas duplicadas.
A chave paraum valor é a posi¢do na qual
certo valor ocorreu no array original. O
valor 9, por exemplo, foi encontrado na
quarta e a tiltima posi¢do do array. Como
isto é redundante, o tiltimo valor no array
foi eliminado e s6 permaneceu o valor na
posicdo nimero 4:

Retorno da Tistagem:
23: 3
12: 1
9: 2
Retorno da listagem lnica:
0: 23
2: 12
3: 9
A saida da fungdo mostra o que é exibi-
do quando o script é executado.
Quando trabalhamos com mais de um
array pode ocorrer a necessidade de unir-
mos determinados arrays para algum

fim. Para realizarmos isso, o PHP fornece

algumas fungdes poderosas e faceis de
utilizar. Uma das fungdes é chamada
array_merge e é utilizada para combinar
dois arrays:

<?php
$a = array(23, 12, 9);
$b = array(12, 13, 14);

$res = array_merge($a, $b);

while (1ist ($key, $val) = each ($res)){
echo "$key: $val<br>\n";
}
k>

Sdo definidos dois arrays, os quais
serdo fundidos em um sé. Se executar-
mos o script, o resultado conterd todos
os valores de ambos os arrays, tal como
mostrado na listagem a seguir:

23
12
9

12

13
14

R W O

Ao contrdrio da funcédo array_merge, a
funcao array_diff, pode ser utilizada para
obter um array diferenca de outros dois
arrays, tal como mostrado a seguir:

<{?php
$a = array(23, 12, 9);
$b = array(12, 13, 14);

$res = array_diff($a, $b);:

while (Tist ($key, $val) = each ($res)){
echo "$key: $val<br>\n";
}
>
Foram encontrados dois valores em $a

que ndo existem em $b:
0: 23
2: 9

Se quisermos computar a interseccdo
de dois arrays em lugar da diferenca,
podemos utilizar a fungdo array_inter-
sect. Como com as fungdes array_diff e
array_merge, devemos passar dois arrays
para a fungéo array_intersect:
<7php
$a = array(23, 12, 9);
$b = array(12, 13, 14);

$res = array_intersect($a, $b);

while (list ($key, $val) = each ($res)){
echo "$key: $val<br>\n";
}
7>

Apenas um valor é retornado:
1: 12

O célculo da soma de todos os valores
em um array, pode ser feito de varias

maneiras porém, a forma mais facil é
utilizar a fungéo array_sum:
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<?php
$a = array(23, 12, 9);
echo array_sum($a);

7>

O valor 44 resultante, serd exibido na tela.

Dividir uma seqiiéncia e gerar um array
a partir da mesma é uma operagdo impor-
tante. Se tivermos que processar arquivos
separados por tags, por exemplo, dividir
strings e gerar arrays é um procedimento
essencial. O PHP prové uma funcdo cha-
mada explode. A fungdo explode é chamada
com dois pardmetros. O primeiro diz ao
PHP onde dividir a string mediante a
defini¢do de um padrdo. O segundo pa-
rametro contém a varidvel que desejamos
processar.

Ao contrdrio dela podemos usar a
funcdo implode, que faz exatamente o
contrdrio da fungao explode. Vejamos um
exemplo na Listagem 9.

No inicio do script, uma varidvel é de-
finida, a qual serd utilizada para gerar
uma tabela na segunda linha. Um carac-
tere espago é designado como caractere
separador. A seguir, o contetdo de $b é
exibido na tela. Finalmente todos os va-
lores em $b sao combinados novamente
em uma seqiiéncia. Mais uma vez, um
caractere espago é designado como ca-
ractere separador.

Se executarmos o script, a saida serd
exibida na tela:

: Esta
é
1 ouma
: string

[N

Esta é uma string

Como podemos ver na tltima linha do
resultado, o array foi novamente combi-
nado na string que tinha sido definida na
primeira linha.

Trabalhando com arrays
multidimensionais

Os arrays multidimensionais sdo um
bocado mais dificeis de manipular do
que os arrays unidimensionais. Contudo,
com algumas técnicas bdsicas, é possivel
executar operagdes complexas.

Estas técnicas podem ser utilizadas para
processar tanto arrays unidimensionais
quanto multidimensionais. Mesmo para
estruturas de dados mais complexas,
cada um desempenhard um papel im-
portante (Listagem 10).

Nas quatro primeiras linhas, um array

de duas dimensdes é criado e quatro va-
lores sdo atribuidos ao mesmo. O objetivo
é exibir todos os registros na tela.

A listagem a seguir, mostra o que é exi-
bido quando executamos o script:

Informagoes:
0: Array
1: Array

A listagem ndo contém o resultado de-
sejado, pois cada um extrai uma lista de
arrays em lugar de uma lista de valores
tnicos da tabela multidimensional. Para
exibir os dados, devemos fazer algumas
pequenas modificagdes no cédigo con-
forme a Listagem 11.

Uma segunda repeticdo deve ser acres-
centada para obter todos os campos dos

-
Listagem 6.While

~\

<?php
$a = array(23, 16, 8, 99);
reset($a);
$val = $a[0];
dof
echo “valor: $val<br>\n”;

}
while($val = next($a));
2>

Listagem 7. Arrays Stacks

<?php
$a = array();
array_push($a, ‘o primeiro valor’);
array_push($a, ‘o segundo valor’);
array_push($a, ‘o terceiro valor’);

while(1ist ($key, $val) = each ($a)){
echo “$key: $val<br>\n”;

}

echo “<br>removendo: “

echo “removendo: “.

while (list ($key, $val) = each ($a)){
echo “$key: $val<br>\n”;

}

(o

Listagem 8. array_count_values e array_unique

. array_pop($a).”<br>”;
array_pop($a).”<br><br>”;

<?php
$a = array(23, 23, 12, 9, 23, 9);
$counted = array_count_values($a);

echo “Retorno da listagem: <br>\n”;

echo “$key: $val<br>\n”;
}

$a = array_unique($a);
while (1ist ($key, $val) = each ($a)){
echo “$key: $val<br>\n”;
}
>

Listagem 9. Funoes implode e explode

while (1ist ($key, $val) = each ($counted)){

echo “<br>Retorno da listagem (nica: <br>\n”;

<?php
$a
$b

“Esta € uma string”;
explode(“ “, $a);

while (1ist ($key, $val) = each ($b)){
echo “$key: $val<br>\n”;
}
$c = implode(“ “, $b);
echo “<br>$c<br>”;
?>

Listagem 10. Arrays multidimensionais

<?php
$a[0][0]
$al0][1]
$al0]1[2]
$al11[0]

“Jodo Morais”;

“Maria Aparecida”;
“Chamada de Viena”;
“Satélite para Satélite”;

echo “<b>Informacdes:</b><br>\n”;
while (1ist ($key, $val) = each ($a))t
echo “$key: $val<br>\n”;
}
?>
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arrays extraidos do array multidimen-
sional. Se executarmos o script agora, o
resultado contera todos os valores:

Informacgoes:

chave:0 - subchave: 0 - valor: Jodo Morais
chave:0 - subchave: 1 - valor: Maria
Aparecida

chave:0 - subchave: 2 - valor: Chamando de
Viena

chave:1 - subchave: 0 - valor: Satélite para
Satélite

A seguir desejamos ordenar os valores
no array. Para realizar este objetivo, pode-
mos tentar acrescentar um comando sort
apos atribuirmos os valores ao array:

sort($a);

Isto ndo nos conduzird ao resultado
desejado, pois 0o PHP ordenaré as chaves
e ndo os valores:

Informacgoes:

chave:0 - subchave: 0 - valor: Satélite para
Satélite

chave:1 - subchave: 0 - valor: Jodo Morais
chave:1 - subchave: 1 - valor: Maria
Aparecida

chave:1 - subchave: 2 - valor: Chamando de
Viena

Se quisermos ordenar o contetido do
array e ndo as chaves, devemos construir
um array multidimensional, onde todos
o0s eixos tém a mesma quantidade de va-
lores. No caso, podemos construir uma
matriz com quatro valores (matriz 2x2):

$a[0]1[0] = "Jodo Morais";

$al0][1] = "Maria Aparecida";
$a[11[0] = "Chamando de Viena";
$al1][1] = "Satélite para Satélite";

Esta matriz pode ser facilmente orde-
nada utilizando o comando array_mul-
tisort:

array_multisort($a[0], SORT_ASC, SORT_STRING,
$al[1], SORT_ASC, SORT_STRING);

Ambas as colunas serdo ordenadas
em ordem ascendente. Se executarmos
o script agora, obteremos uma lista or-
denada:

Informagoes:

chave:0 - subchave: 0 - valor: Maria
Aparecida

chave:0 - subchave: 1 - valor: Jodo Morais
chave:1 - subchave: 0 - valor: Satélite para
Satélite

chave:1 - subchave: 1 - valor: Chamando de
Viena

Se ndo tivermos modificado a estrutu-
ra dos dados, terfamos experimentado
dificuldades, pois o tamanho dos arrays
seria inconsistente:

A funcdo array_multisort, aceita dois
parametros para influir no modo em que
os dados serdo ordenados. O PHP suporta
dois flags de ordenacao:

*SORT_ASC - Ordenacao ascendente;
¢ SORT_DESC - Ordenagao descendente;

Além do mais, trés parametros de tipo
de ordenacao sao fornecidas:

* SORT_REGULAR - Comparar os itens
normalmente;

* SORT_NUMERIC - Comparar os itens
numericamente;

*SORT_STRING - Comparar os itens
como seqiiéncias;

Como podemos ver, a fungdo array_mul-
tisort é uma funcdo poderosa e flexivel.
Contudo, deve ser utilizada com cuidado,
para garantir que o resultado de um pro-
cesso de ordenacdo, ird conter exatamente
os dados desejados.

Nos jd vimos que um array multidi-
mensional se compde de muitos arrays
que tém uma dimensdo a menos do que
oarray pai. O conhecimento disto permi-
tird que executemos todas as operagdes
que desejarmos executar. Trabalhando
com arrays stacks multidimensionais, é
importante saber o que acontece dentro
do PHP e como os dados serdo fornecidos
pelo intérprete.

Condlusao

Neste artigo vimos como trabalhar com
tipos de dados no PHP, incluindo arrays.
Na préxima edi¢do continuaremos explo-
rando a linguagem PHP. Até 14! @

-
Listagem 11. Alteracdo na exibicao dos arrays

<?php
$a[0][0]
$a[0][1]
$a[0][2]
$al1100]

“Jodo Morais”;

“Maria Aparecida”;
“Chamando de Viena”;
“Satélite para Satélite”;

echo “<b>Informacdes:</b><br>\n”;
while (1ist ($key, $val) = each ($a)){

}
}

(7
|

while (list ($subkey, $subval) = each ($val)){
echo “chave:$key - subchave: $subkey - valor: $subval<br>\n”;
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